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Introduction to Altiris Deployment Solution™ 
from Symantec

Take control of all your computer resources across your organization using Altiris 
Deployment Solution™ from Symantec deployment and management tools. Take a seat 
at any Deployment Console to remotely manage all types of devices—notebooks, 
desktops, switches, and servers—through all phases of computer deployment and 
lifecycle management. Schedule remote system upgrades, distribute patches and 
drivers, re-image computer hard drives, or migrate large groups of users to new 
computers without missing a single custom setting or installed program. Use 
Deployment Solution to handle daily tasks and depend on it for occasional big jobs, such 
as disaster recovery or large-scale software updates. And do it all remotely from any 
Deployment Console on any device with a connection to your WAN or LAN.

That is the attitude behind Deployment Solution: increase access and productivity while 
decreasing costs and IT response time. You will appreciate the simple, easy-to-use 
graphical consoles to organize computer groups, schedule deployment jobs, and 
distribute disk image and update packages. It’s easy. It’s powerful. It conforms and 
scales to your infrastructure. Go ahead—take some time and learn to take control.

What can I do with Deployment Solution?

Deploy. Manage. Migrate. Regardless of your organization’s size or special IT 
requirements, Deployment Solution provides a complete system to cut costs and 
improve response times for both big and small jobs.

Manage from a remote console. Deploy, control, and manage all types of computers 
across your organization from a remote Deployment Console. Use the feature-rich 
Deployment Server Console for real-time management of computers.

See  on page 69.

Migrate data, applications, and personal settings. Through easy-to-use wizards, 
migrate data and settings from a retiring computer to a new computer by capturing 
desktop, network, and application settings. Redeploy these personal settings remotely 
from a Deployment Console.

See New job wizard on page 146.

Upgrade and install software. Manage system software on a day-to-day basis for 
desktops, servers, and notebooks to upgrade applications, install service packs, set up 
printer drivers, and modify systems as needed. Deployment Solution provides upgrade 
capabilities for all mobile computers by deploying to remote sites as needed by traveling 
personnel.

See Distributing software on page 175. 

Deploy computers in large groups. Easily deploy and configure large numbers of 
computers across an organization. Install hard disk images to groups of new or existing 
computer types using multicasting features. Install software and personality settings 
with common applications, data and drivers. Run post-configuration jobs or automated 
scripts to assign unique security IDs, configure user names, and set IP addresses using 
deployment jobs.

See  on page 95.
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Deploy and manage servers. Manage all types of Web and network servers, including 
ultra high-density server board inserts. Automatically redeploy servers based on 
deployment history and saved server images, or use automated scripted installs with 
easy-to-create answer files. Operating systems can be installed as image files or run as 
scripted installs—or as a combination strategy (especially nice for managing ultra-dense 
server farms). See the Altiris Deployment Solution Reference Guide.

Respond to common help desk requests. Remotely browse, diagnose, and repair 
problems on systems without ever leaving a Deployment Console. Detailed hardware 
and software inventories, along with remote control and chat features simplify remote 
diagnosis of common problems.

See Remote operations using Deployment Solution on page 122.

Recover from disaster. Ease the pain of accidents by automatically backing up and 
restoring configurations, personalities, registries, partitions, and drives remotely from a 
Deployment Console. Saving the history of all deployment jobs assigned to a computer 
makes it easy to restore a system to a previous working state.

See Restoring a computer from its deployment history on page 124.

Features of Deployment Solution
Deployment Solution can be installed and implemented locally as an independent 
Deployment Server system on a single LAN segment or site, or scaled across the 
enterprise using Deployment from the Symantec Management Console to consolidate all 
deployment and IT management efforts.

Each Deployment Server system includes services, applications, and utilities for high-
bandwidth, real-time deployment, and includes a Web console to perform IT duties from 
a Web browser. Deployment from the Symantec Management Console integrates 
multiple Deployment Server systems for generating deployment reports across the 
enterprise and adds other Web IT solutions, such as Inventory, Application Metering, 
Carbon Copy, and other solutions of the Client Management Suite.

Deployment server system

The Deployment Console is a Windows user interface that provides full features to 
deploy computers, image hard disks, migrate user settings and programs, run scripted 
installs, remotely control computers, and perform other deployment tasks for all your 
computer resources. Daily IT requests and jobs formerly completed by visiting each 
desktop, server or portable computer in the organization can now be completed from 
your Deployment Server Console.

Components of the Deployment Server system can be installed on a single computer (a 
Simple install) or distributed across several local computers (a Custom install). A 
Custom installation lets you install Microsoft SQL Server and access the Deployment 
Database from a separate computer. The Deployment Share, Deployment Server, PXE 
Server, and Deployment Consoles can also be distributed to separate computers. The 
Deployment Server Console displays data directly from the Deployment database.

Managing from the deployment console
The Deployment Server Console (a Windows console) is included with the 
Deployment Server system and provides complete deployment and management 
features. It is divided into several operational panes:
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The Computers pane displays all computer resources managed by a Deployment 
Server system. It includes features to right-click and remotely execute operations 
on managed computers. From this pane, you can drag the computer icons to job 
icons to schedule deployment and management tasks.

The Jobs pane executes and schedules deployment tasks for selected computers. 
Using one or more sequenced jobs, you can image, configure computer settings, 
distribute packages, and run scripts by dragging Job icons to individual computers 
or computer groups and scheduling a convenient time to execute. It lets you 
schedule deployment jobs by dragging computer icons to job icons, or vice versa.

The Details pane provides information and features to filter computers by type and 
build deployment tasks. It extends the user interface features when working in the 
Computers and Jobs panes.

From the Deployment Server Console (the Windows console), a Shortcut and 
Resources pane organizes and provides easy access to .MSI files, .RIPs, image files 
(.img), Personality Packages (.exe), and other file types. It functions as a library for 
packages used when building jobs in the console.

In addition, the Deployment Server Console provides easy-to-use wizards to simplify 
and expedite common deployment tasks.

See  on page 69.

Managing computers
From the Deployment Console, you can manage all types of computers to perform 
immediate deployment and management operations. From the Computers pane of the 
console, computer resources can be grouped by location, department, or type 
(portables, desktops or servers) and organized to reflect your environment. You can run 
operations, schedule deployment jobs, access computers or computer groups to change 
the network settings, run disk image, other deployment jobs.

The console identifies computers and computer groups with a unique icon. To access a 
computer, click the computer icon to view the configuration settings or run specific 
deployment and management operations. Computer icons can be dragged to job icons 
to schedule and run pre-configured deployment tasks from the Windows console. In the 
Deployment Web console, you can manage computers using drop-down lists, secondary 
dialog boxes, and other familiar Web features.

See  on page 95.

Managing with computer icons

Icons displayed in the Computers pane of the console help in identifying the computer 
types and deployment status. Group icons can be expanded to view the member 
computers, and computer types can be identified by specific icons: desktops and 
notebooks, servers, computer groups, and Linux computers. Computer icons can also 
identify the state of the managed computer—a logged-on user, a computer waiting for 
further instructions, a user not logged on and other states of deployment—when 
performing operations or executing deployment tasks on a selected computer.

See Viewing computer details on page 96.

 

This icon identifies a managed desktop or notebook computer that is 
active and has a user logged on.
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Additional icons represent deployment status, inactive computers, computers running a 
deployment job, and new computers.

See Viewing computer details on page 96.

Immediate management access from the console

From a Deployment Console, you can select a computer and start various computer 
configuration and management operations for a specific computer in your system. You 
can create new deployment tasks, restart, restore the hard drive, view deployment 
history, and perform other advanced tasks using the commands on this menu. Some 
operations—such as changing configuration settings, copying files, and creating quick 
disk images—create job files automatically.

See Remote operations using Deployment Solution on page 122. For complete 
information about Deployment Consoles, see Managing from the deployment console on 
page 10.

Building and scheduling deployment jobs
Jobs are designed as objects with defined deployment tasks. Jobs can be built, 
organized, and scheduled to run on selected computers or computer groups from a 
Deployment Console. Jobs automate both simple and complex IT administrative duties 
— from complete deployment and migration tasks to simple DOS commands and 
modification of configuration settings. You can build and schedule jobs from any of the 
Deployment Consoles.

Deployment jobs give you the ability to organize, store, and assign administration tasks 
for each computer or computer group. You can create and deploy images, back up 
registry files, run scripted installs, or make post-imaging changes such as adding 
printers and applications. You can deploy and run packages—RIPs, images, personality 
packages, MIS programs, and others—to migrate applications, configure computer 
settings, deploy complete hard disk images, and much more. You can also assign jobs 
with conditions to run only on defined computer types.

See  on page 145.

Jobs are built in the Deployment Server Console by creating a job name (identified by a 
job icon in the console) and adding predefined deployment tasks. Tasks such as 
Distribute Software, Run Script, or Create Disk Image are added and executed 
sequentially when scheduled to run on computers or computer groups. And even within 
computer groups, different jobs can be assigned to different computer types based on 
the operating system, hardware, or other specified conditions.

See Deployment tasks on page 155.

 

This icon identifies a managed Windows network or Web server that is 
active and has a user logged on.

This icon identifies a Linux computer.

This icon identifies a pre-configured computer account with user 
account settings that are not associated with a new computer.
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When a job is built, it can be scheduled to run immediately, at desired intervals, or at 
any other convenient time when the bandwidth is low. In addition, you can use 
bandwidth throttling features to schedule and run deployment tasks to large groups 
without affecting network traffic.

See Scheduling jobs on page 153.

From the Deployment Server Console, you have several options to create deployment 
jobs:

Create common deployment tasks quickly and easily using the New Event Wizard.

Import jobs from other Deployment Solution systems.

Manually create deployment tasks from the console.

Copy and paste deployment tasks from within the console.

See Building new jobs on page 150.

In the Jobs pane, you can create and organize deployment jobs. You can then assign 
jobs by dragging icons to the desired computer or computer group. 

Building jobs

Building jobs includes creating a new job and then adding tasks to the job to run in 
sequence when scheduled on selected computers. You can build jobs by adding tasks 
manually or you can step through the New Job Wizard to create common jobs and 
schedule them. Sample tasks are also included with Deployment Solution to use as 
installed or to easily customize and run.

See New job wizard on page 146.

After creating and building a job, you can then assign it to a computer and schedule it to 
run at any time—immediately, after a specified time, or on a daily, weekly, or monthly 
schedule. The deployment status of each job is reflected in the console.

Assigning deployment jobs with icons

Computer icons are used to identify the types of computers in a console. Similarly, job 
icons identify the status and success of a scheduled deployment job. After scheduling 
jobs, you can monitor the progress as the job icons are updated at each step of 
execution.

This job is assigned to a computer, but is not scheduled to run. Until 
scheduled, this job icon remains unchanged.

This job is assigned to the computer and is scheduled to run either 
immediately or in the future.

This job is currently in process.

This job has completed successfully.
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See Viewing job details on page 145.

Scheduling jobs

From the Schedule Job dialog, you can run jobs immediately or schedule the job to run 
in batches at defined intervals. You can also assign the job to repeat every hour, day, or 
week. Scheduling jobs can be as simple as clicking OK to run immediately or as 
sophisticated as required to meet your deployment needs.

For complete information about building and scheduling deployment jobs, see  on 
page 145.

Imaging
A primary task of Deployment Solution is to capture an image (a clone of the hard drive) 
from a reference computer and distribute the image to set up new computers or reinstall 
computers to their basic configuration. You can create a library of image files on the 
Deployment Share (file server storage) and schedule image jobs to different computer 
types as required.

Deployment Server lets you push down a boot image remotely and execute the image 
using PXE Server, eliminating the need to physically attend and boot each managed 
computer.

See Creating a disk image on page 157, Distributing a disk image on page 162, and New 
job wizard on page 146

Imaging from deployment server

Deployment Server includes multiple features to capture an image and lay it down to a 
new or existing computer. You can use the Deployment Server Console to create and 
distribute disk images using deployment tasks, such as the Quick Disk Image wizard 
shown below:

Pre-boot environments let you boot to automation to create and deploy images, back up 
and restore a computer’s registry file, or run other automation tasks. You can also boot 
to a Network Server and run imaging files and other commands.

See Boot Disk Creator Help and PXE Configuration Utility Help.

Migrating computers
Deployment Solution provides various options to migrate operating systems, computer 
personalities, software, or entire hard disk images. You can accomplish migration tasks 
individually or as a single job.

The New Job Wizard steps you through each migration option, letting you capture a 
complete hard disk image (to upgrade to a new computer), migrate a user to another 
operating system with the same personality settings and applications, or to simply move 
personality settings from one computer to the another. Using the New Job Wizard is one 
of the easiest ways to build deployment tasks to migrate user data and settings.

Deployment Solution lets you build sophisticated deployment jobs that automatically 
migrate personalities, including deployment tasks to capture the user’s personality, 
migrate the operating system and software, and reconfigure the computer with the 
user’s original personality settings. You can also edit Personality Packages or Rapid 
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Install Packages (.RIPs) using the PC Transplant Editor and the Wise MSI Editor tools 
from the Deployment Server Console.

Deploying and managing servers
Deployment Solution includes features designed specifically for deploying and managing 
network or Web servers. Server-specific features include scripted installs for initial 
installation, and support for remote management cards, multiple network adapters, 
history transfers to support rip and replace redeployment, and additional functionality 
required for automating server management. 

Deployment Solution also integrates with other hardware vendors to provide systems 
and tools to manage large server installations and support automatic deployment 
strategies. These unified systems simplify and automate server configurations and 
large-scale migrations, and support emerging hardware for ultra high-density server 
systems.

From a Deployment Console you can build deployment jobs to run scripted installs for 
Windows and Linux servers. You can run these unattended installs directly over the 
network for individual Web or network servers. You can create answer files for each 
scripted install from a Deployment Console.

You can also run server-specific scripts and redeployment tasks. Enhanced task logging 
and history tracking features let you recall deployment actions to quickly redeploy 
mission-critical servers.

Get started
Deployment Solution is a full-featured remote deployment system designed to manage 
computer devices across all types and sizes of small to medium organizations and large 
enterprises. It includes Windows and Web components to design and scale a system for 
your specific IT needs and challenges. Deployment Solution provides a wide array of 
tools, utilities, and applications to design a system for your specific needs. Deployment 
Solution is easy-to-use and adaptable to your environment.

You can design and install a Deployment Server system specific to your hardware, 
organizational structure, network architecture, and other environmental variables. The 
installation and configuration process lets you install Deployment system components 
(database, services, network share, user interface console) to a single computer or 
distribute components to separate role servers.
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Chapter 34
Installing Deployment Server 

Deployment Server is a flexible, scalable computer deployment and management 
system that can be installed and configured on a single computer, or installed across 
several computers to distribute processing for large enterprise environments. You can 
run a Simple install to position all Deployment Server Components on a single computer 
(most frequently used), or plan and perform a Custom install to distribute installation of 
components across separate computers in the site. The Deployment Web Console can be 
installed as part of the Deployment Server installation on any computer running 
Microsoft IIS.

See Deployment Server components on page 335.

After installing Deployment Server components, you can remotely install Deployment 
Agents on all types of computer resources across your organization: laptops, LAN and 
Web servers, network switches, and so on. Windows computers and Linux computers 
can be managed as a unified environment, with each client communicating through its 
own Deployment agent to update inventory data and react to Deployment Server 
commands and deployment tasks.

Select one of the following methods for installing a Deployment Server system:

Simple install for Deployment Server

Custom install for Deployment Server

Thin client install

Component install

To install Deployment Agents on the client computer, see Installing Deployment Solution 
agents on page 351.

Note
You can also install the Deployment Server components remotely from the Symantec 
Management Console.

Enabling SQL Server 2008
SQL Server 2008 turns off the network TCP and pipe protocols. Before you install 
Deployment Server, you need to enable the network TCP protocol.

To enable SQL Server 2008

1. In the SQL Server Configuration Manager, expand SQL Server Network 
Configuration.

2. Click Protocols for MSSQLSERVER.

3. In the right pane, double-click TCP/IP.

4. Change the Enabled field to Yes.

5. Click OK.
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6. Restart SQL Server.

You can now install Deployment Server.

Deployment Server components
The Deployment Server system includes the following components:

Deployment Console

Deployment Server

Deployment database

Deployment share

PXE server

DHCP Server (not an Altiris product)

Deployment Web console

Installing Deployment Solution agents

Sysprep

You can install all these components on the same computer or distribute them across 
multiple computers, depending on the environment.

Deployment Console
The Deployment Console is the Win32 user interface for Deployment Solution. You can 
install this Windows console on computers across the network to view and manage 
resources from different locations. In addition, from this console, you can access the 
Deployment Database on other Deployment Server systems to manage sites across the 
enterprise.

See Deployment database on page 337 and Connecting to another Deployment Server 
on page 93. 

The Deployment Console communicates with the Deployment database and Deployment 
Server services. In a Simple Install for Deployment Server, the Deployment Console is 
installed on the same computer similar to all other components. In a Custom Install for 
Deployment Server, you must ensure that a connection is available to these computers 
and security rights are set. You must have administrative rights on any computer 
running the Deployment Console.

See Simple install for Deployment Server on page 341 and Custom install for 
Deployment Server on page 344.

See also: Deployment Web console on page 339,  on page 69, and Deployment Server 
components on page 335.

Deployment Server
Deployment Server controls the flow of the work and information between the managed 
computers and the other Deployment Server components (Deployment Console, 
Deployment Database, and the Deployment Share). Managed computers connect and 
communicate with the Deployment Server to register inventory and configuration 
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information and to run deployment and management tasks. The computer and 
deployment data for each managed computer is stored in the Deployment Database.

Note
To view, start, or stop Deployment Server, go to the Altiris Server services in your 
Windows Manager.

Managed computers require access to the Deployment Server at all times, requiring that 
you have administrative rights on the computer running the Deployment Server.

 

Note
It is easier to create an administrative account using the same name and password on 
all computers than to use the existing name and password of each account.

Most packages (.RIP, Personality Packages, and .MSI files) pass through the Deployment 
Server. Therefore, if you store these files on the Deployment Server, the deployment of 
these packages is faster. Image files, however, are sent directly from the Deployment 
Share to the client computer when you run an imaging task.

See Deployment Server components on page 335.

Deployment database
Note
In Deployment Solution 6.0 and later, if you have already set up multiple instances of 
the Microsoft SQL Server, you can identify a specific instance using this format: 
<database instance>\express. Example: If you have a clustered Microsoft SQL Server 
named SQLClusterSvr to manage multiple Deployment Solution systems on different 
network segments, you can enter the name SQLClusterSvr\salesSegment or 
SQLClusterSvr\marketingSegment during the Deployment Server setup, depending on 
the previously established database instance. This feature is supported in the silent 
install .INI file and the GUI install executable.

The database maintains the following information about the managed computers:

Hardware. RAM, asset tag, and serial numbers

General Information. Computer name and MAC address

 

Create a user account to run the Deployment Server. The service runs as 
a logged-on user, not as a system account. You must create this account 
on all Deployment Server computers. The account must have full rights 
to the Deployment Share. The account must have a non-expiring 
password.

See Deployment share on page 338.

 

Assign a static IP address to the Deployment Server computer. Other 
components cannot connect to the Deployment Server if you use DHCP 
and dynamically change the IP address.

 

To install the Deployment Server on a remote computer, the default 
administration shares must be present. Restore any shares that have 
been removed before you install the Deployment Server.
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Configuration. TCP/IP, Microsoft networking, and user information

Applications. The installed applications and information about these applications, such 
as the name of the application, publisher, and product ID

Services. Installed Windows services

Devices. Installed Windows devices, such as network adapter, keyboard, and monitors 

Location information. Contact name, phone, e-mail, department, mail stop, and site

The Deployment Server Database also contains jobs and other data used to manage 
your computers.

Note
You can install a single Deployment Database in each Deployment Server system—you 
cannot have two databases storing data for a single computer. If the computer you are 
installing the database on has an existing Microsoft SQL Server™, the Deployment 
Database is added to that instance of the database engine.

Support for multiple database instances
In Deployment Solution 6.0 and later, you can identify a named instance of the Microsoft 
SQL Server when installing Deployment Solution. You can now identify other named 
instances of Microsoft SQL Servers instead of accessing only the default instance. This 
feature lets you identify and run multiple databases from one clustered Microsoft SQL 
Server to manage multiple sites or network segments. This feature is supported in the 
silent install .INI file and the GUI install executable. Deployment Solution also supports 
a different name for the Deployment Database instead of the default name, eXpress.

See Custom install for Deployment Server on page 344 and Deployment Server 
components on page 335.

Deployment share 
The Deployment Share is a file server or shared directory where Altiris program files and 
packages are stored. The Deployment Share can be a shared directory (default Simple 
install in Program Files\ Altiris\eXpress\Deployment Server) or another file server (in the 
Custom install, you can assign a Microsoft Windows or Novell NetWare file server).

Deployment Share is where you store image files, registry files, .MSI packages, 
Personality Packages, script files, and more. When you are deploying or managing a 
computer, the Deployment Server stores and retrieves these packages from the 
Deployment Share as needed.

 

If you want to install Deployment Solution on a remote file server (not 
the computer where you are running the install program), create a 
share (or give Read/Write rights for NetWare) on the file server where 
you want to install the Deployment Server. This share must allow access 
to all other components, including managed computers and the user 
account that runs the Deployment Server.

You must create this share before you begin installing. If you are 
not installing on a remote computer, you can select the option to create 
the share during the installation.
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Note
You can install only one Deployment Share for each Deployment Server system. 
However, if the Deployment Share's hard drive gets full, other computers can be used as 
additional backup storage points. In some cases, other systems emulating a Microsoft or 
NetWare environment can be used as the Deployment Share.

Note for NetWare users: If you have a problem using the Novell NetWare server as a 
Deployment Share, install the Novell Client instead of the Microsoft NetWare Client.

See Deployment Server components on page 335.

PXE server
The PXE Server provides service to client computers on a subnet. When the Deployment 
Server sends a deployment job, the client computer receives a request to boot to 
automation and the PXE-enabled computers connect to the first PXE Server that they 
discover, which communicates with the Deployment Server and the client computers.

The PXE Server also functions on the same protocols as a standard DHCP Server, so you 
can place the PXE Server wherever you would place a DHCP server. You can also install 
as many PXE Servers as required in your system, but you must also install a DHCP 
Server.

The PXE Server sends a boot menu option list to the client when the computer performs 
a PXE boot. The deployment job, which contains at least one automation task, uses the 
default automation environment or the environment specified by a user who has the 
permission to create a deployment job. Use the boot menu option to request the PXE 
Server for the boot menu files and download the boot menu files from the PXE Server to 
the client computer’s RAM storage. The client computer always boots according to the 
request and reply communications taking place between the Deployment and PXE 
Servers.

Altiris supports DOS, Linux, and Windows PreInstallation Environment (WinPE) as pre-
boot environments. These options let you create a single job, but may contain multiple 
automation tasks. The default automation environment (the first pre-boot operating 
system files installed during the Deployment Solution installation) is used for Initial 
Deployment, unless you specify otherwise.

Using a PXE Server to boot client computers to automation saves you from having to 
install an automation partition on each client computer’s hard disk, or from manually 
starting computers using Altiris-supported bootable media.See Boot Disk Creator Help.

See Pre-boot operating system (simple) on page 367, Install automation partition on 
page 133, and PXE Configuration Utility Help.

DHCP Server

The DHCP (Dynamic Host Configuration Protocol) server is a server set up to assign TCP/
IP addresses to the client computers. This server is not an Altiris product, but is required 
if you want to use the PXE Server.

We recommend that you use DHCP to manage the TCP/IP address in your network, 
whether you use PXE or not. This greatly reduces the amount of time required to set up 
and manage your computers.

See Deployment Server components on page 335.
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Deployment Web console

The Deployment Web console remotely manages a Deployment Server installation from 
a Web browser. It deploys and manages Windows and Linux computers (both client and 
server editions) in real time with many of the features that are present in the 
Deployment Console.

See Deployment Console on page 335.

You can install the Deployment Web console on any computer running the Microsoft IIS 
Server, such as a computer running Deployment Server, Notification Server, or a remote 
computer running only Microsoft IIS.

Note
If Microsoft IIS is running, the Deployment Web console is installed automatically during 
the Windows installation.

Note
The DS Installer does not detect the version of MDAC that is installed. The Deployment 
Web console requires MDAC version 2.71 or later to install. If the version of MDAC is 
earlier than 2.71, the Web console displays a Target of Invocation error.

See Deployment Console on page 335 and Deployment Server components on 
page 335.

Deployment Server system requirements
The following are the system requirements for Deployment Server components and the 
network environment.

Network

TCP/IP is used for communication between all Deployment Server components. If 
you have a NetWare file server for your Deployment Share, IPX can also be used to 
communicate with this component.

Deployment Server

RAM: 256 MB

Disk Space: 200 MB

Component Hardware Software

All components require Pentium III processors

Deployment 
Server

RAM: 256 MB

Disk Space: 200 MB

Windows Server

Deployment 
Console

RAM: 128 MB 

Disk Space: 3.5 MB

Windows XP Professional

Windows Server
Altiris Deployment Solution™ from Symantec User’s Guide 339



 

Deployment agents

The Deployment agent requirements are similar to the target operating system. The 
Deployment agent requires around 5 MB disk space.

See the following sections for additional information:

Installing the Deployment Agent on page 353

Installing Deployment Agent on Linux on page 357

Installing the automation agent on page 358

Managing licenses on page 358

Simple install for Deployment Server
The Simple Install option places all the Deployment Server Components — Deployment 
Server, Deployment Console, Deployment Share, and Deployment Database — on the 
same computer.

See Deployment Server components on page 335.

You can install the Deployment Server with a Microsoft Desktop Engine (MSDE) by using 
the Simple Install. You can install the Deployment Web Console during a Simple Install 

PXE server Memory: 128 MB

Disk Space: 25 MB (for 
boot files)

DHCP server (must be on the 
network, but does not have to be 
on the same computer as a PXE 
Server)

Windows Server or Advanced 
Server

Deployment 
database 

Memory: 128 MB 

Disk Space: 55 MB (for 
program files), plus space 
for data.

(Microsoft SQL ServerTM or MSDE

Deployment 
share

(File server for 
storage)

Memory: 128 MB 

Disk Space: 100 MB for 
Deployment Server program 
files plus space for storing 
files (image, boot, .RIP, and 
so on)

Windows Server

NetWare (File server only. Cannot 
be used for any other 
components).

Deployment 
Web console

Memory: 128 MB Windows XP Professional

Windows Server

MS IIS

MDAC

Component Hardware Software
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(and during a silent install) if the Microsoft IIS services and .NET frameworks are 
running on the selected computer.

Note
Simple installation works only with a default Microsoft SQL or MSDE install.

To run a simple install

1. Start the server and log on using the administrator account you created for the 
Deployment Server. See Deployment Server system requirements on page 340.

2. Launch the appropriate Altiris Deployment Server installation file and follow the 
setup steps.

The Altiris Packager Self-Extracting Executable Options dialog appears.

3. Select the Use current temp folder option to use the current temporary folder to 
download installation files or the Extract to a specific folder option to set a path 
to an existing folder to download the installation files.

4. Click Extract and Execute App to extract and execute the application immediately.

The default installation directory is C:\DSSetup. If the file C:\DSSetup\AppLic.dll 
already exists, a prompt appears, asking whether you want to overwrite this file. 
Click Yes to All. You may have to wait for some time while Altiris Packager extracts 
files from this archive.

Note
Click Extract Only to only extract the application and execute the application later. 
You must run the axInstall.exe file to start the installation.

5. Select the Simple Install option from the installation types listed in the 
Deployment Server Install Configuration dialog.

6. (Optional) Select the Include PXE Server option to install the PXE Server. (See 
PXE server on page 338.) Click Install.

7. Click Yes on the Software License Agreement page.

8. Enter the following information on the Deployment Share Information page:

a. In the File Server path field, enter or browse to the path to install the 
Deployment Server program files. The default path is C:\Program 
Files\Altiris\eXpress\Deployment Server.)

b. Select the Create Deployment Share option to create a Deployment Share on 
the computer. The Deployment Share lets you store files on the computer and 
run Deployment Server system applications. See Deployment share on 
page 338.

c. Select one of the following options to configure the licensing information:

If you do not have a license file, select the Free 7 day license option. The 
installation continues and lets you use a free evaluation license file.

 

AltirisDeploymentSolutionWin_(version) installs all Windows 
components of Deployment Solution. Using the Simple Install 
option, you can install MSDE on a local computer if a database is 
not already installed.
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Select the Upgrade using existing license option to upgrade the 
installation using an existing license.

Select the License File option and browse to locate a license file (.LIC file). 
This is the activation key you receive when you register your Altiris software. 
See the Altiris Getting Started Guide for further licensing information.

Note
You do not need to apply a license key to activate thin clients from HP or Dell. 
This managed client computer automatically receives a non-expiring license 
when connected to the console.

d. You must enter an administrator user name and password for the Deployment 
Server. This account must already exist on the Deployment Share and the 
Deployment Server. By default, the name you are currently logged on as 
appears. If you use a domain account, enter the domain and the user name 
(Example: Domain1\administrator). See Deployment Server on page 336.

Note:
If a previous installation of the Deployment Database is detected, an axinstall 
prompt appears, asking whether you want to preserve or overwrite the existing 
database. Click Yes to preserve the data in your Deployment Database.

Click Next. The Pre-boot Operating System page appears.

9. Select a default pre-boot operating system from any one of the options, such as 
FreeDos, MS-DOS, Linux, WinPE, or None. Browse to locate the FIRM file (for 
FreeDos and Linux operating systems) or the operating system files (for MS-DOS 
and WinPE). Click Next. The Installation Information page appears, displaying 
the components that you selected to install.

10. Click Install to install the listed components, or click Back to modify the settings 
before starting the installation. The installation process begins and can take several 
minutes. The Installation Information Summary page appears after the 
installation completes.

Note
If you are upgrading your installation, the message Do you want to replace the 
share? appears. Click Yes and continue. If you click No, a message appears, 
stating that the share is already in use and you need to manually set the share to 
point to the correct directory. Click OK.

11. (Optional) You can select one of the following options to install agents.

Enable Microsoft Sysprep Support. Select this option to enable Microsoft 
Sysprep support and click Next. You must specify the location of the Microsoft 
Sysprep files.

Remotely install Deployment Agent. Select this option if you want to push 
the Deployment Agent to computers running Windows operating systems.

Install add-ons to provision server hardware. Select this option to install 
the add-ons for Dell computers.
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Note
This option is enabled on Dell computers only when add-ons are present in the 
oeminstall-addons section of the oeminstall.ini file, which is located in the 
eXpress directory.

12. Click Finish.

You have successfully completed a Simple Install for a Deployment Server system. Click 
the Deployment Console icon on your desktop to view all the computer resources 
running Deployment Agents configured for your Deployment Server.

Note
Antivirus applications can delete service .EXE files or can disable services.

Example: When you run the Deployment Server Win32 Console, the “Unable to connect 
to the Altiris Deployment Server DS Management Server. Please ensure this service is 
started and running currently.” error appears. This occurs because the service files are 
deleted by the antivirus application during scanning. To resolve this issue, disable the 
antivirus software and reinstall the Deployment Server.

See Custom install for Deployment Server on page 344.

Custom install for Deployment Server
The Custom Install option lets you distribute all the Deployment Server Components — 
Deployment Server, Deployment Console, Deployment Share, and Deployment Database 
— on different computers. You can install Deployment Server with a Microsoft Data 
Engine (MSDE) or install it on an existing SQL Server.

See Deployment Server components on page 335.

To run a custom install

1. Start the server and log on as the administrator account you created for the 
Deployment Server. See Deployment Server system requirements on page 340.

2. Launch the appropriate Altiris Deployment Server installation file and follow the 
setup steps.

The Altiris Packager Self-Extracting Executable Options dialog appears.

3. Click the Use current temp folder option to use the current temporary folder to 
download installation files or the Extract to a specific folder option to set a path 
to an existing folder to download the installation files.

4. Click Extract and Execute App to extract and execute the application immediately.

The default installation directory is C:\DSSetup. If the file C:\DSSetup\AppLic.dll 
already exists, a prompt appears, asking whether you want to overwrite this file. 

 

AltirisDeploymentSolutionWin_(version) installs all Windows 
components of Deployment Solution. Select the Custom install 
option to add new components or to install Deployment Solution 
on an existing database.
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Click Yes to All. You may have to wait for some time while Altiris Packager extracts 
files from this archive.

Note
(Optional) Click Extract Only to only extract the application and execute the 
application later. You must run the axInstall.exe file to start the installation.

5. Select the Custom Install option from the installation types listed in the 
Deployment Server Install Configuration dialog if any of the following 
conditions exist:

You are using the NetWare file server as a Deployment Share.

You are managing many computers and require a distributed architecture to 
meet bandwidth restrictions and other design requirements.

6. Click Install. Click Yes on the Software License Agreement page.

7. Enter the following information on the Deployment Share Information page:

a. In the File Server path field, enter or browse to the path to install the 
Deployment Server program files. The default path is C:\Program 
Files\Altiris\eXpress\Deployment Server.)

b. Select the Create Deployment Share option to create a Deployment Share on 
the computer. The Deployment Share lets you store files on the computer and 
run Deployment Server system applications. The Deployment Share can exist 
on a Microsoft Windows server or Novell NetWare server. 

Note
You can only create the share if it is on a Microsoft Windows Server; the Novell 
share should already be set up. See Deployment share on page 338.

c. Select one of the following options to configure the licensing information:

If you do not have a license file, select the Free 7 day license option. The 
installation continues and lets you use a free evaluation license file.

Select the Upgrade using existing license option to upgrade the 
installation using an existing license.

Select the License File option and browse to locate a license file (.LIC file). 
This is the activation key you receive when you register your Altiris software.

See the Altiris Getting Started Guide for further licensing information. Click 
Next.

Note
You do not need to apply a license key to activate thin clients from HP or Dell. 
This managed client computer automatically receives a non-expiring license 
when connected to the console.

8. Enter the following information on the Deployment Server Information page:

a. Select the computer where you want to install the Deployment Server. You can 
install the Deployment Server on the local computer or on a remote computer. 
The IP address and the port information for the selected computer are displayed 
by default.

b. Enter the path where you want to install the Deployment Server.
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c. You must enter an administrator user name and password for the Deployment 

Server. This account must already exist on the Deployment Share and the 
Deployment Server. By default, the name you are currently logged on as 
appears. If you use a domain account, enter the domain and the user name 
(Example: Domain1\administrator). (See Deployment Server on page 336.) 
Click Next.

9. Enter the Deployment Database information and click Next.

Specify the Microsoft SQL Server Instance where you want to install the 
database. See Deployment database on page 337.

Note
If you have already set up multiple instances of the Microsoft SQL Server, you 
can identify a specific database instance in this field using the format: <SQL 
Server Name>\<database instance>.

Depending upon the selection of the SQL Server instance, the default port at 
which the selected instance is listening appears in the SQL Port Number field. 
You can edit the port number if you have manually entered the SQL Server 
name or if the port number does not appear automatically due to some firewall 
restriction.

You can enter a name other than eXpress in the Database Name field.

10. Select the type of Deployment Database authentication to be used. You must enter 
the user name and password if you want to use SQL Server authentication.

Note
You cannot use the remote SQL database with NT authentication on a remote 
computer if you do not have administrative rights on the computer.

Click Next. The Pre-boot Operating Systems page appears.

Note:
If a previous installation of the Deployment Database is detected, an axinstall 
prompt appears, asking whether you want to preserve or overwrite the existing 
database. Click Yes to preserve the data in your Deployment Database.

11. Select a default pre-boot operating system from any one of the options, such as 
FreeDos, MS-DOS, Linux, or WinPE. Browse to locate the FIRM file (for FreeDos and 
Linux operating systems) or enter the path for the operating system files (for MS-
DOS and WinPE). Click Next.

Note
If you are using a free evaluation license, you cannot use the WinPE Add-On 
Packages.

12. Enter the PXE Server information. (See PXE server on page 338.) Select the pre-
boot operating system to use as the default PXE boot menu item. You can select 
DOS, Linux, or WinPE. If you want to use the previously installed pre-boot operating 
system, select the Keep current default option. Click Next. 

13. Specify how you want to connect your managed computer to the Deployment Server 
by selecting one of the following options.

Select the Connect directly to Deployment Server option and enter the 
Deployment Server IP address and port.
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Select the Discover Deployment Server using TCP/IP multicast option and 
provide the Server name. 

Note
If you leave the Server name field blank, the Deployment Agent connects to 
the first Deployment Server that responds. Click Next.

14. Enter the Deployment Console information. You can install the Deployment Console 
on the local computer or on a remote computer. Click Next.

15. Enter the Deployment Web Console information. You can install the Deployment 
Web Console on the local computer or on a remote computer. This computer must 
be running Microsoft IIS .NET framework. Specify the path where you want to install 
the Deployment Web Console and also valid user credentials. Click Next. See 
Deployment web console information on page 369.

Note
This option is disabled if Microsoft IIS is not detected.

The Installation Information page appears, displaying the components that you 
selected to install.

16. Click Install to install the listed components or click Back to modify the settings 
before starting the installation. The installation process begins and can take several 
minutes. The Installation Information Summary page appears after the 
installation completes.

Note
If you are upgrading your installation, the message Do you want to replace the 
share? appears. Click Yes and continue. If you click No, a message appears stating 
that the share is already in use and you must manually set the share to point to the 
correct directory. Click OK.

17. (Optional) You can select one of the following options to install agents on the 
managed computers.

Enable Microsoft Sysprep Support. Select this option to enable Microsoft 
Sysprep support and click Next. You must specify the location of the Microsoft 
Sysprep files.

Remotely Install Deployment Agent. Select this option if you want to push 
the Deployment Agent to Windows computers directly after the installation. This 
can be done any time by selecting Tools > Remote Agent Installer.

Install add-ons to provision server hardware. Select this option to install 
OEM add-ons for servers.

Note
This option is enabled only when add-ons are present in the oeminstall-addons 
section of the oeminstall.ini file, which is located in the eXpress directory.

18. Click Finish.

You have successfully completed a Custom Install for a Deployment Server system. Click 
the Deployment Console icon on your desktop to view all the computer resources 
running Deployment Agents configured for your Deployment Server.

See Simple install for Deployment Server on page 341.
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Thin client install

The thin client install option lets you install the Thin Client view of the Deployment 
Console on your computer. You can install Deployment Server with a Microsoft Data 
Engine (MSDE) or install it on an existing SQL Server. You need not provide a license file 
for the Thin Client installation.

To run a thin client install

1. Start the server and log on using the administrator account you created for the 
Deployment Server. See Deployment Server system requirements on page 340.

2. Launch the appropriate Altiris Deployment Server installation file and follow the 
setup steps.

The Altiris Packager Self-Extracting Executable Options dialog appears.

3. Select the Use current temp folder option to use the current temporary folder to 
download installation files or the Extract to a specific folder option to set a path 
to an existing folder to download the installation files.

4. Click Extract and Execute App to extract and execute the application immediately.

The default installation directory is C:\DSSetup. If the file C:\DSSetup\AppLic.dll 
already exists, a prompt appears, asking whether you want to overwrite this file. 
Click Yes to All. You may have to wait for some time while Altiris Packager extracts 
files from this archive.

Note
Click Extract Only to only extract the application and execute the application later. 
You must run the axInstall.exe file to start the installation.

5. Select the Thin Client Install option from the installation types listed in the 
Deployment Server Install Configuration dialog.

6. (Optional) Select the Include PXE Server option to install the PXE Server. (See 
PXE server on page 338.) Click Install.

7. Click Yes on the Software License Agreement page.

8. Enter the following information on the Deployment Share Information page:

a. In the File Server path field, enter or browse to the path to install the 
Deployment Server program files. The default path is C:\Program 
Files\Altiris\eXpress\Deployment Server.

b. Select the Create Deployment Share option to create a Deployment Share on 
the computer. The Deployment Share lets you store files on the computer and 
run Deployment Server system applications. See Deployment share on 
page 338.

c. You must enter an administrator user name and password for the Deployment 
Server system. This account must already exist on the Deployment Share and 
the Deployment Server. By default, the name you are currently logged on as 
appears. If you use a domain account, enter the domain and the user name 
(Example: Domain1\administrator). See Deployment Server on page 336.

If a previous installation of the Deployment Database is detected, an axinstall 
prompt appears, asking whether you want to preserve or overwrite the existing 
database. Click Yes to preserve the data in your Deployment Database.
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Click Next. The Pre-boot Operating System page appears.

9. Select a default pre-boot operating system from any one of the options, such as 
FreeDos, MS-DOS, Linux, WinPE, or None. Browse to locate the FIRM file (for 
FreeDos and Linux operating systems) or enter the path for the operating system 
files (for MS-DOS and WinPE). Click Next. The Installation Information page 
appears, displaying the components that you selected to install.

10. Click Install to install the listed components, or click Back to modify the settings 
before starting the installation. The installation process begins and can take several 
minutes. The Installation Information Summary page appears after the 
installation completes.

Note
If you are upgrading your installation, the message Do you want to replace the 
share? appears. Click Yes and continue. If you click No, a message appears, 
stating that the share is already in use and you must manually set the share to point 
to the correct directory. Click OK.

11. (Optional) You can select one of the following options to install agents.

Enable Microsoft Sysprep Support. Select this option to enable Microsoft 
Sysprep support and click Next. You must specify the location of the Microsoft 
Sysprep files.

Remotely install Deployment Agent. Select this option if you want to push 
the Deployment Agent to computers running Windows operating systems.

Install add-ons to provision server hardware. Select this option to install 
OEM add-ons for servers.

Note
This option is enabled only when add-ons are present in the oeminstall-addons 
section of the oeminstall.ini file, which is located in the eXpress directory.

12. Click Finish.

You have successfully completed a Thin Client install for a Deployment Server system. 
Click the Deployment Console icon on your desktop to view all the computer resources 
running Deployment Agents configured for your Deployment Server.

Note
Antivirus applications can delete service .EXE files or can disable services.

Example: When you run the Deployment Server Win32 Console, the “Unable to connect 
to the Altiris Deployment Server DS Management Server. Please ensure this service is 
started and running currently.” error appears. This occurs because the service files are 
deleted by the antivirus application during scanning. To resolve this issue, disable the 
antivirus software and reinstall the Deployment Server.

Component install
The component install option lets you add selected Deployment Server Components — 
Deployment Console, Deployment Web Console, PXE Server, and Deployment Agents to 
the existing Deployment Share. You can also add Microsoft Sysprep files.

See Deployment Server components on page 335.
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To run a component install

1. Start the server and log on using the administrator account you created for the 
Deployment Server. See Deployment Server system requirements on page 340.

2. Launch the appropriate Altiris Deployment Server installation file and follow the 
setup steps.

The Altiris Packager Self-Extracting Executable Options dialog appears.

3. Select the Use current temp folder option to use the current temporary folder to 
download installation files or the Extract to a specific folder option to set a path 
to an existing folder to download the installation files.

4. Click Extract and Execute App to extract and execute the application immediately.

The default installation directory is C:\DSSetup. If the file C:\DSSetup\AppLic.dll 
already exists, a prompt appears, asking whether you want to overwrite this file. 
Click Yes to All. You may have to wait for some time while Altiris Packager extracts 
files from this archive.

Note
(Optional) Click Extract Only to only extract the application and execute the 
application later. You must run the axInstall.exe file to start the installation.

5. Select the Component Install option from the installation types listed in the 
Deployment Server Install Configuration dialog and click Install.

6. Click Yes on the Software License Agreement page.

7. Enter a path for the Deployment Share and click Next.

8. Select the components you want to install and click Next.

Install an additional Deployment Console. Select this option to install 
another Deployment Console (a Windows executable) on another computer. You 
can add as many Deployment Consoles as required to manage from multiple 
consoles across your system, but you can install only one at a time. The 
Deployment Console Information dialog appears.

Install an additional Deployment Web Console. Select this option to install 
an additional Deployment Web Console on the local computer. You can install 
the Web console only on computers running Windows and Microsoft IIS. See 
Deployment web console information on page 369. The Deployment Web 
Console Information dialog appears.

Install an additional Altiris PXE Server. Select this option to add additional 
PXE Servers across a network segment to handle boot requests for large 
environments. The PXE Server Information dialog appears.

Master PXE Server. When you add another PXE Server, the PXE Server that 
you initially installed is designated as the Master PXE Server. The Master PXE 
Server works concurrently with any additional PXE Server to handle boot 
requests across the network segment, but it also allocates additional blocks of 
IP addresses to other PXE Servers in the system.

For all the available options for installing PXE Server, see PXE server install on 
page 368.

Install additional Deployment Agents. Select this option to install additional 
Deployment Agents on client computers, setting up managed computers in the 
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Deployment Server system. The Remote Agent Install dialog appears. Enter 
common administrator credentials for all client computers. See Enter 
administrator account information on page 353.

Add Microsoft Sysprep files. Select this option to install the Microsoft 
Sysprep files, if you did not install them earlier. The Sysprep dialog appears. 
See Sysprep on page 370.

9. Select the computer where you want to install the selected components and click 
Next. The Installation Information page appears.

Note
If you select the On a remote computer option, you must browse and select the 
remote computer.

10. Click Install to install the listed components or click Back to modify settings before 
starting the installation. The installation process begins and can take several 
minutes. The Installation Information Summary page appears, specifying that 
the installation was successful.

11. Select the Install add-ons to provision server hardware option to install the 
add-ons for Dell computers. Click Finish.

Note
This option is enabled on Dell computers only when add-ons are present in the 
oeminstall-addons section of the oeminstall.ini file, which is located in the eXpress 
directory. This is the only option available on the Installation Information 
Summary page when you select Component Install.

You have successfully completed a Component Install for a Deployment Server 
system. Click the Deployment Console icon on your desktop to view all the 
computer resources running Deployment Agents configured for your Deployment 
Server.

Installing Deployment Solution agents
Each client computer requires the Deployment Agent to run as the Production Agent on 
a local hard disk, which communicates with the Deployment Server and registers in the 
Deployment Database. For Windows and Linux client computers, Deployment Solution 
lets you push agent software to a client computer from a Deployment Console, or you 
can pull the Deployment agent to the client computer from the Deployment Web Console 
(or pull it from the Deployment Share).

You can install an embedded (recommended) or hidden automation partition, which 
contains an Automation Agent that establishes communications with the Deployment 
Server to run the deployment jobs that are assigned to the client computer.

See Install automation partition on page 133.

Deployment Agent. Install a Production Agent to a Windows desktop, notebook, or 
server computer. You can also install this agent on any supported Linux workstation 
or server. See Installing the Deployment Agent on page 353.

Deployment Agent on Linux. Install on any supported Linux workstation or 
server. See Installing Deployment Agent on Linux on page 357.
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Automation Agent. Install on any Windows desktop, notebook, or server 
computer. See Installing the automation agent on page 358.

Deployment Agent on XP, 2003, Vista (Business) and 2008 Server. Install 
the Deployment Agent on the selected Windows computers.

Client connectivity and network adapters
Altiris supports all standard network adapter cards and includes many drivers with the 
installation of Deployment Solution. However, sometimes outdated drivers (including 
default drivers that come with the hardware) cause problems when clients are in 
automation mode. To avoid these problems, you should check the manufacturer’s Web 
site for your network adapter to ensure you use their latest driver in your pre-boot 
operating system configuration file.

Some common client problems that can be solved by updating drivers are:

Locking when loading drivers or failing to connect to the server

Locking when imaging (downloading, uploading, or multicasting)

Microsoft client drivers

The Boot Disk Creator is set up to work with drivers that follow a certain standard. 
Because not all NIC drivers follow that standard, you may have to move the files to a 
different location. Ensure that the following files are in the same directory:

The DOS driver for your card (drivername.dos) 
The sample protocol.ini that comes with your driver (protocol.ini) 
The OEM setup file that specifies the DOS driver (oemsetup.inf)

Example: The OEM setup file may contain lines similar to the following:

[netcard]

NGRPCI=”NETGEAR FA310TX Fast Ethernet PCI 
Adapter”,0,ndis,ethernet,real,NGRPCI,NGRPCI_NIF

[NGRPCI] (This header must be the sixth item listed in the line 
above)

Device=NGRPCI.DOS (If this line is missing, add it. The syntax is 
device=drivername.)

If there is no protocol.ini file, create a text file that contains the following command:

DriverName=drivername

Novell client drivers

The Boot Disk Creator performs the following functions:

Searches all subdirectories for a directory that contains *.ins, *.com, and net.cfg 
files. (These files must be in the same directory.) The .INS file is opened to get 
information about the network card.

Searches the file for a line starting with a carat (^). This line must have at least two 
values listed, separated by a comma. The two values needed are the description of 
the card (value1) and the .com driver file name (value2).
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Installing the Deployment Agent 

For client computers running a Windows operating system, Deployment Solution lets you 
install agent software using the Remote Agent Installer to “push” the agent to a client 
computer from a Deployment Console. (See Remote agent installer on page 353.) You 
can also pull the Deployment agent to the client computer by accessing the Windows 
share or downloading the install package from the Deployment Web Console. You must 
have administrative rights to the client computers and File and Print Sharing must be 
enabled to install the agent software.

Remote agent installer
DAgent replaced AClient as the default agent for the Windows operating systems.

Windows XP

To install, each XP computer must have the following items:

An Administrator account with a password. This account must be able to browse 
\\hostname\admin$ on the selected computer.

Disabled simple file sharing. This option can be disabled in Windows Explorer by 
selecting Tools > Folder Options > View tab and clearing the Use simple file 
sharing check box in the Advanced settings section.

Enabled File and printer sharing in the Windows Firewall.

Windows 2003, Vista, 2008 servers, and Windows 7

You must enable file and print sharing in the Windows Firewall.

Enter administrator account information
Enter common administrator credentials for all client computers, or keep the default 
credentials to be prompted for each client computer.

Let me specify a username and password for each machine as it’s installed. 
Prompts for an administrative user name password for each computer in the remote 
install list. This is the default option.

Use this username and password for all clients. Enter credentials for an 
administrator account that has rights to all the client computers that you add to the 
remote install list.

Specify install directory
Enter a location to install the Deployment Agent.

Install directory. Enter the path to install the Deployment Agent on the client 
computer.

 

Click Remote Agent Installer on the Deployment Console toolbar, or 
click Tool > Remote Agent Installer to open the utility program. You 
can also download aclient.exe from the network share or Deployment 
Web Console to install a Deployment agent.
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Enable this agent to use SIDgen and/or Microsoft Sysprep. If you plan to use 
SIDgen or Sysprep to configure this computer the required files can be copied when the 
agent is installed.

Click Change Settings to set the Deployment Agent settings.

See Deployment agent settings on page 110.

Automatically add to a group
You can select one of the following options to automatically add new computers to the 
group that you specify.

Add client(s) to default group. Adds new computers to the All Computers group.

Add client(s) to a specific group. Adds new computers to another group. Use back 
slashes to separate subgroups.

Select computers on the network
Identify client computers on the network and add them to a list of computers to 
remotely install the Deployment Agent. 

Add. Select the computers by the name in the list, or enter a computer name or IP 
address.

Computer Name. Enter the name of a computer on the network or its IP address.

Properties. Select a computer and view the agent install settings. You can also change 
SID and Agent settings from the Agent Properties dialog.

Import. Import new computers from a file.

This file has the following parameters: -c:[computer] –u:[username] –
p:[password] –i:[input file]. The parameters must be entered in this order. 
The password parameter is not required if the administrator account does not have one 
assigned. If you are using the default settings, you do not need to specify an input 
filename. Each computer entry must be on a separate line.

Export. You can export the listed computers into an export file to use later. The default 
extension is *.RCI. Remote Agent Installer first looks for an RCI file extension, but any 
DOS text file can be used. 

When the computers appear in the installer list and the properties are set, click Finish. 
The status of the agent install appears.

After the Deployment Agent is installed, it automatically connects to the Deployment 
Server and appears in the Computers pane of the Deployment Console.

Download Microsoft sysprep 
If you select Enable this agent to use SIDgen and/or Microsoft Sysprep on the 
previous dialog, the Remote Agent Installer dialog locates the required installation 
files for the specific versions of Sysprep.

Update file system permissions when changing SIDs. Select this option to 
automatically update file system permissions to maintain the individual file permissions 
that you may have set. This also includes the individual network shares that may exist 
on this client. On selecting this option, SID conversion takes a long time.
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Note
SIDgen is no longer supported and should not be used. Altiris recommends using 

Microsoft Sysprep in situations where SID replacement is required.

Change settings
Click Change Settings to modify access, security and other settings on the Deployment 
Agent to be installed.

See Deployment agent settings on page 110.

Get server security key
This page appears only if you select the Enable key-based authentication to 
Deployment Server option in the Default Agent Settings dialog.

Enter the security key file path for the Deployment Server or browse and select a file 
containing the security key file path.

Installing Deployment Agent for Windows
Run AClient.exe from the Deployment Share (shared folder) or download the installation 
file from the Deployment Web Console.

1. On the Altiris Client Service dialog, enter a location to install the Deployment 
agent. Select one of these options, if required, and click Next:

Secure modification of server properties. Select to prohibit users from 
changing any agent settings.

Enable changing of Security ID. Select to manage the security IDs to run a 
SID utility as part of an imaging job. 

Advanced. Click to open the Computer Configuration Properties dialog and 
enter the settings for the Deployment agent you are installing. See Computer 
configuration properties on page 101.

2. If you have enabled the security IDs, a page listing the options for managing the 
SIDs appears. Select the utilities you want to use and enter the path where the 
utilities are stored. Click Next to install the Deployment Agent.

3. (Optional) Select a group in the Deployment Console to add the client to. You can 
also leave it at the default group.

After the Deployment Agent is installed, it connects to the Deployment Server and 
appears in the Computers pane of the Deployment Console.

See Installing Deployment Solution agents on page 351.

 

To install Microsoft Sysprep, you must download the installation files 
required for the Windows operating systems running on the client 
computer.

Windows XP/2003 (deploy.cab)

We recommend installing these files from a Windows 2003 server CD. 
Windows Vista and 2008 Server include sysprep files by default.
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Automating the installation of Deployment Agent

If you do not select Remote Agent Installer to install the Deployment Agent, install the 
Deployment Agent using log-on scripts or batch flies. However, this requires that you 
manually complete the installation at each client computer. Instead, you can use a 
template file to set applicable options and properties.

The template file is a text file that can be used to automate configuration of the 
properties when installing the Deployment Agent from a batch file, login script, or 
manually from a client computer.

The template file can be created using two methods: editing the sample.inp file or using 
Remote Agent Installer.

Editing the sample.inp file
Deployment Solution ships with a sample template file named sample.inp, which 
contains the commands to configure installation options and properties. This file is 
located in Program Files\Altiris\eXpress\Deployment Server.

Most of the parameters are disabled in this file. To enable an option, remove the 
semicolon. Example: To specify an IP address and port number for the client to locate 
the Deployment Server, remove the semicolon from the TcpAddr and TcpPort lines and 
change the address and port number to the correct values.

Using remote agent installer
You can create a template file when running Remote Agent Installer. After modifying 
agent properties and adding computers to the Selecting Clients window, click Export 
to create a template file to import computers (*.rci) as well as the template file (*.inp).

Example: If you have computers named PC-1 and PC-2 listed in the Selecting Clients 
window and you export these computers using the file name Export.rci, the following 
two template files are created:

Export_PC-1.inp

Export_PC-2.inp

Using the template file
To use the template file you create, run the AClient.exe installation program specifying 
the template file and using the -install switch. Example:

\\FX1\eXpress\AClient.exe aclient.inp -install

The following command-line options are available:

Option Definition

-install AClient.exe runs and installs the Deployment Agent on the 
computer instead of just running it in memory.

-remove Permanently removes the Deployment Agent from the computer 
where it is installed.

-silent Lets you use the options without being prompted for further 
input.
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Installing Deployment Agent on Linux
You can install the Deployment Agent on any supported Linux workstation or server by 
downloading and running the Deployment Agent for Linux installation file (a .BIN file) on 
the client computer. The Deployment Agent is updated automatically on Linux computers 
when you upgrade to a new version of Deployment Solution. The creation date of the 
Deployment Agent is checked and updated when a new agent is available.

 Installing the Deployment Agent for Linux

1. After downloading the .BIN file to a local directory, you can install from the 
command line.

Browse to the directory where you saved the .BIN file, switch to the root user 
(su) and change the directory to the location of the .BIN file by entering

(cd < directory>)

After changing the directory, you must have the permission to execute the .BIN 
file; to obtain the permission, enter

chmod 544 <filename>

Enter: ./<file name> 

The Deployment Agent for Linux is installed in the /opt/altiris/
deployment/adlagent directory.

2. To change the adlagent configuration file settings, update the adlagent.conf file. 
This file is located in the /opt/altiris/deployment/adlagent/conf directory. 
You can also change the adlagent configuration file settings by executing the 
configure script from the /opt/altiris/deployment/adlagent/bin 
directory.

To edit the configure file directly, open the adlagent.conf file located in the  
/opt/altiris/deployment/adlagent/conf directory and make the 
required changes.

You can also edit the configuration file to change the functionality or properties. 
Example: You can open the adlagent.conf file in an editor and scroll to the 
[Transport] section and the UseMcast line. Change UseMcast=true to 
UseMcast=false. In the TCPAddr=<IP address> line, enter the IP address 
of the specific Deployment Server you want to manage the client computer. You 
can also identify and edit additional configuration settings in the configuration 
file.

To run the script to change the settings for the adlagent configuration file, 
browse to the /opt/altiris/deployment/adlagent/bin directory from 
the shell and enter

./configure

-stop Stops the Deployment Agent from running, but does not remove 
it. The next time the computer is booted, the Deployment Agent 
runs in production mode.

-start Starts the Deployment Agent. This option works only when 
Deployment Agent is installed on the computer.

Option Definition
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You are prompted to select Multicast options to identify a Deployment Server to 
manage the current client computer, or you can select a specific Deployment 
Server by setting the Multicast option to false and adding the IP address of the 
required Deployment Server. 

3. After editing the configuration file, restart the Deployment Agent for Linux.

To start and stop the Deployment Agent for Linux, enter the full path or browse to 
the /etc/rc.d/init.d directory (with administrator/root rights). You can use 
either the adlagent stop and adlagent start commands, or only the 
adlagent restart command. You can also use the Package Manager installed 
with Linux to restart the Deployment Agent for Linux.

By stopping and starting the Deployment Agent for Linux, the service updates the 
changes made in the adlagent configuration file.

You can now view the Linux managed computer from a Deployment Console.

See Installing Deployment Solution agents on page 351.

Installing the automation agent 
After Deployment Server has detected a managed computer through the Deployment 
Agent in a production environment, you can install an Automation Partition from the 
Computers pane. 

Here are some other ways to create and install an Automation Agent, which is saved in 
an embedded (recommended) or hidden partition on the client computer’s hard disk.

For Deployment Solution systems running the PXE Server, create boot menu options 
from the PXE Configuration Utility, using one of the following methods: Boot Disk 
Creator, Direct from floppy, or User Specified. See PXE Configuration Utility 
Help.

To install an Automation Partition you can create a Microsoft Install Package (MSI) 
and deploy it using a job from the console. You can also create floppy disks, 
bootable CDs with an ISO image, or bootable USB devices. See Boot Disk Creator 
Help. See Distributing software on page 175.

To install an automation partition

See Install automation partition on page 133.

Managing licenses 
From the Deployment Console, you can find the number of licenses used, detect an 
expired license, or apply a license to a client computer. Although you can install multiple 
Deployment Servers, licensing is based on the number of managed client computers.

The Deployment Server system also provides the license utility to install or update 
regular licenses, or to add licenses to computers installed with Deployment Solution. 
This utility shows the license status, installs a new license, and adds additional licenses. 
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Licensing Terms

See Using the license utility on page 359, Adding a license from the Deployment Console 
on page 361, Rapid Deployment Pack licensing on page 362, Finding the number of used 
licenses on page 362, Computers not using a regular license on page 362, Detecting an 
expired license on page 362, and Expired licenses on page 363.

Using the license utility
The Deployment Server system provides a license utility to update or add licenses to 
installed sites, which lets you apply the license activation key file (.lic file) after Altiris 
products are installed. This utility is installed on the Deployment Share during the 
Deployment Server installation. 

When you open the License Utility, the Altiris Activation Key Wizard appears. On the 
Select Altiris Program Files to Activate page, you can select the Replace all 
existing license Activation Keys with this new Activation Key check box, which 
overwrites the current Activation Key with the one you are installing.

Term Description

AUP - Annual Upgrade 
Protection

Altiris Annual Upgrade Protection or AUP lets registered 
Altiris software users upgrade to any version of the 
registered product that is released during the coverage 
period without paying an upgrade charge. Regular 
production licenses never have a license expiration 
date, but always have an AUP date. As long as this date 
does not expire, you can use the license to register any 
version of Deployment Server.

Licensed Nodes The total number of client and server computers that a 
Deployment Server is licensed for. Each client computer 
that has an agent, and that communicates actively with 
the Deployment Server, uses a single license node. 

You can view this information on the About 
Deployment Console box. This information appears in 
the License Details section when you apply a license 
using the Product Licensing Utility.

DS and PCT These are common abbreviations for Deployment 
Server and PC Transplant. Both these products are 
licensed with the same licensing model, and often a 
single license applies to both products at once, although 
some licenses apply only to PC Transplant.

Expired License All regular licenses (that are purchased) never expire. 
However, evaluation licenses do have an expiration 
date. After the expiry date, the trial or evaluation 
licenses do not function, and need to be replaced with a 
regular license.
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You can use the License Utility to view the license status, install a specific product, install 
new or updated licenses for installed software, and additional licenses for installed 
software.

To view license status

1. Open the License Utility.

2. Enter the directory path to the new .LIC file.

3. Click Next.

A summary page displays the activation key information.

4. Click Cancel.

Install a regular license for products
When a product is installed from the Altiris CD or the Altiris Web site, a 7-day trial 
license is automatically applied. However, you can apply a 30-day evaluation license or a 
purchased regular license to installed products that use a license activation key file 
(.LIC). 

Note
Save the license activation key file, because you will need it when future product 
updates are released. After you receive the key, store it in a safe place (such as a floppy 
disk) for future reference. You can store multiple license activation key files in individual 
folders on a single disk. You can also store multiple license activation key files in the 
same folder, but the file names must be different.

To apply a regular license file

1. Open the License Utility.

2. Enter the directory path to the new .LIC file and click Next.

The Altiris Activation Key Wizard displays the activation key information.

3. Click Next.

A list displays the Altiris products that are installed on the Deployment Server. Each 
program file uses license activation key files.

4. Select the products that you want to license.

Use the Shift key to select multiple products.

 

To open the License Utility

Option 1:

Click Start > Programs > Altiris > Deployment Solution 
> Product Licensing Utility.

Option 2:

1. Browse to the location where you installed the Deployment 
Share.

2. Run license.exe. 
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Click Add and browse to add another Altiris product. Select the program 
filename and click Open.

Select the products that you do not want to apply a license to and click 
Remove.

5. Click Finish to apply the license to the selected products.

See Installing Deployment Solution agents on page 351.

Install multiple licenses
Some Altiris utilities can combine multiple licenses together for the total number of 
nodes. Example: Two 50-node licenses can be combined to a single 100-node license. 
This option lets you apply an “add-on” license to the Altiris products that you have 
installed on the Deployment Server.

1. Open the License Utility.

2. Enter the directory path to the new .LIC file and click Next.

The Altiris Activation Key Wizard displays the activation key information.

3. Click Next.

A list displays the Altiris products you have licensed.

4. Click Finish.

See Managing licenses on page 358, Adding a license from the Deployment Console on 
page 361, Rapid Deployment Pack licensing on page 362, Finding the number of used 
licenses on page 362, Computers not using a regular license on page 362, Detecting an 
expired license on page 362, and Expired licenses on page 363.

Adding a license from the Deployment Console
Use this option to install a license to a computer from the Deployment Console after the 
free trial has expired. You must apply a regular (permanent) license to continue 
managing client computers. You cannot install a license directly on a client computer. 
However, you must install a regular license on the Deployment Server before you can 
install and manage licenses for client computers from the Deployment Console.

To install a regular license on a single computer

1. From the Deployment Console, right-click the computer to which you want to apply 
the license.

2. Select Properties.

3. Select Apply regular license.

4. Click OK.

 To install a regular license on multiple computers

1. From the Deployment Console, right-click the computer group to which you want to 
apply the license.

2. Select Advanced.

3. Select Apply Regular License.
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See Managing licenses on page 358, Using the license utility on page 359, Rapid 
Deployment Pack licensing on page 362, Finding the number of used licenses on 
page 362, Computers not using a regular license on page 362, Detecting an expired 
license on page 362, and Expired licenses on page 363.

Rapid Deployment Pack licensing
Rapid Deployment Pack (RDP) is the version of Deployment Server that is released to HP 
customers. The RDP licensing functionality is similar to the Deployment Server licensing. 

If you have RDP licenses with AUP longer than 3 years the Deployment Solution license 
utility might not work. To use these licenses, download the installation files from the HP 
Web site. These installation files use a slightly different version of the Product Licensing 
Utility, and they allow licenses with long AUP dates. 

See Managing licenses on page 358, Using the license utility on page 359, Adding a 
license from the Deployment Console on page 361, Finding the number of used licenses 
on page 362, Computers not using a regular license on page 362, Detecting an expired 
license on page 362, and Expired licenses on page 363.

Finding the number of used licenses
Open the Deployment Console and select Help > About from the main menu bar. You 
can see the total number of licenses you have purchased, the total licenses you have 
used, and the total licenses available.

You can view the information in the Computers pane to understand for which 
computers regular licenses have been applied. In the Computers pane, a clock icon in 
the lower left corner implies that the computer still has a free license.

See Managing licenses on page 358, Using the license utility on page 359, Adding a 
license from the Deployment Console on page 361, Rapid Deployment Pack licensing on 
page 362, Computers not using a regular license on page 362, Detecting an expired 
license on page 362, and Expired licenses on page 363.

Computers not using a regular license
From the Deployment Console, you can understand which computers do not have a 
regular license. If the icon has a clock in the lower left corner of the Computers pane, it 
is an HP computer that still has the free 30-day license.

See Managing licenses on page 358, Using the license utility on page 359, Adding a 
license from the Deployment Console on page 361, Rapid Deployment Pack licensing on 
page 362, Finding the number of used licenses on page 362, Detecting an expired 
license on page 362, and Expired licenses on page 363.

Detecting an expired license
A computer listed in the Computers pane of the Deployment Console will be gray 
instead of blue if the license has expired. However, this may not always mean that the 
license has expired. To verify that the license has expired, use the following options:

When you select a computer with an expired license, the following message 
appears:

Client license expired - see computer properties.
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If you try to view the properties of a computer with an expired license, the following 
error message appears:

Error: You have chosen a computer that has expired. Clients that are expired 
cannot be managed until a license is purchased for them and they have been 
flagged in the Computer Properties dialog to accept a regular license.

Note
If you place a job on a computer with an expired license, the same error message 
appears.

Directing client computers to the correct Deployment Server

If you review the client computer list from the Deployment Console and notice that some 
computers are not available when you select them, it is possible that the computer was 
moved from one Deployment Server to the other, and the former server had an expired 
licence. To verify that a client computer is associated with the Deployment Server you 
want, do the following:

1. Click the Deployment Agent icon on the client computer.

2. Select Properties.

3. Enter the IP address of the correct Deployment Server in the Address/Hostname 
field.

4. Click OK.

See Managing licenses on page 358, Using the license utility on page 359, Adding a 
license from the Deployment Console on page 361, Rapid Deployment Pack licensing on 
page 362, Finding the number of used licenses on page 362, Computers not using a 
regular license on page 362, and Expired licenses on page 363.

Expired licenses
Regular Deployment Server licenses do not expire, however the 7-day trial license and 
the 30-day evaluation licenses do expire, and can cause some problems if not replaced 
properly after adding regular licenses. Computers with expired licenses become dead 
nodes and can no longer be managed by the Deployment Console.

When a license is first installed on the Deployment Server, each computer in the 
database takes a license node. If this node is a temporary license, that computer has a 
tag in the database that says it is a trial node. If that license is not replaced before the 
time limit, the computer stops accepting jobs or any type of remote management.

When the Deployment Server receives new regular licenses, it does not by default 
release the trial license nodes that it was using before. This can cause problems if the 
trial licenses are still being used and they expire even after you apply a regular license. 
You can use one of the following methods to deal with this lingering expired license 
issue:

You can set up a global option that automatically replaces any trial license with a 
regular license as soon as they become available. This is a long term and 
preventative solution to expired license issues.

1. In the Deployment Console, go to Tools > Options.

2. Click the Global tab. 
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3. Select the Automatically replace expired trial licenses with available 

regular licenses check box. This resolves the computer node licenses expiry 
issue.

You can reapply all regular licenses to the computer nodes. This is helpful if you 
want to see an immediate resolution to a license issue.

1. In the Deployment Console, right-click the All Computers computer group (or 
any other computer group you need to do this to).

2. Select Advanced > Apply Regular License. This makes all computer nodes in 
that group release the license node they were using and take a regular license 
node.

See Managing licenses on page 358, Using the license utility on page 359, Adding a 
license from the Deployment Console on page 361, Rapid Deployment Pack licensing on 
page 362, Finding the number of used licenses on page 362, Computers not using a 
regular license on page 362, and Detecting an expired license on page 362.

Installation help
The following are the help file topics for the Deployment Server installation program that 
you can access by clicking Help or pressing the F1 key. These topics identify and explain 
the elements on the dialogs used in the installation process.

Configuration
The Deployment Server system supports a Simple Install as well as a Custom Install 
option. A Simple installation lets you install all components on a single computer. The 
Custom installation lets you distribute individual components of a Deployment Server 
system on multiple computers. The Thin Client Install lets you install the Thin Client 
view of the Deployment Console on your computer. The Component Install option lets 
you install additional components on your system.

Pre-installation

Simple install helper. Select this option to check for an installation of Microsoft SQL 
Server for a Simple Install. If Microsoft SQL Server or MSDE is located, the installation 
program continues. Otherwise, the installation program prompts you to download and 
install MSDE from the Altiris Solutions Center.

Installation type

Simple install. Select this option to install all Deployment Server components on a 
single computer. This configuration is recommended for managing computers on a single 
LAN or across a site with few subnets.

See Simple install for Deployment Server on page 341.

Include PXE server. Select this option to install the PXE Server when running the 
Simple install option. The PXE Server requires a DHCP server also installed on your 
network.

See PXE server on page 338.

Custom install. Select this option to install Deployment Server components on multiple 
computers across your system. A Custom Install lets you balance network activity for 
large enterprises with multiple subnets. Example: Use this option to distribute the 
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Deployment Database on another computer or assign another file server as the 
Deployment Share to store image and package files.

See Custom install for Deployment Server on page 344.

Thin client install. Select this option to install the Thin Client view of the Deployment 
Console on your computer. You do not require a license file to install this view.

See Thin client install on page 347.

Component install. Select this option to install additional Deployment Server 
components on your system. Example: Use this option if you want to add a PXE Server 
to your Simple or Custom installation, or if you need multiple Deployment Consoles.

See Component install on page 349.

If you have multiple network adapter cards, a secondary dialog appears asking you to 
select the IP address for the Deployment Server interface.

See also Deployment Server system requirements on page 340. 

Note
If you run the Deployment Server on a MS Windows Server 2003 Domain Controller with 
SMB Signing enabled, you cannot execute any imaging and DOS jobs. When running 
jobs on MS Windows Server 2003, you must change the SMB Signing Registry Key to 
execute DOS-based deployment jobs.

To disable SMB signing on the Windows 2003 server

1. Click Start > Control Panel > Administrative Tools > Local Security Policy > 
Local Policies >Security Options.

2. Locate the Microsoft network server: Digitally sign communications 
(always) policy setting, right-click it, and select Properties > Disabled.

3. Disable the Microsoft network server: Digitally sign communications (if 
client agrees) policy setting as well. This is enabled by default.

Installing Deployment Server
Specify the Deployment share (shared directory) where you want to store the image 
files, .RIPs, and other package files. Before installing the Deployment Server, ensure 
that you have a shared Windows or NetWare directory with free disk space and 
appropriate security rights.

File server path. Select the drive letter and directory path where you want to install 
the Deployment Server. The default path is the Program Files directory on the local 
computer.

Create Deployment Share. If you are installing the Deployment Server on a local 
Windows computer, select this option to create a shared directory as your Deployment 
Share. If you are installing on a remote file server or if you select an invalid path, this 
option is unavailable.

Note
If you are installing the Deployment Server on a remote file server, create a share or 
grant access rights to the Deployment Server directory on the file server before you 
start the installation. For Windows XP, you must run the Network Setup Wizard accessed 
from My Network Places to enable sharing.
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Select one of the following options to configure the licensing information:

If you do not have a license file, select the Free 7 day license option to use an 
evaluation license for a new Deployment Server installation.

Select the Upgrade using existing license option to upgrade the installation 
using an existing license.

Select the License File option and browse to locate the license file (.LIC file) 
that you received when you registered on the Altiris Web site. See the Altiris 
Getting Started Guide for further licensing information.

Service username and Service password. If running a Simple Install, you must enter 
an administrator user name and password for the Deployment Server and the 
Deployment Share. This account must already exist on the Deployment Server and the 
Deployment Share. If you use a domain account, enter the domain name (Example: 
orgDomain\admin.

See Deployment Server components on page 335, Installing Deployment Server, and 
Managing licenses on page 358.

Installing Deployment Server using component install

Specify the Deployment Share (shared directory) where the image files, RIPs, and other 
package files are stored. Ensure that you have a shared Windows or NetWare directory 
with available disk space and security rights before installing.

See Deployment share on page 338.

Deployment Server install
Install the Deployment Server on a computer. The service is identified in the Services 
section of the Windows Computer Management as Altiris eXpress Server.

See Deployment Server on page 336.

To install service on a local computer

1. Select the On this computer option.

2. Enter the Deployment Server IP address and port information.

3. Enter the path to install the Deployment Server.

4. Enter the user name and password of the Deployment Server. For a domain account, 
enter the domain and user name. Create this account before starting the 
installation.

To install service on a remote computer

1. Select the On a remote computer option.

2. Enter the name of the computer or browse to where you want to install. By default, 
the destination path and IP address of the computer appear.

3. Enter the user name and password of an administrator account for the Deployment 
Server computer. For domain accounts, include the domain name (Example: 
orgDomain\admin). The user account must have rights to the Deployment Share. 
Create the administrator domain account before starting the installation. See 
Deployment share on page 338.
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See Deployment Server components on page 335 and Installing Deployment Server on 
page 334.

Pre-boot operating system (simple) 
Select a pre-boot operating system, which the Deployment Server can use as the 
default, when creating a deployment job with an automation task. You can also install 
additional pre-boot operating system files later by using Boot Disk Creator.

If you are running a PXE Server in your system environment, the first pre-boot 
operating system that you install becomes the default boot menu option for Initial 
Deployment. The menu options display DOS Managed, Linux Managed, or Windows 
Managed.

You can assign an automation pre-boot operating system to an automation task when it 
is added to a deployment job. This flexibility lets you run several automation tasks 
within a single job, and each task can boot to the automation environment you want.

None. Select this option if you do not want to provide a default automation 
operating system. You can also select this later through the Boot Disk Creator utility.

FreeDOS. Browse to the BDCgpl.frm file. This is available on the Deployment 
Solution download site.

MS-DOS. DOS requires an original Microsoft Windows installation disk, or browse to 
the system formatted files.

Linux. Browse to the BDCgpl.frm file. This is available on the Deployment Solution 
download site.

WinPE. Browse to the WinPE files.

See Boot Disk Creator Help and PXE Configuration Help.

Pre-boot operating system (custom) 
Select a pre-boot operating system that the Deployment Server can use as the default 
when creating a deployment job with an automation task. You can also install additional 
pre-boot operating system files later by using Boot Disk Creator.

If you are running a PXE Server in your system environment, the first pre-boot 
operating system that you install becomes the default boot menu option for Initial 
Deployment.

You can assign an automation pre-boot operating system to an automation task when it 
is added to a deployment job. This flexibility lets you run several automation tasks 
within a single job, and each task can boot to the automation environment you want.

FreeDOS. Browse to the BDCgpl.frm file. This is available on the Deployment 
Solution download site.

MS-DOS. DOS requires an original Microsoft Windows installation disk, or browse to 
the system formatted files.

Linux. Browse to the BDCgpl.frm file. This is available on the Deployment Solution 
download site.

WinPE. Browse to the WinPE files.

See Boot Disk Creator Help and PXE Configuration Help.
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Deployment database install

Install the Deployment Database on a local or remote server with or without an existing 
Microsoft Data Engine (MSDE) or Microsoft SQL Server. To install the database, you must 
have administration rights to the selected server.

See Deployment database on page 337.

Note
If you have multiple instances of the Microsoft SQL Server already set up, you can 
identify a specific instance using this format: <SQL Server Name>\<database 
instance>. The instance of the database can vary. Example: If you have a clustered 
Microsoft SQL Server to manage multiple Deployment Solution systems on different 
network segments, you can enter the name salesSegment\express or 
marketingSegment\express depending on the previously established database 
instance.

Install the Deployment Database using these options:

Select the Microsoft SQL Server instance where you want to install your Deployment 
database.

You can also change the default SQL Port number. 

You can rename the Deployment Database default name, eXpress, by entering a 
different name in the Database Name field. However, this does not alter the 
Deployment Share name.

See Deployment Server components on page 335.

PXE server install
Select the options to boot locally using the Altiris Automation Partition. For PXE-
compliant computers, you can boot across the network using the Intel Pre-boot 
eXecution Environment option in the PXE Server.

See PXE server on page 338.

Note
If you have a Novell NetWare file server, you must set up the PXE Server after installing 
the Deployment Server. The Universal Network Device Interface (UNDI) default driver is 
not supported by Novell NetWare.

Select the No I will be using an Altiris automation partition on each client 
computer option, if you do not want to use PXE and prefer to use embedded 
(preferred) or hidden partitions, or bootable media to run tasks.

Note
This option is unavailable for installing the PXE Servers using the Component Install 
option.

Select the Yes, I want to install PXE Server on this computer option to install 
the PXE Server on the local computer.

Note
This option is selected by default for the Component Install.
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Select Yes, I want to install PXE Server on a remote computer to install the 
PXE Server on a remote computer. Enter the name of the computer and the path.

Enter the IP address for the PXE Server and the Deployment Server. 

Enter the path where you want to install the PXE Server.

Select the pre-boot operating system that can be used as the default PXE boot 
menu item. The pre-boot operating system options that are enabled depend on the 
options you selected for the pre-boot operating systems in the Pre-boot Operating 
Systems page. Example: If you select Linux in the Pre-boot Operating Systems 
page, the Linux option is enabled as the default PXE boot menu item.

See Installing the automation agent on page 358, Pre-boot operating system (simple) 
on page 367, and PXE Configuration Utility Help.

Client connection to server
Select the protocol your managed computers can use to connect to the Deployment 
Server. 

Connect directly to Deployment Server. Installs the PXE Server using the Intel Pre-
boot eXecution Environment (for PXE-compliant computers only). You can use this 
without PXE for faster access, as it goes directly to the IP address without searching.

If managed computers are on a different segment or if you are using the PXE Server 
with an UNDI driver, click Connect directly to Deployment Server and enter the IP 
address of the Deployment Server that the managed computers can connect to. Do not 
change the port number unless the default is already being used.

Note
If you change the port number, you must change the client configurations.

Discover Deployment Server using TCP/IP multicast. Lets the managed 
computers connect to any Deployment Server. To use multicasting and connect to a 
specific Deployment Server, enter the name of the Deployment Server computer.

Multicasting cannot be used with the UNDI driver. If you want to use different drivers on 
the PXE Server, you can create multiple PXE boot files after installing.

See Deployment agents on page 109.

Deployment web console information
This feature lets you remotely manage Deployment installations, deploy and manage 
Windows and Linux computers (both client and server editions) in real-time, and benefit 
from many of the features available in the Deployment Console.

To install deployment web console

1. By default, the Deployment Web Console installs on the computer that is running 
the installer. Select the On a remote computer option and browse to a computer 
where you want to install. If you do not want to install the Deployment Web 
Console, select the Do not install option.

2. If you want to change the default values, enter the Console port and Deployment 
Web Console path for the installation.
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3. You must enter the Service username and Service password that already exist 

on the Deployment Share and the destination computer where you install the Web 
Console.

Note
If you are installing an additional Deployment Web Console using the Component Install 
option, the Do not Install option is disabled.

See Deployment Console on page 335 and Deployment Server components on 
page 335.

Sysprep
Enter the location of the Microsoft Sysprep files according to the operating system. 
Specify the location or browse and select the required files.

Installing components
Click Install, or click Back to change the settings.

See Deployment Server components on page 335.

Installation information summary
The components are installed.

You can remotely install Deployment Agents, enable Sysprep support, and download 
Adobe Acrobat for documentation.

Enable Microsoft Sysprep support. Select this option to enable Sysprep support. 
Provide the location of the Microsoft Sysprep files.

Remotely install Deployment Agent. Select this option to push the Deployment 
Agent.

Install add-ons to provision server hardware. Select this option to install the add-
ons for Dell computers.

Note
This option is enabled on Dell computers only when add-ons are present in the 
oeminstall-addons section of the oeminstall.ini file, which is located in the eXpress 
directory. This is the only option available on the Installation Information Summary 
page when you select Component Install.

Click Finish.

See Deployment Server components on page 335.

Add components summary
The components in the list are installed.

Download Adobe Acrobat. Select this option to download the Adobe Acrobat Reader 
to read the documentation in the .PDF format.

Click Finish.

See Deployment Server components on page 335.
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Deployment database authentication

Specify the type of authentication the Deployment Database will use. You can select 
Windows authentication or SQL Server authentication. If you select SQL authentication, 
enter the user credentials with administrative rights for the SQL database.

Use Windows NT authentication. Select this option to use the Windows network or 
Active Directory authentication.

Use SQL Server authentication. Enter the user name and password set for the 
Microsoft SQL Server. If using MSDE, the default “sa” user name is used and no 
password is required. 

See Deployment Server components on page 335 and Installing Deployment Server on 
page 334.

Add components
If you have already installed Deployment Server, you can add components to the 
existing system. Select the type of component you want to add.

See Deployment Server components on page 335.

Console install
You can install the Deployment Console either on the local computer or on multiple 
remote computers. Installing the Deployment Console on remote computers lets you 
manage computers from multiple Deployment Consoles across the Deployment Server 
installation.

See Deployment Console on page 335.

Select the On this computer option to install the Deployment Console on the local 
computer.

Select the On a remote computer option to install the Deployment Console on a 
remote computer. Enter the computer name or browse and select a computer.

See Deployment Server components on page 335 and Installing Deployment Server on 
page 334.

Installer return codes

For a list of return codes for the installation program, see the Error Messages in 
Deployment Solution chapter in the Reference Guide.
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Chapter 12
Managing from the Deployment Console 

Deployment Solution provides both Windows and Web user interface consoles to deploy 
and manage computer devices across local or wide area networks. It also provides a 
Thin Client view of the Deployment Console. As an IT administrator, you can manage all 
computer devices from one of these Deployment Consoles:

The Deployment Console is a Windows-based console with complete deployment and 
management features, including remote control, security, PXE Server configuration, 
image editing, and other deployment utilities and features. See Deployment Console 
basics on page 70.

The Deployment Web Console provides basic deployment and management 
functionality from a Web browser, including the ability to remotely access and manage 
computer devices, build and schedule jobs, and view multiple Deployment connections.

The Thin Client View of the Deployment Console provides a simplified experience when 
dealing exclusively with Thin Clients. The functionality of the Thin Client Console is 
identical to that of the current Deployment Console. However, you can toggle from Full 
View to Thin Client View.

Deployment from the Symantec Management Console combines management and 
reporting features across multiple Deployment Server systems and lets you integrate 
additional Web applications in the client and server management suites, including 
Inventory, Software Delivery, Recovery, HelpDesk, Patch Management, and Application 
Metering solutions.

Features of the Deployment Console. The Windows console for Deployment Solution 
provides standard Computers, Jobs, and Details panes to drag and drop icons, view 
properties, and identify the state and status of Deployment objects. In addition, the 
Deployment Console also includes a Shortcuts and Resources view and provides the 
tools, utilities, and features required for complete computer resource management. See 
Deployment Console basics on page 70.

Set program options. From the Tools > Options dialog, you can set preferences for 
each Deployment Server system. See General options on page 82.

Set security. From the Tools > Security dialog, you can set security rights and 
permissions for all Deployment Consoles. See Security in Deployment Solution on 
page 87.

Connecting to other Deployment Server systems. Connect to other Deployment 
Server connections from your current Deployment Console and manage computers 
outside of your current network segment or site. See Connecting to another Deployment 
Server on page 93.

 

To launch the Deployment Console, click the icon on the desktop, or click 
Start > Programs > Altiris > Deployment Solution > Console.
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Customize the Tools menu. You can add commands to the Tools menu to open 
commonly-used deployment programs and utilities. See Extending the tools menu on 
page 79.

Deployment Console basics 
The Deployment Console is your main portal to Deployment Solution. It is a feature-rich 
Win 32 program with real-time access to computer resources, deployment jobs, and 
package files, each represented by distinct icons to identify the status and settings. 
From the Deployment Console, you can build simple or complex deployment jobs, assign 
them to a computer group, and verify deployment execution.

Because the Deployment Console can reside on its own computer, you can have multiple 
consoles running from different locations. The Deployment Console needs to be running 
only while creating assignments or viewing information about the managed computers. 
You can turn on the console, run management tasks, and turn off the console.

Scheduling information is saved in the Deployment Database and tasks are executed at 
their scheduled time. If an assignment to a managed computer is made from two 
different consoles at approximately the same time, the computer is assigned those tasks 
in the order they are received. See Console options on page 82 to set refresh intervals 
for the Deployment Console.

Features of the Deployment Console
The Deployment Console is divided into several panes to organize computers, 
deployment jobs, and software packages and scripts. It gives you a graphical view of 
your network and provides features to build jobs, drag and drop icons to schedule 
operations, store and access jobs and packages, and report the status and state of your 
computer resources. The Deployment Server includes three main panes, toolbars, 
wizards, shortcuts, and utility programs.

Computers pane 
Use this area to view and select managed computers for the Deployment Server system. 
You can select and right-click a computer in the Computers pane to run remote 
operations using Deployment Solution or to view the computer properties. You can also 
create computer groups to organize collections of similar computers. See Remote 
operations using Deployment Solution on page 122 and Computer properties on 
page 119.

When you select a computer or group, a list of the computers in the group appears in 
the Details pane and provides the basic information about each computer. The Filter 
detail bar appears in the Details pane that helps to view computers according to set 
criteria. When a computer is selected, you can view the computer status in the Details 
pane, including a list of jobs that are running or are scheduled to run on the computer 
and the status of each job.

Create computer groups by clicking Computer Groups on the toolbar, or 
right-clicking in the Computers pane and selecting Groups. Click View > 
Show Computers to display only computer group icons and not individual 
computers.
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To get more details about all tasks that are run on computers, click Status Detail. 
Status Detail displays a more detailed breakdown of the tasks that the job has executed 
and a status message indicating the status of the tasks.

You can also import new computers from a text file or add security rights and privileges 
for a specified computer or group of computers. See  on page 95 for complete 
information about setting up, importing, and managing computers from the Computers 
pane.

Jobs pane
Use this area to create and build jobs using specific deployment tasks. You can select 
and right-click a job in the Jobs pane when building new jobs or running the New Job 
Wizard. You can also import new jobs from a text file or add security rights and 
privileges for a specified job or collection of jobs. See Building new jobs on page 150 
and New job wizard on page 146.

Set up folders to organize and access jobs according to your specifications. To create a 
new folder, right-click in the Jobs section and select the New Folder option. You can 
also create folders by selecting File > New > Folder.

When you select a job, the Details pane displays a list of computers in the folder and 
gives a basic information about each job, such as its state and status. It also shows the 
computers or computer groups to which the job is assigned.

The Conditions detail bar also appears, letting you assign jobs to computers. See 
Setting conditions for task sets on page 151.

In System Jobs, folders are created to store jobs that are created when running 
operations from the console.

Drag-n-Drop Jobs. Jobs are created and automatically placed in this folder when 
you drag an .MSI, .RIP, or other package files from the Resources view to a specific 
computer or group. See Shortcuts and resources view on page 72.

Image Jobs. Jobs are placed in this folder when you create a Quick Disk Image. 
See Quick disk image on page 125.

Restoration Jobs. Jobs are placed in this folder when you restore a computer from 
its Deployment history. See Restoring a computer from its deployment history on 
page 124.

From the Jobs pane, you can drag job icons to computer icons to run jobs, such as 
creating images, deploying computers, changing configurations, or installing software. 
After you create a job, you can change it by adding, modifying, or deleting tasks. You 
can run jobs immediately, schedule them to run at a particular time, or save them for a 
later time. See  on page 145 for complete information about setting up, importing, and 
managing computers from the Jobs pane.

Click View > Jobs View to show or hide the Jobs pane. 
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Details pane

The Details pane extends the user interface features when working in the Computers, 
Jobs, or Shortcuts panes.

When you select a computer in the Computers pane, the Details pane changes to 
a Filters section (if you click a group icon) and displays the status of all jobs 
assigned to the selected computer.

When you select a job icon in the Jobs pane, the Details pane displays the 
information about the job to set up conditions, order tasks, and to add, modify, or 
remove tasks.

When you select a computer or computer group in the Computers pane, the 
Details pane displays the information about a computer, such as its IP address, 
MAC address, and status.

When you select a batch file, you can click Modify to update the file.

When you select a hard disk image file (.IMG), the Details pane displays a 
description of the image file and information about the included partitions.

When you click on the package files, the Details pane displays the title, description, 
version, creation date, and platform of an .RIP file or Personality Package.

Shortcuts and resources view
The Shortcut and Resources pane provides easy access to the computers and job 
objects identified in the console and the software packages stored in the Deployment 
Share. In the Shortcuts view, you can drag computers, computer groups, jobs, and job 
folders to organize and access commonly-used console objects. In the Resources view, 
you can identify and assign package files.

The Shortcuts view provides quick links to view and access computers, jobs and 
packages. It can act as a palette of Deployment Solution icons that you can drag to 
other working panes in the console, or as a storage to save commonly-used jobs and 
computer icons.

The Resources view lets you see a filtered view of the package files — .MSI files, .RIPs, 
image files, Personality Packages, and other resource packages — stored in folders in 
the Deployment Share. From the Resources view, you can drag packages directly to 
the computers in the Computers pane to deliver the software. This automatically 
creates jobs in the System Jobs > Drag-n-Drop Jobs folder in the Jobs pane. The 
Resources view lets you identify packages assigned to each job and assign those 
packages to create new jobs.

 

Click View > Shortcuts View to open the Shortcuts and Resources 
pane. You can drag the jobs and computer icons to this pane. Click 
Resources in the Shortcuts and Resources view, or click View > 
Resources or CTRL+R to open a filtered list of packages on the 
Deployment Share.
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Using resources directly

If you do not want to create a shortcut to a resource, but still want to use a resource to 
assign a job to a computer, you can move the resource to a designated computer. To do 
so:

1. Enable the Shortcuts view.

2. Click Resources at the bottom of the Shortcuts window.

3. Browse to the selected resource and drag it to the appropriate computer.

You can create a new script file from the Resources view and use it directly to schedule 
it on a computer. See Creating new script files on page 192.

See Console options on page 82 for options to set refresh intervals for the Resources 
view.

Thin client view of the Deployment Console
The Thin Client view of the Deployment Console provides a simplified experience when 
dealing exclusively with Thin Clients. The functionality of the Thin Client view is identical 
to that of the current Deployment Console. However, you can switch from Full view to 
Thin Client view.

The Thin Client Console has the following panes:

Computers

Resources

Software Packages

Inventory

The Computers, Resources, and Software Packages panes are on the left side of the 
Thin Client view, while the Inventory pane is on the right side of the Thin Client view. 

Installing the thin client view
During installation, you can install the Deployment Solution Thin Client view. By default, 
the traditional Deployment Console is installed.

If you select Thin Client view, a Thin Client Jobs system folder is created. All the jobs 
created from the Deployment Solution Thin Client view are stored in this folder. During 
the installation process, the following folders are created in this hierarchy for the Thin 
Client resources:

Configuration Packages

Images

Software Packages

Deployment Solution for Thin Clients uses the same installation program as Deployment 
Solution. No licensing is required even if you select Thin Client Install.

To install thin client

To install Thin Client, choose one of the following options:

On the Deployment Server Install Configuration dialog, select the Thin Client 
Install option. The Deployment Console Thin Client View appears.
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On the Deployment Server Installation dialog, select the Simple Install option. 
The Deployment Console appears. Click View > Show Thin Client View. The 
Deployment Console Thin Client View appears.

Switching between two views
When you switch between the traditional view and the Thin Client view, you can 
maintain the last state in which you viewed the console. This ensures that you open the 
console in the same view that you last closed it in.

To switch between the traditional and the thin client view

1. Click View.

2. Select Show Thin Client View.

Note 
By default, the Thin Client view is visible if you select Thin Client Install.

When you switch to the Thin Client view, all the menus and items that are not necessary 
for the Thin Client view are unavailable. These are visible when you switch to the 
traditional view.

Computers pane
This pane is the same as that in the traditional view. However, only thin clients are 
displayed. You can right-click this pane to view a new menu. When you right-click a thin 
client, you can view the following options:

Capture Configuration

Capture Images

Deploy Configuration

Deploy Image

Install Automation Partition

Get Inventory

Power Control

Properties

Remote Control

Delete

Manage Inventory View

If you select a Capture option, a text field appears, prompting you for the name of the 
captured resource. By default, the name is the same as the serial number on the Thin 
Client, which you can change.

If you select a deploy option, a list of the available resources appears for the selected 
type, such as Configurations, Images, or Software Packages. You can select a resource 
from this list.

To create a job

You can create a job in one of the following ways:
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Select any of the first six options from the Computers pane. All these jobs are 
scheduled at the current time.

Note 
The Schedule Computers for Job dialog does not have the Job Schedule tab. 
Also, all the automation jobs have the default option selected for boot image.

Drag resources to the Computers pane or computers to the Resources pane to 
schedule jobs at the current time.

Note
Ensure that you have the required permissions to drag and drop resources.

All thin client job details are saved in the Thin Client Jobs system folder. You cannot 
delete or rename this new system folder from the console.

All the above options, except Properties, are disabled when the client is not active.

Note 
All the jobs on the thin clients are automatically created and scheduled by the console, 
and this happens only when the clients are active. When creating the jobs, the console 
refers to the operating system type (platform) of the client.

Resources pane
This pane is a treeview listing all the resources that you can drag and drop to the thin 
clients and vice versa. The following types of resources appear in this pane:

Configuration Packages. Example: Captured Registry Settings.

Images

Software Packages. Example: HP Tools.

Note 
All these resources reside in the eXpress share in the ThinClient directory.

When you click any of the submenus corresponding to the subdirectories within the 
ThinClient directory, the tree expands and displays all the resources included in the 
directory. If the folder is empty, an appropriate message appears. You can rename or 
delete the resources.

Software packages
The Software Packages pane displays the software packages that can be created for 
the available computers. You can drag and drop this resource to the thin clients and vice 
versa.

When you right-click the Software Packages pane, you can view the following options:

New folder. Select this option to create a new folder.

Import. Select this option to import a job. See To import a job on page 76.

Rename. Select this option to rename a folder.

Note
You cannot rename the Software Packages pane. You can only rename a folder.
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Delete. Select this option to delete folders.

Find Software Packages. Select this option to find software packages.

To import a job

1. Open the Thin Client view.

2. Right-click the Software Packages pane and select Import.

The Import Job dialog appears.

3. In the Job file to import field, browse and specify the file that you want to import.

Note
By default, the Import to Job Folder, Overwrite existing Jobs and Folders 
with the same names, and Delete existing Jobs in folder options are disabled.

To preserve the source operating system file paths of Scripted Install, select the 
Preserve Scripted Install OS source paths option.

Click OK.

To delete the Software Packages option from the Deployment Console

1. Open the Deployment Console.

2. In the Jobs pane, select System Jobs > Thin Client Jobs > Software Packages.

3. Right-click Software Packages and select Delete.

A confirmation dialog opens.

4. Click Yes to confirm the deletion.

The Software Packages option is deleted from the Deployment Console view.

Note
The Software Packages option is automatically added in the Jobs pane in System 
Jobs > Thin Client Jobs when you switch from the Deployment Console view to 
the Thin Client view.

Inventory pane
This pane displays a table that lists all the thin clients identified by the console. The 
following columns appear in the Inventory pane:

Name

Computer Status

Action Status

Product Name

Operating System

Image Version

Flash Size 

Memory Size

BIOS version
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You can select which columns to view. The following columns are available, but do not 
appear:

Automation Partition

CPU

Domain name

IP address

MAC address

To view Inventory columns

1. Right-click the Inventory pane. The Manage Inventory Columns dialog appears.

2. You can add columns to either the Selected columns list or the Available columns 
list by clicking the required arrows.

3. Click OK.

Toolbars and utilities
The toolbars and menus on the Deployment Console provide major features and utility 
tools to deploy and manage computers from the console. From the Main toolbar, you 
can create new jobs and computer accounts and run basic deployment tasks. On the 
Tools toolbar, you can launch Deployment Solution administration tools and package 
editing tools. It also includes icons to quickly run commonly used remote operations. 
See Remote operations using Deployment Solution on page 122.

Deployment Solution utility tools
The Deployment Console lets you open utility programs from the Tools menu or from 
the Tools toolbar. You can launch Deployment Solution administration tools (Boot Disk 
Creator, PXE Configuration, Wise SetupCapture and Remote Agent Installer) and 
package editing tools (Wise MSI Editor, PC Transplant Editor, and Image Explorer) from 
the toolbar.

Administration tools

  Boot Disk Creator. Use this tool to create boot disk configurations, and 
automation and network boot media to image client computers. The Boot Disk Creator 
can maintain several different boot disk configurations for different types of network 
adapter cards. See Altiris Boot Disk Creator help.

  PXE Configuration. After installing the PXE Server, you can create and modify 
configurations, which make up the boot menu options that appear on client computers. 
This is another another option to boot computers to automation. See the Altiris PXE 
Configuration help. 
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  Remote Agent Installer. Remotely install the Deployment Agent on client 
computers from the console. This utility lets you push the agent installation to client 
computers from the Deployment Console. DAgent is the default agent for all Windows 
platforms.

  PC Transplant Editor. Use this tool to edit a Personality Package to add or 
remove data. See the Altiris PC Transplant Help located in the Deployment Share.

  Image Explorer. After a disk image is saved to the Deployment Share, this tool 
lets you view and manage data in the image file. You can edit and split an image, create 
an index, and more. See the Altiris Image Explorer help file located in the Deployment 
Share.

  Wise MSI Editor. Edit .MSI packages generated from the Wise Setup Capture 
tool or other .MSI files used to distribute software and other files.

 SVS Admin Utility. Create, import, and manage virtual software layers. See 
Software Virtualization Solution on page 78.

DeployAnywhere Driver Database Management. Lets you run DeployAnywhere to 
create hardware independent images. This functionality is provided by Symantec Ghost 
Imaging Foundation (GIF). To add and manage drivers, on the Tools menu, click the 
new DeployAnywhere option. To enable this functionality, select the DeployAnywhere 
option from the deploy image task. For more information about DeployAnywhere or 
Ghost, see the Symantec Ghost Imaging Foundation documentation.

Software Virtualization Solution
Altiris® Software Virtualization™ Solution (SVS™) is a revolutionary approach to 
software management. SVS places applications and data into managed units called 
virtual software packages. You can use SVS to activate, deactivate, or reset applications 
to avoid conflicts between applications without altering the base Windows installation.

The SVS Admin Utility is a part of SVS. It creates, imports, and manages virtual 
software layers, which are part of the packages. For information on installing and using 
the SVS Admin Utility, see the Software Virtualization Solution Reference Guide.

For information on the integration of the SVS Admin Utility with Deployment Solution, 
see Using SVS admin utility with Deployment Solution on page 79.
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Using SVS admin utility with Deployment Solution

On a Deployment Solution computer, you can capture application and data files. The 
installed application, data files, and settings are captured into the virtual software 
layers.

The Deployment Solution computer should have a clean installation of the Windows 
operating system. The computer should not have any background processes or 
programs running that can be captured into the layers. Your base computer should not 
be running an antivirus program or any other computer management program. If 
possible, the computer should not have an active Internet connection.

You can create layers on a virtual computer. (See Managing the SVS layer on page 177.) 
This lets you disconnect a computer from the network and reset the computer after each 
capture. This ensures that you have a clean operating system.

You can also distribute .RIPs, .MSI files, scripts, personality settings, and other package 
files to computers or groups. See Distributing software on page 175.

Extending the tools menu
You can add commands to the Tools menu on the Deployment Console to quickly access 
additional management applications. This lets you easily access applications commonly 
used with Deployment Solution.

Commands are added by modifying or adding new .INI files. You can insert commands 
to the root ATools.ini file for the main menu or add new .INI files to create submenus. 
Place both types of .INI files in the directory where the Deployment Console executable 
(eXpress.exe) is located. The default location is Program Files\Altiris\ 
eXpress\Deployment Server. 

You can add up to eight menu items to the main menu, and eight menu items for each 
submenu.

These .INI fields are included for each application added to the “Tools > Altiris Tools” 
menu:

[Application name or submenu declaration]

MenuText=<the application name displayed in the menu>

Description=<the name displayed when you mouse over the menu item>

WorkDir=<directory set as default when executable is run>

Executable=<path to the executable files>

The ATools.ini file extends the main Tools menu on the console. This sample file 
contains one submenu, Web Tools, and two additional menu items, Notepad and 
Netmeeting. The .INI files are located in the Deployment Share.

[Submenus]

Web Tools=wtools.ini

[Notepad]

MenuText=Notepad Editor

Description=Simple Editor
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WorkDir=.

Executable=C:\WINNT\notepad.exe

[NetMeeting]

MenuText=NetMeeting

Description=NetMeeting

WorkDir=.

Executable=C:\Program Files\NetMeeting\conf.exe

Another Tools .INI file is wtools.ini. It is a submenu file referenced by the main 
ATools.ini file. On the main menu, this is titled “Web Tools” (see Tools.ini) and contains 
two applications, Internet Explorer and Adobe Acrobat. 

[Explorer]

MenuText=Explorer

Description=Windows Explorer

WorkDir=.

Executable=C:\Program Files\Internet Explorer\explorer.exe

[Acrobat]

MenuText=Acrobat Reader

Description=Acrobat Reader

WorkDir=.

Executable=C:\Program Files\Adobe\Acrobat\acrobat.exe

Computer filters and job conditions
Use this dialog while creating a computer group filter to filter only the specified 
computers in a computer group, or while setting conditions for task sets when running a 
job only on the specified computers in a group. See Creating a computer group filter on 
page 81 and Setting conditions for task sets on page 151.

Creating conditions to assign jobs
You can set conditions on a scheduled job to run only on the computer devices that 
match a defined criteria. As a result, you can create a single job with tasks defined for 
computers with varying properties, including the type of the operating system, network 
adapters, processors, free disk space, and other computer properties. For each job, you 
can now create task sets that are applicable only to the computers matching those 
conditions.
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Creating custom tokens

You can create custom tokens to set conditions based on the database fields that are not 
provided in the available preset conditions in the Conditions dialog. Example: Select 
User Defined Token from the drop-down list in the Fields box. Select contains in the 
Operation field, and enter Milo in the Value field. In the Token field, enter the 
following custom token: %#!computer@lic_os_user%. This filters out only the jobs 
with the registered license user named Milo. The job runs only on the computers that 
meet the specified criteria.

Creating a computer group filter
The Computer Filters dialog displays a list of all computers in a group according to the 
specified criteria. Example: You can create a filter to view all the computers in a 
particular group that have Windows 2008, 256 MB of RAM, and 20 GB hard disks only. 
By applying the filter, you can view all the computers that meet the specified criteria in 
the Details pane of the Deployment Console.

Click a job in the Jobs pane. The Condition feature appears in the Details 
pane. Click Setup to add new conditions or edit existing conditions. When 
you are setting conditions to schedule a job, select from a list of predefined 
database fields or create custom tokens that key on other fields in the 
database.

Filter Name Description

Active 
Computers

Displays all the active computers.

Inactive 
Computers

Displays all the inactive computers.

Computers With 
Failed Jobs

Displays all the computers where jobs have failed to execute.

Windows 2003 
or 2008

Displays only the computers with Windows 2003 or 2008 
operating systems.

Windows XP/
Vista

Displays only the computers with Windows XP or Vista operating 
systems.

Windows CE 
(PDAs)

Displays only the computers with Windows CE operating systems.

Linux Displays only the computers with Linux operating systems.

Windows XP 
Embedded

Displays only the computers with Windows XP Embedded 
operating systems.

Windows CE 
.NET

Displays only the computers with Windows CE .NET operating 
systems.

Pocket PC 
(PDAs)

Displays only the Pocket PC computers.
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To create or modify a computer filter

1. Click the All Computers group or any other computer group.

2. On the Filter bar in the Details pane, click Setup > New to create a new filter.

Or

Click Setup > Modify.

3. Type a name for the filter and click Add. The Filter Definition page appears.

4. Define the conditions you want to filter. 

Click the Field box to see a list of computer values stored in the Deployment 
Database. Select a computer value and set the appropriate operation from the 
Operations list. In the Value box, enter an appropriate value for the selected 
database field. Example: You can choose Computer Name as the Field, Contains 
as the Operation, and Sales as the Value.

5. Repeat to include other conditions. Click OK.

General options 
Use the Program Options feature to set the general options for Deployment Solution. 
Click Tools > Options to view the Program Options dialog.

Console options

Global options

Task password options

Domain accounts options

RapiDeploy options

Agent settings options

Custom data sources options

 Console options 
Set basic console features for miscellaneous refresh actions and warning messages.

Scan resource files for changes every ____ seconds. Specify how frequently (in 
seconds) the Deployment Console updates its view of package files in the Resources 
view. See Shortcuts and resources view on page 72.

Warn user when no tasks are assigned to the 'default' condition. When a job is 
assigned to computers and the default condition has no tasks assigned, a message 
appears. The job has no secondary default tasks assigned if a computer in the group 
does not meet the primary conditions. See Setting conditions for task sets on page 151.

Refresh displayed data every ____ seconds. Refresh the display of data accessed 
from the Deployment Database. This lets you refresh console data at defined intervals 

 

Click a computer group in the Computers pane. The Filter feature appears 
in the Details pane for the selected computer group. Click Setup to add 
new filters, or to modify and delete existing computer filters.
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instead of updating every time the Deployment Console receives a command from the 
server, which can be excessive traffic in large enterprises.

Global options 
Set global options for the Deployment Server system.

Delete history entries older than _____ days. Specify the number of days entries 
are kept in the history before they are deleted. Enter any number between 1 and 
10,000. If you don’t select this option, log entries remain in the history.

Remove inactive computers after ____ days. Specify the number of days you want 
to keep inactive computers in the Deployment Database before they are deleted. The 
default value is 30 days, but any number between 1 and 10,000 is valid.

Synchronize display names with computer names. Automatically update the 
displayed name of the managed computer names in the console when the client 
computer name changes. If this option is not selected, changes to the computer names 
are not reflected in the console. Synchronization is off by default. The names do not 
have to be synchronized for the Deployment Server to manage the computer.

Reschedule failed image deployment jobs to immediately retry. Immediately 
retry a failed image deployment job. The program continues to retry until the job 
succeeds or until the job is cancelled.

Client/server file transfer port: _____. Specifies a static TCP port for file transfers 
to the clients. The default value is 0 and causes the server to use a dynamic port. This 
setting is useful if you have a firewall and need to use a specific port rather than a 
dynamically assigned port.

Automatically replace expired trial licenses with available regular licenses. Lets 
Deployment Solution automatically assign a permanent license to the computer after the 
trial license expires.

Note
Be careful when using this option. Ensure that you do not give a permanent license to 
computers you do not want to manage after their trial license expires.

Display Imaging status on console. Displays the status of the imaging job on the 
Deployment Console.

Remote control ports. Specifies ports for using the Remote Control feature. You have 
the option to enter a primary port address and a secondary port address (Optional).

Remove task passwords when exporting or copying jobs. Specifies that you must 
remove the task password when exporting or copying jobs.

Display only computers and jobs the user has rights to manage. Displays only the 
computers and jobs that the user has rights to manage. If this option is not selected, all 
of the computers and jobs are displayed. If this option is selected when security is 
enabled and the logged-on user has administrator rights, all computers and jobs are 
displayed. However, if this option is selected when security is enabled and the logged-on 
user does not have administrator rights, that user’s view is restricted to see the jobs and 
computers that the user only has rights to. A computer is displayed if the logged-on user 
has any permission on the computer’s group or if the computer’s group inherits any 
permissions from a parent folder.
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Do not update configuration data on a failed configuration task. If checked, does 
not overwrite the data in the Deployment Solution database if a configuration task fails. 
The database is not updated until a successful configuration task finishes running.

Primary lookup key(s). Specifies the lookup key type(s) used to associate a new 
computer with a managed computer. The options are Serial Number, Asset Tag, 
UUID, or MAC Address.

Sysprep Settings. This lets you enter global values for Sysprep. See Sysprep settings 
on page 84.

Sysprep settings
View and configure the Sysprep settings for the Deployment Server.

OS product key dialog
In the OS Product Key dialog, select the suitable operating system from the 
Operating System drop-down list. After you select the operating system, a list of all 
product keys for the selected operating system appears. Select an operating system 
from the Operating System drop-down list, and click Add to type the Product Key. You 
can type up to 29 characters for the Product Key. The new product key is added to the 
list of available keys of the selected operating system.

To modify a product key, select the product key to be modified, and click Edit. To 
remove a product key, select the product key to be deleted, and click Remove.

Note
If the product key is being used by another task, you cannot delete the product key. You 
are prompted with a message stating that the product key is being used by another 
task.

Task password options 
According to the network and security properties, the passwords for administrators and 
users change after a certain number of days. In such a scenario, the password becomes 
invalid and all jobs and tasks using the user name whose password changes must be 
modified to use the new password. The Task Password option provides administrators 
with a simple option to manage all password changes from a centralized location. 

This feature lets you set or change user passwords from a central location, so you can 
modify the password for the Copy File to, Distribute Software, Run Script, 
Distribute Personality, and Capture Personality tasks when creating or modifying 
jobs. However, this tab is enabled only to administrators and select users who have been 
granted the appropriate privileges.

The Status field displays the results of password updates. Example: User A’s user name 
and password is used in ten tasks. If you want to update the password for these ten 
tasks, you can do so through the Task Password option. After the password is 
updated, the Status field displays the message: Password for 10 tasks updated.

Domain accounts options 
This sign-on feature retrieves the name of the administrator (or the user with 
administration rights) and the password for each domain. This feature lets you avoid 
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needing to log on for each managed computer when you run imaging and configuration 
jobs.

You can provide the user credentials for the parent domain or a trusted domain in this 
window. Deployment Solution supports the UPN and SAM formats, and it accepts either 
the parent domain user’s credentials or the domain user’s credentials for any 
configuration jobs.

Click Add to enter the Domain name. The Add Domain Account page appears. Enter 
the name of the selected domain and provide the administrator credentials. Click OK. 
The administrator name and domain are listed in the Domain Accounts list box.

Note
To enter the administrator user name for a Windows XP domain, you must add both the 
domain name and the user name. Example: Instead of entering only the user name 
jdoe, you must enter domainName\jdoe.

RapiDeploy options 
This feature optimizes the multicasting ability of the RapiDeploy application in the 
Deployment Server, letting you deploy images to a group of computers simultaneously, 
download an image from a file server, or access a local hard drive, and manage the 
imaging of several client computers concurrently.

Because RapiDeploy is more efficient when writing directly to the IP address of the 
network adapter driver, you can enter a range of IP addresses when using the 
multicasting feature for faster computer deployment and management. The Deployment 
Server accesses the range of computers using the defined IP pairs and avoids retrieving 
the computers through the port and operating system layers.

However, because some network adapter cards do not handle multiple multicast 
addresses, you can also identify a range of ports to identify these computers. On the 
first pass, the Deployment Server accesses the selected computers using the list of IP 
numbers. On the second pass, the Deployment Server accesses the selected computers 
using the port numbers or higher level operating system IDs.

Note
Multicasting images are not supported when using the UNDI driver on PXE, and are 
disabled on the client.

Click Reset to set the default values.

Agent settings options 
These are the default agent settings for new computers. Click Change Default 
Settings to change Windows Agents Settings for Windows and DOS. The Change 
Default Settings option is enabled only if you select the Force new agents to take 
these default settings or the Force new Automation agents to take these 
default settings option. Set Deployment Agent settings for new computer accounts or 
set Deployment Agent settings for DOS for new computers. See Deployment agent 
settings on page 110 and Deployment Agent settings for DOS on page 116.

These default settings are applied only for new client computers that have never 
connected to the Deployment Server, and have no information stored in the Deployment 
Database. These settings are not for the existing managed computers, nor are these 
settings applied when setting properties using the Remote Agent Installer.
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When the Deployment Agent connects, the Deployment Server verifies if the computer 
is a new or an existing computer. If the client computer is new and if the Force new 
agents to take these default settings option is selected, the Deployment Agent on 
the client computer receives the default settings established in the Options > Agent 
Settings dialog. If the computer is recognized as an existing managed computer, it uses 
the existing agent settings. The same process occurs for automation agents if the Force 
new Automation agents to take these default settings option is selected.

Force new agents to take these default settings. Select this option to force the 
default settings when adding a new computer.

Force new Automation agents to take these default settings. Select this option to 
force the default settings when adding a new automation agent connects.

Custom data sources options 
This option lets you set up credentials to authenticate to external Deployment 
Databases and other Microsoft SQL Server databases to extract data using custom 
tokens. Click Add to enter an administrator alias and other login information for the 
Microsoft SQL Server (or MSDE) hosting the desired Deployment Database.

The information required to create a custom data source entry is listed below:

Alias. The alias name you want to use when referencing the external SQL database.

Server. The name of the external SQL database server or IP address.

Database. The name of the external database from which you want to extract data.

Use Integrated Authentication. This option authenticates to the external 
database using the domain account you are currently logged on as.

User name and Password. When the integrated authentication is not being used, 
you must provide a user name and password to authenticate to the external 
database.

Allowed Stored Procedures. Click this tab to modify the existing list. See Allowed 
stored procedure list on page 86.

Allowed stored procedure list 
Click Allowed Stored Procedures to identify the stored procedures from the selected 
custom data source. You can now select from the list of available stored procedures in 
the data source. This lets you call stored procedures outside of the Deployment 
Database (eXpress database) using custom tokens within scripts or answer files.

Virtual centers options
You can keep a list of all VMware Virtual Center Web services. The hosts and virtual 
computers from each Virtual Center that have corresponding computers in the 
Deployment Database appear in the computer tree. These virtual computers appear 
under the Virtual computers node in the Computers pane.

Click Add. On the Virtual Center page, enter the Display name, Server hostname, 
and Username. By default, the port number is displayed. You can also set up a 
password for the selected user.
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Security in Deployment Solution 

Deployment Solution provides a security system based on associating job and computer 
objects with user and group permissions, letting IT personnel be assigned to different 
security groups to manage operations on specific computer groups or job folders. Each 
security group can perform only a defined scope of deployment operations on each 
computer group or job folder. Additionally, each user can be assigned rights to access 
general console features. You can also choose whether to specify that scripts on run only 
on the Deployment Server.

Note
Security rights and permissions set in one console are enforced in all Deployment 
Consoles.

See Best practices for Deployment Solution security on page 87, Enabling security on 
page 88, Setting permissions on page 92, Groups on page 89, and Rights on page 90.

Best practices for Deployment Solution security
Deployment Solution is based on defining groups of users and groups of computers and 
jobs, and associating one with another. We recommend that you first create user groups 
based on administration duties or access to levels of deployment operations. For 
example, You probably set up a group with full Administrator rights. This group has 
access to run all operations on all computers using all types of jobs. No permissions 
need to be set on each computer group or job folders for the Administrator group 
because this has full rights to all features and resources.

However, you can also set up a Technician group that has only basic access and 
permissions limiting deployment operations. This prohibits members of the group from 
re-imaging the Server computer group or scheduling Distribute Disk Image jobs. You 
can explicitly Allow or Deny the group from running these operations for each 
computer group in the Computers pane or each job folder in the Jobs pane. 

After creating the Technician group, you can limit their rights to set General Options and 
set permissions on each computer groups and job folder for the group. See General 
options on page 82. You can select the computer group, right-click it and select 
Permissions. Select the group name in the left pane, and click Allow or Deny for a list 
of deployment operations. Example: You can select the Deny check boxes for Restore, 
Schedule Create Disk Image, and Schedule Distribute Disk Image.

Additional groups can be created with different rights and permissions depending on the 
needs and responsibilities in the IT team. If users are assigned to multiple groups, the 
Evaluate Permissions and Evaluate Rights features are sorted and display effective 
permissions and rights.

 

To set general security rights, click Tools > Security and add a user name 
and password. You can create users and groups and set scope-based rights. 

To set feature-based permissions for specific computers or jobs, select the 
object in the console, right-click and select Permissions.
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Enabling security 

You can enable security by first creating a group with Administrator rights, adding a user 
to the Administrator group, and selecting Enable Security.

Note
When the Administrator Right is selected, you do not need to select any other rights 
because the Administrator Right implies that all other rights are selected.

1. Click Tools > Security. 

The Security dialog appears.

2. Click the Manage User Groups tab and click Add. The Add User Group dialog 
appears.

3. Select the authentication type. You can add a DS group or a group from the Active 
Directory. To add groups from Active Directory, see Adding groups from the Active 
Directory on page 90.

4. Click DS Group.

Note
The Browse option is disabled for Local Group.

5. Type a name and description in the Add User Group dialog. Click OK.

The group name appears in the window.

6. Select the new group name and click Rights.

7. Select Administrator in the Rights dialog. This assigns complete rights and 
permissions to the group. Click OK, and click Close.

8. On the main Security dialog, click the Manage Users tab, and click Add. 

The Add User Account dialog appears.

9. Select the authentication type. You can add a DS user or a user from the Active 
Directory. To add users from the Active Directory, see Adding users from the Active 
Directory on page 89.

10. Select the DS User option in the Add User Account dialog. 

Note
The Browse option is disabled for DS User.

11. Type the user name, full name, and password. Retype the password, and enter a 
description for the user. Click OK.

12. Select the user name in the main Security dialog. Click Rights.

13. Click the name of the new Administrator group in the Groups window. This assigns 
the new user to the new group with Administrator rights. Click OK.

Note
You can assign the user Administrator rights directly, but we recommend you to 
assign users to groups. See Best practices for Deployment Solution security on 
page 87.
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14. Now that you have a user with administrator rights, select the Enable Security 

box.

Security is now enabled. You can now create users and groups and assign permissions to 
computer groups and job folders.

Adding users from the Active Directory

You can add users from the Active Directory.

1. In the main Security dialog, click the Manage Users tab, and click Add.

2. Select the AD User option in the Add User Account dialog.

3. If you know the user name, type it in the User name field, or click Browse to 
select the user from the Active Directory.

The password field is deactivated because the user is being added from the Active 
Directory.

Note
You can add only one user at a time. To import users, see Importing users from the 
Active Directory on page 89.

4. Enter a description for the user in the Description box.

5. Click OK.

Importing users from the Active Directory

You can also import users from the Active Directory. To open a standard Windows Active 
Directory dialog, from the main Security dialog, click the Manage Users tab, and click 
AD Import. Add users from Active Directory, not groups. The users are added to the 
Deployment Database. However, you still need to assign the users to security groups 
with appropriate rights and permissions.

Note
When logging on with the imported AD account, Deployment Solution accessed the 
Windows Active Directory server to validate the user password.

Evaluate rights

Click Evaluate Rights to identify the combined rights of the selected user and its user 
group(s). This feature identifies effective rights for each user by resolving any possible 
conflicts between multiple group settings.

Groups 
Assign the user to previously created groups. If you are enabling security, you can 
assign the user to a group with Administration rights.

To add groups, from the Security dialog, click the Manage User Groups tab, and click 
Add. Select the authentication type, and type the required details. You can view the 
members of any group by clicking the group in the Manage User Groups dialog and 
clicking View Members.

See also Best practices for Deployment Solution security on page 87 and Enabling 
security on page 88.
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Adding groups from the Active Directory
You can add users from the Active Directory. 

1. In the main Security dialog, click Manage User Groups tab, and click Add.

2. Select AD Group in the Add User Group dialog. 

3. If you know the group name, enter it in the Name field, or click Browse to select 
the group from the Active Directory. A list of groups, along with their descriptions, 
appears in a new dialog. Select a group from the list and click OK.

4. The Name, Domain, and Description are displayed. However, you can modify the 
description. Click OK.

The newly added group appears in the main Security dialog.

Importing groups from the Active Directory
You can also import users from the Active Directory. In the main Security dialog, click 
the Manage User Groups tab, and click AD Import to open a standard Windows 
Active Directory dialog. Add groups from Active Directory. You can choose a domain 
from the Domain List, and select a group from the displayed list. The group is added to 
the Deployment Database. However, you still need to assign the users to security groups 
with appropriate rights and permissions.

DS authentication
If the user is already in the Deployment Database and tries to access the Deployment 
Console, the Deployment Server checks the authentication with the logged on user, and 
upon matching does not prompt for user credentials. Similarly, if a group is already 
added in the Deployment Database and if a logged-on user, who is a part of the AD 
group, tries to access the Deployment Console, the Deployment Server does not prompt 
for credentials.

Rights 
This dialog lets you set general rights for a user or group. To verify, add, or change the 
rights assigned to each console user, use the following steps:

1. On the Security page, select a user and click Rights.

2. Click the Rights tab.

3. Select the check box for each right you want to grant.

4. After selecting all applicable rights, click OK to save your changes.

A brief explanation of each Deployment Server right that can be assigned is given 
below:

Administrator. Lets the user access all features available on the Deployment 
Console. You must have Administrator rights to enable security. See Enabling 
security on page 88.

Options Console. Lets you set the view and the Console options. See Console 
options on page 82.

Options Global. Lets you set the view and the Global options. See Global options 
on page 83.
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Options Domain Accounts. Lets you set the view and the Domains Accounts 
options. See Domain accounts options on page 84.

Options RapiDeploy. Lets you set the view and the RapiDeploy options. See 
RapiDeploy options on page 85.

Options Agent Settings. Lets you set the view and the Agent Settings options. 
See Agent settings options on page 85.

Options Custom Data Sources. Lets you create Custom Data Sources options. 
See Custom data sources options on page 86. You can view, create, and set 
database aliases.

Manage Rejected Computers. Lets you view rejected computers in Deployment 
Solution and change their status. See Rejected computers in Deployment Solution 
on page 94.

Refresh Clients. Lets you refresh Deployment Solution clients. See Refresh 
Deployment Solution on page 94. You can use the View > Refresh clients <CTRL 
+F5> feature to disconnect and reconnect client computers.

Allow Scheduling on All Computers Group. Lets you schedule jobs on All 
Computers. If you have administrator rights, by default, you have the rights to 
schedule job on all computers, irrespective of the check box state. You can grant 
this right to a specific user or a group.

Import/Export. Lets you import and export jobs and import computers as well. 
See Importing and exporting jobs on page 193 and Importing new computers from 
a text file on page 100.

Options Task Password. Lets you centrally update passwords for users and 
groups so they can access the Copy File to, Distribute Software, Run Script, 
Distribute Personality, and Capture Personality tasks. You must have administrative 
rights to access this option. See Task password options on page 84.

Use PXE Configuration Utility. Lets you use the PXE Configuration Utility.

Options Virtual Centers. Lets you view and add options for Virtual Centers. See 
Virtual centers options on page 86.

Run Script on DS. Lets you choose to run scripts either on the server or on the 
client.

Access to Master Return Code. If unchecked, restricts access to the master 
return code list. If checked, lets you modify the master return code list.

Allow DeployAnywhere. Lets you run DeployAnywhere to create hardware 
independent images. This functionality is provided by Symantec Ghost Imaging 
Foundation (GIF). To add and manage drivers, on the Tools menu, click the new 
DeployAnywhere option. To enable this functionality, select the DeployAnywhere 
option from the deploy image task. For more information about DeployAnywhere or 
Ghost, see the Symantec Ghost Imaging Foundation documentation.

Restricting the number of computers
This dialog lets you restrict the maximum number of computers that can be selected.

Restricing the number of computers

1. On the Security page, select a user and click Rights.

2. Click the Restrictions tab.
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3. Type the maximum number of computers that each job can be scheduled on.

4. Check the box if you want this user to be able to schedule jobs to run immediately.

5. Click OK to save your changes.

Setting permissions 
Set permissions for jobs, job folders, computers, and computer groups. See Best 
practices for Deployment Solution security on page 87 for additional design tips.

Setting permissions

1. Right-click on a computer group or job folder (or individual computers and jobs) and 
select Permissions. The Object Security dialog appears.

2. Click the Groups tab and select a group name. Or click the User tab and select a 
user name.

3. From the list in the right pane, select if you want to Accept or Deny permission to 
run the operations on the selected computer or job objects. These permissions 
include access to remote operations using Deployment Solution and features for 
scheduling Deployment tasks. See Remote operations using Deployment Solution on 
page 122 and Deployment tasks on page 155.

4. Select the Allow or Deny check box to explicitly set security permissions for these 
Deployment Solution features for the selected objects.

Note
Administrators have access to all objects with unrestricted rights and permissions. 
You cannot explicitly deny permissions to computer or job objects for users with 
administrator rights.

5. To assign permissions to multiple groups, click Set permissions on all child 
objects to assign the values without closing the dialog.

Note
You can set permissions for all jobs and computers by clicking in the Jobs pane or 
Computers pane without selecting a job or computer object.

Permission rules

Permissions received through different sources may conflict with each other. The 
following permission rules determine which permissions are enforced:

Permissions cannot be used to deny the user with Administrator console rights 
access to use any console objects or features.

User permissions take precedence over Group permissions.

Deny overrides Allow. When a user is associated with multiple groups, one 
group could be allowed a permission at a particular level while the other group 
is denied the same permission. In this scenario, the permission to deny the 
privilege is enforced.

Permissions do not flow down an object tree. Instead, the object in question 
looks in the current location and up the tree, and uses the first permission it 
finds.
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If a console user does not have permissions to run all tasks the job contains, 
the user cannot run the job.

Evaluate permissions

Click Evaluate Permissions to identify the combined permissions of groups and 
containers with conflicting permissions. This feature identifies effective permissions for 
each object by resolving any possible conflicts.

If a job includes multiple tasks and one of the tasks does not have sufficiently assigned 
permissions, the whole job fails due to lack of access permissions.

Note
Permissions to schedule jobs also lets a user delete jobs in the Details pane after a job 
runs. Example: If a job contains errors and does not run, no other jobs can be 
scheduled. The user must delete the job before scheduling a new job.

Connecting to another Deployment Server 
From the Deployment Console, you can connect to other Deployment Servers on your 
LAN and manage computers outside of the network segment you are currently logged on 
to. To open a connection, you must connect to the Deployment Database of the 
preferred Deployment Server connection using the ODBC Data Source Administrator.

Note
Although you are accessing another connection (another Deployment Database), 
Windows remembers the last place you browsed to, which would be the Deployment 
Share of the previous Deployment Server connection. You need to browse to the new 
connection’s Deployment Share to access its shared folder that contains its RIPs, 
images, executables, and other resources.

Connecting to a new deployment database

1. Click New. The Define Connection Information dialog appears.

2. Enter a name for the connection to be opened.

3. Establish an ODBC data source.

a. Click ODBC Administrator.

b. Click the System DSN tab, and click Add.

c. Select the SQL Server driver source and click Finish.

d. In the Create a New Data Source to SQL Server dialog, enter a name and 
description for the data source.

e. If an entry for your server already exists, select it from the menu. Otherwise, 
enter the name of the server hosting your remote SQL server in this field. Click 
Next.

Click File > Connect to or press CTRL+O to open the Connect to 
Deployment Server dialog. Enter the required information to connect to the 
external Deployment Server connections using an ODBC driver.
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f. Click Next in the Create a New Data Source to SQL Server dialog to accept 

the default settings for authentication.

g. Select the Change the default database to option and select eXpress from 
the drop-down list. Click Next.

h. Click Finish. The specifications for the new ODBC data source appear.

i. Click Test Data Source to verify that the source is reachable.

j. Click OK. You return to the main ODBC Data Source Administrator dialog 
with your new data source listed in the System DSN tab. Click OK.

4. From the ODBC Data source name drop-down list in the Define Connection 
Information dialog, select the new Data Source name you just created.

5. In the Installation Directory path field, enter or browse the full UNC path (or 
path using any locally mapped drive) to the directory of the required Deployment 
Server, such as:

\\server\express or H:

6. Click OK.

Rejected computers in Deployment Solution 
When an unwanted managed client computers attaches to your Deployment Solution 
system, you can right-click the computer in the Computers pane and select Advanced 
> Reject Connection. You can view these rejected computers by clicking View > 
Rejected Computers. 

The rejected computers are prohibited from being active in the Deployment Database. 
They are identified and rejected by their MAC address.

You can remove computers from the Rejected Computers list by selecting it and clicking 
Accept Computer(s). This lets the computer to attach again and be managed by the 
Deployment Solution system.

Refresh Deployment Solution 
You can refresh the Deployment Console by clicking View > Refresh Console (or 
pressing <F5>) to update data from the Deployment Database. You can also click View 
> Reset Client Connections (or press Ctrl+<F5>) to disconnect and reconnect all 
managed computers in a Deployment Server system.

When you refresh the managed client computers, you are asked if you want to 
disconnect all computers. Click Yes. This tells the Deployment Agent to shut down and 
restart. It also creates additional network traffic when all computers connect and 
disconnect. By refreshing the managed client computers, you ensure that you are 
viewing the current status and state of all computers resources in your system.
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Chapter 13
Managing computers 

From the Computers pane of a Deployment Solution console, you can identify, deploy, 
and manage all computer resources across your organization, including desktop 
computers, notebook computers, network and Web servers, and network switches. You 
can quickly modify any computer’s configuration settings or view its complete 
management history. Or you can take on big projects, such as completely re-image the 
hard drive, restore software, and migrate personality settings for a whole department. 
You now have management of all your computer resources available from a Windows or 
Web console from any location.

All computer resources can be accessed and managed as single computers or organized 
into computer groups with similar hardware configurations or deployment requirements, 
letting you run deployment jobs or execute operations on multiple computers 
simultaneously. You can use search features to locate a specific computer in the 
Deployment Database, or set filters to sort computers by type, configuration, operating 
system, or other criteria.

Manage with computer icons. Major computer types are identified by a computer icon 
in the console, with a list of scheduled jobs and operations associated with each 
computer. In the Deployment Console, you can assign and schedule deployment jobs to 
computers or groups by dragging the computer icon to a job in the Jobs pane, or vice 
versa.

See Viewing computer details on page 96.

Add new computers. Deployment Solution lets you add new computer accounts and 
set configuration properties for new computers before they are recognized by the 
Deployment Server system. Preset computer accounts automatically associate with new 
computers when they start up, or can be associated with pre-configured computers.

See Adding new computers on page 98.

   

Computer icons appear in the Computers pane of the Deployment 
Console, where they can be organized into groups. To assign and schedule 
a job on a computer in the Deployment Server Console, drag a computer 
icon or group icon to a job icon.

 

Click New Computer on the console to create a new computer account. 
You can also click File > New > Computer or right-click in the 
Computers pane and select New Computer.

When the new computer starts up, you can assign it a preset account.

 

Click New Group on the console to add a new group in the Computers 
pane of the Deployment Console. You can also click File > New > 
Computer Group or right-click in the Computers pane and select New 
Group.
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Deploy to groups of computers. Organize computers by department, network 
container, hardware configuration, software requirements, or any other structure to 
meet your needs. You can deploy and provision computers on a mass scale.

To filter computers in a computer group to schedule jobs only to the appropriate 
computer types, see Computer filters and job conditions on page 80.

Configure Computer Agents. See the property pages for modifying Deployment Agent 
settings.

See Deployment agents on page 109.

View and configure computer properties. You can modify computer settings for 
each computer from the console. Or you can view the Computer Properties page for 
detailed access to a computer’s hardware, software, and network property settings.

See Computer configuration properties on page 101 and Computer properties on 
page 119.

Run remote operations from the console. Perform operations quickly in real time 
from a Deployment Console. Restore a computer to a previous state, configure property 
settings, send a file, remote control, chat, set security, run deployment jobs, or select 
from additional management commands.

See Remote operations using Deployment Solution on page 122.

Build and schedule jobs. Build deployment jobs with one or more management tasks 
to run on selected computers. Create jobs, add tasks, and assign the job to computer 
groups. Jobs can be organized and assigned for daily tasks or to handle major IT 
upgrades.

See  on page 145.

Manage Servers. Deployment Solution also manages network or Web servers to 
administrate high-density server farms or server network resources across your 
organization.

See the Deployment Solution Reference Guide.

Viewing computer details 
In Deployment Solution, a computer resource is identified in the console with a 
distinctive icon to display the computer type — Windows desktop or notebook, server, or 
Linux operating system — and its current status. These computer icons change to 
convey the state of the computer, such as the log on status, server waiting status, or 
user with a timed license status. You can also view the status of the jobs assigned to the 
selected computer in the Details pane of a Deployment Console.

See Viewing job details on page 145.

The following is a sample list of computer icons displayed in each Deployment Console, 
identifying the computer type and state.

A computer connected to the Deployment Server with a user logged on. 
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A computer connected to the Deployment Server, but the user is not logged 
on.

A computer with a time-limited user license and a user logged on.

A computer not currently connected to the Deployment Server, but known to 
the Deployment Database.

A pre-configured computer with values defined in advance using the New 
Computer feature. As soon as the computer connects, the Deployment 
Server recognizes the new computer and this icon appears. See Adding new 
computers on page 98.

 

A managed computer waiting for user interaction before running deployment 
tasks. This icon appears if the Workstations check box is selected in Initial 
Deployment. See Sample jobs on page 196.

A computer identified as a master computer used to broadcast images to 
other client computers.

A managed server connected to the Deployment Server with a user logged 
on. Additional icons identify different states of server deployment.

A managed Linux computer connected to the Deployment Server with a user 
logged on. Additional icons identify different states of Linux computer 
deployment.

 

Physical view of Rack/Enclosure/Bay components for high-density 
server systems. These icons appear as physical representations to 
allow management of different levels of the server structure. In 
addition, server icons identify logical server partitions. See Bay on 
page 121 for properties and rules to deploy Rack/Enclosure/Bay 
servers.

 

Select the New Computers or All Computers group to run jobs or 
operations for these default groups identified by an icon in the Computers 
pane.

 

Additional computer groups can be added to the Computers pane to 
organize similar computer types or to list computers of similar departments 
or locations. Click the New Group icon on the toolbar or select File > New > 
Computer Group to create a new group.
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See also Deployment agents on page 109.

Adding new computers
Computers can be added to the Deployment Database using the following methods:

Install the Deployment Agent. If you install the Deployment Agent to a computer 
with the operating system already installed, the computer is added automatically to 
the Deployment Database at startup. New computers with the Deployment Agent 
installed are added to the All Computers groups (unless otherwise specified in the 
Deployment Agent configuration). You can move the computer to another group if 
required.

Use Initial Deployment to configure and deploy new computers booting to 
automation. Starting up a new computer with the Automation Agent lets you 
image the hard drive, assign IP and network settings, distribute personal settings 
and software, and install the Deployment Agent for new computers. Using Initial 
Deployment, you can associate new computers with pre-configured computer 
accounts. These newly configured computers appear in the New Computers group. 
See Sample jobs on page 196.

Create or import computer accounts from the Deployment Console. You can 
add new computers using the New Computer feature or import computers using a 
delimited text file. You can pre-configure computer accounts by adding names and 
network settings from the console. See Creating a new computer account on 
page 99.

About new computers

When a new computer starts up, if Deployment Server recognizes the MAC address 
provided in a New Computer account or import file, it automatically associates the user 
account at startup with the New Computer icon. If this value is not provided, the 
computer appears as a pre-configured computer account, letting you associate it with a 
new computer.

 

Pre-configured computer account

A pre-configured computer account can be associated with a new computer using the 
Initial Deployment feature. You can create multiple pre-configured computer accounts 
and associate the account with a new computer when it boots to automation. At startup, 
the configuration settings and jobs assigned to the pre-configured computer account can 
be associated with the new computer.

Deployment Solution provides features to create a pre-configured computer account to 
pre-define a computer’s configuration settings and assign customized jobs to that 

 

The New Computer icon appears for a new computer if the MAC Address is 
provided when creating a new computer account using any import or new 
computer account feature. 

 

A pre-configured computer account icon appears if specific hardware data 
(MAC Address) is not known. As soon as the computer starts up and is 
associated with a pre-configured computer account, Deployment Server 
recognizes the new computer and this icon appears.
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computer even if you do not know that computer's MAC address. This type of computer 
is known as a pre-configured computer account.

Pre-configured computer accounts offer a lot of power and flexibility, especially when 
you need to deploy several computers to individual users with specific needs. Pre-
configuring a computer account saves your time because you can configure the 
computer before it arrives on site. You can set up as much configuration information 
(such as computer name, workgroup name, and IP address) as you have about the 
computer and apply it to the new computer when it comes online. You can also prepare 
jobs prior to the arrival of the new computer to deploy the computer using customized 
images, .MSIs, and .RIPs, based on a user's specific needs.

Example: A user might request Windows 2003 with Office and virus scanning software 
installed on the new computer. The user also might request that the computer 
personality (customized user settings, address books, bookmarks, familiar desktop 
settings) be migrated from the old system. You can build any job, including any of the 
available tasks, and assign it to a pre-configured computer account.

When the new computer finally arrives, you are ready to deploy it because you have 
done all the work in advance. Boot the client computer to automation, and the new 
computer can connect to the server and become a managed computer. Now you can 
perform an Initial Deployment or run a deployment imaging job on the new computer.

Creating a new computer account 
You can create computer accounts for individual computers or for computer groups. 
When creating new accounts for computer groups, you can automatically assign new 
names and associate them with existing computer groups or the New Computer group.

To create a new computer account

1. In the New Computers dialog, click Add. The New Computer Properties page 
appears.

2. Enter names and configuration settings for each new computer account using the 
Computer Configuration screens. See Computer configuration properties on 
page 101 for a description of the configuration settings.

Note
If you do not enter a MAC address, the computer you create or import becomes a 
virtual computer.

3. (Optional) Click Import to add new computers from a delimited text file. See 
Importing new computers from a text file on page 100.

4. Click OK.

A pre-configured computer account icon appears in the Computers pane.

When a new computer starts up, you can assign it to this preset account.

 

Click the New Computer icon on the console to create a new computer 
account. You can also click File > New > Computer or right-click in the 
Computers pane and select New Computer.
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To create and associate multiple computer accounts

You can create computer accounts and automatically assign predefined names. These 
computer accounts can be associated with computers in a selected computer group.

1. Select a computer group, including the New Computers group (empty groups 
cannot access features). Right-click and select the Configure command. The 
Computer Configuration Properties dialog appears.

2. Enter names and configuration settings for each new computer account using the 
Computer Configuration screens. See Computer configuration properties on 
page 101.

3. (Optional) Click the Microsoft Networking category and click Define Range.

a. In the Fixed text field, enter a base computer name. Example: Sales.

b. In the Range start field, enter a numeral or letter to add to the Fixed Text 
name. This creates a unique name for a group of computers starting with the 
specified character. The range of numerals and letters is assigned to the 
computer name. Example: Enter 3.

c. Select Append to add the range of numerals after the computer name. Clear 
the check box to add names before the computer name.

 In the above example, the Result field displays computer names beginning 
with Sales3 and ending with Sales12.

4. Click Associate. You can now associate computers in a group (including the New 
Computers group) with the multiple computer accounts.

5. Click OK. 

Importing new computers from a text file
You can import computer configuration data using delimited text files (.TXT, .CSV, or 
.IMP files) to establish multiple computer accounts in the Deployment Server database. 
This file contains all configuration data for a new computer, including all settings in the 
Computer Properties of a selected computer. See Computer properties on page 119.

1. Click File > Import/Export > Import Computers.

A dialog appears, letting you select import files. These files can have .XML, .TXT, 
.CSV, or .IMP extensions. 

2. Select the import file. Click Open.

If a correctly formatted computer import file is selected, a message appears, 
informing you that the computer import is complete and identifying the number of 
computers added. Click OK.

New computers appear as pre-configured computer accounts in the Computers  
pane of the console (as single computers or in groups), and any jobs imported from 
the import file are listed in the Jobs pane.

Note
Jobs can be added to the import file. They can be created and associated with the 
new computers.

If the computer import file is incorrectly formatted, a warning appears, stating that 
the computer import file is incorrect.
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3. Edit computer settings by selecting a computer from the list and clicking 

Properties.

4. The Computer Properties page opens. You can edit or add values not set in the 
import file, such as computer name, TCP/ IP settings, user name, and other 
configuration settings.

5. Click OK.

The imported computers appear in the Computers pane of the Deployment 
Console. 

You can also import a computer to be placed in a sub-folder in the Computers pane and 
create a job to be associated with the imported computer. See the sample import file for 
additional information.

Referencing the sample import file 

When creating an import file, use either the ImportComputers55.txt file or the 
ImportComputers55.xls file in the Samples folder of the Deployment Share. The 
ImportComputers55.txt file provides a sample import template you can access to test 
the Import feature. The ImportComputers55.xls file is a Microsoft Excel spreadsheet 
that lets you add values to each identified column and save the file as a delimited TXT 
file to import to the Deployment Database. The sample import file places a computer 
(DB Computer 1) in a computer group (Test Group) and adds a job (Test Job) associated 
with the imported computer.

Deploying new computers on a mass scale

If you need to deploy large numbers of computers (100 to 5,000), consider using a 
barcode scanning system to collect user information (names, operating system, and 
application needs) and computer information (MAC address, serial numbers, asset tags). 
You can save this information to a file, which can be imported into the New Computers 
List View. Depending on the number of incoming computers, the amount of information 
you have about those computers, and the needs of individual users, you can use either 
the pre-configured computer account method (best for smaller numbers of new 
computers) or the Initial Deployment job (best when deploying generic setups by 
departments or groups).

If you are using an import file, ensure you know the primary lookup key. This 
information is required by Deployment Server to set up a unique computer. The primary 
lookup key can be the Serial Number, Asset Tag, UUID, or MAC address.

 Computer configuration properties 
These computer property settings can be viewed, set, and modified when performing 
the following computer management operations:

Adding new computers on page 98.

Modifying configuration on page 182. Create or edit property settings in a 
deployment job.

Sample jobs on page 196.

Click the configuration group icons to set additional computer property values. After you 
edit these computer property settings, the computer restarts so that the changes can 
take effect.
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General configuration settings

General configuration settings Set the most important value from this property 
sheet. It includes the name of the computer in 
Deployment Solution, the NetBIOS name of the 
computer, the MAC address and other settings.

Microsoft networking 
configuration settings

Set the Windows name of the computer and the 
Workgroup or Domain settings.

TCP/IP configuration settings Set the TCP/IP addresses for one or more 
network adapters.

NetWare client configuration 
settings

Set Novell Directory Services client logon 
options.

Operating system licensing 
configuration settings

Set the registered user name and view the 
hashed installation license key for the installed 
operating system.

User account configuration 
settings

Set the local Windows user account values.

 

The General category provides access to important property settings that 
are also listed in other configuration categories. Click other category icons 
to view and set additional configuration properties.

Field Description

Name Provides a name that appears in the Deployment Console (not the 
BIOS name of the computer).

Note
The Name field is disabled for multiple computer configuration. 

MAC address The unique identification address of the network adapter.

Serial Number The serial number of the computer’s motherboard.

Asset Tag The asset tag of the computer, if available.

Computer 
Name

The Windows name of the computer.

IP Address Current IP address of the computer. Multiple IP addresses are 
listed in this box.

Registered 
User

The name of the user who registered the operating system 
software.

License key The hash value rendered from the OEM key or 25-digit license key 
required when installing the operating system.

User name The user name for the local Windows user account.

Full name The full name for the local Windows user account.
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 Microsoft networking configuration settings

Use Sysprep to generate unique SIDs. This can be done by manually running the utility 
or selecting this feature while installing the Deployment Agent.

Password The password for the local Windows user account.

See also Computer configuration properties on page 101.

 

Enter the computer name and workgroup or domain property settings for 
the managed computer. If you are using Active Directory, you can add 
computers to a domain and a specified organizational unit (OU).

Field Description

Computer 
name

This is the NetBIOS name for the computer. The name must be 
unique in the network and limited to 15 characters.

Note
This field is disabled for multiple computer configuration.

Use Token for 
computer 
name

Select this check box to specify the computer name using tokens. 
Selecting this option enables the Select Token option and 
disables the Define Range option.

Note
This option is applicable for multiple computers and not for single 
computers.

Select Token: You can select one of the following tokens from the 
drop-down list.

%NAME%- Complete computer name.

%NICyMACADDR%- MAC address of the computer with NIC 
specific number. Selecting this option enables the NIC Number 
option. You need to specify the NIC number, which ranges 
from 1-8.

%SERIALNUM%- Serial number from SMBIOS.

%NODENAME%- First 8 characters of actual computer name.

The NIC Number textbox is visible for NIC number input; the 
default value is 1.

Field Description
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TCP/IP configuration settings

Define Range Click to create a sequential range of computer names. The 
Computer Name Range dialog appears. For new computers, set 
a range of names for multiple new computers.

Fixed text. Enter the text portion of the name that you want 
to associate with each computer. Example: MARKETING.

Range start. Enter a whole number to add to the fixed text. 
Example: 1.

Append. Select this check box to add the range after the 
fixed text in the computer name. If you clear this box, the 
number is added as a prefix to the fixed text.

Result. View an example of the selected names that is 
assigned to each computer. Example: 
MARKETING1...MARKETING6.

Note
When setting name ranges, do not set names using multiple 
Modify Configuration tasks and assigning the names by setting 
conditions for task sets. If you set up two separate name ranges 
to be assigned by separate conditions, the computer names 
increment irrespective to the base name. See Modifying 
configuration on page 182, Setting conditions for task sets on 
page 151, and Computer configuration properties on page 101.

Workgroup Select this option and enter the name of the workgroup to place 
the managed computer.

Note
You can select either the Workgroup or the Domain option.

Domain Enter either the fully qualified domain name, the DNS domain 
name, or the WINS domain name. You can enter the fully qualified 
domain name (Example: mjones.yourcompany.com), and specify 
the organizational unit (OU) using this format: OU/newOU/users. 
The complete entry to place the computer in the users OU is the 
following:

 mjones.yourcompany.com/OU/newOU/users

internal.myServer.org/New Corporate Computer OU/
Mail Room/Express Mail Servers

 

Enter TCP/IP settings for one or more network adapters. Click Advanced 
to setup IP Interfaces, Gateways, DNS, WINS, and Static Routes. For 
computer groups, click Associate to assign a range of pre-defined IP 
addresses.

Field Description
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Field Description

Host name The DNS name of a device on a network. The name is used to 
locate a computer on the network.

Network 
adapter

A list of all network adapters installed in the selected computer.

The network adapter with the lowest bus, device, and function 
number is the first listed (NIC0 - zero based). If the bus, device, 
and function information cannot be determined for a network 
adapter, it is enumerated in the order it is detected.

When configuring multiple network adapters, ensure that one 
network adapter is not using an Intel Universal NIC driver 
(commonly called UNDI driver) to connect to Deployment Server. 
If one network adapter uses the native driver and one uses an 
UNDI driver, your computer appears twice in the console.

Add. Enter new settings for additional network adapters 
installed on the client computer. 
You can add “virtual” network adapter settings to send a job 
to a computer group containing computers with varying 
numbers of network adapters. If a computer in the group has 
only one network adapter, it is configured only with the IP 
settings listed first. If IP settings are provided for additional 
network adapters not present in the computer, they are 
disregarded. 
If you add a new network adapter, the Remove button  
appears. You can remove the new network adapter by clicking 
Remove.

See also Computer configuration properties on page 101.

Description MAC Address. The MAC address is a unique number assigned 
to the network adapter by the manufacturer. You cannot 
change this number. The MAC address appears in this box 
when you view computer configuration settings. This box is 
disabled when creating a Modify Configuration task. 

DNS connection suffix. Enter this to add domain suffixes to 
the root address.

Obtain an IP Address automatically.

Use the following IP address.

Obtain DNS server address automatically.

Obtain the following DNS server addresses.

Reboot After Configuration. Restarts the computer after 
configuration.

Adapter state The state of the Network Interface Card (NIC). AClient and 
DAgent do not report limited information for disabled NICs. 
Deployment Solution tracks any disabled NICs when it rebuilds or 
reconfigures a computer. Users have the option of enabling, 
disabling, or keeping the card in its current state. 
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TCP/IP advanced options - IP interfaces
IP Interfaces (Linux and Windows type only). Click Add to set named interfaces for this 
network adapter. You can add TCP/IP addresses to an existing network adapter card on 
Linux or Windows operating systems.

TCP/IP advanced options - gateway
View Gateway addresses. Click Modify to edit an existing IP address. Use the up and 
down arrows to move an address to the top of the list, which acts as the primary 
address. Review all selection by clicking the TCP/IP option on the Configuration page.

TCP/IP advanced options - DNS
Click Add to set a new DNS address.

DNS server addresses, in order of use: Add additional Domain Naming Servers 
(DNS) for this network adapter.

Append these DNS Suffixes (in order): Add the name of the Domain Suffix and use 
the up and down arrows to set the DNS suffix search order.

TCP/IP advanced options - WINS
Click Add to set a new WINS address.

Add additional WINS settings for this network adapter. Select one of the Enable 
NetBIOS over TCP/IP, Disable NetBIOS over TCP/IP, or Use NetBIOS settings 
from DHCP server options for this network adapter. See also Computer configuration 
properties on page 101.

Field Description

IP Address Add or modify an IP address common to all interfaces.

Subnet mask Enter the appropriate subnet mask.

Field Description

Interface 
Name

Establish Linux-specific IP interface settings. Ensure you use the 
“eth” syntax when naming new interfaces. Example: eth0:1 or 
eth0:new interface.

Broadcast 
Address

Enter the Broadcast address for the specified IP interface.

Interface 
State

The default value of the interface state is Up, which denotes that 
the named interface is operating. You can shut down the named 
interface by selecting Down.

See also Computer configuration properties on page 101.

Field Description

Gateway Add additional gateways for this network adapter.
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TCP/IP advanced options - static routes 

NetWare client configuration settings

Field Description

Destination IP address of the destination Deployment Server.

Netmask Subnet mask.

Gateway Additional gateways required to reach the destination server.

Interface IP address for the interface over which the destination can be 
reached.

Metric Cost associated with the route

Flags (Linux) Enter the flag associated with a Linux-specific operating system. 
Possible flags include:

U (route is up)

H (target is a host)

G (use gateway)

R (reinstate route for dynamic routing)

D (dynamically installed by daemon or redirect)

M (modified from routing daemon or redirect)

A (installed by addrconf)

C (cache entry)

! (reject route)

 

Set Novell NetWare client values for a new or existing computer. Select 
whether you want to log in directly to a NetWare server or to a NetWare 
tree in the Novell Directory Service (NDS). You can specify the preferred 
tree, server name, and NDS context.

Field Description

Ignore 
NetWare 
settings

Select to disregard all Novell NetWare client settings for this 
computer. Clear to specify the required information.

Preferred 
server

Select this option and enter the name of the NetWare server. 
Example: \\OneServer. This is the primary login server for the 
NetWare client.

Preferred tree Select this option and enter the name of the NDS tree.

NDS User 
name

Enter the name of the user object for the NetWare client.

NDS Context Enter the organizational unit context for the user.
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Operating system licensing configuration settings

User account configuration settings

Run login 
scripts

Select this option to run the NetWare client login scripts.

See also Computer configuration properties on page 101.

Enter or view the license information for your Windows operating system 
software.

Field Description

Registered 
user

Enter the name of the registered user.

Organization Enter the name of the organization.

License key Enter the alpha-numeric license key. This is the hash value 
rendered from the OEM key or 25-digit license key required when 
installing the operating system.

See also Computer configuration properties on page 101.

 

Set up local user accounts for the newly imaged computer or when running 
a configuration task. Enter a user name, full name, and password; and set 
standard Windows login options.

Field Description

User name The user name for this local Windows user account.

Full name The full name for this local Windows user account.

Password The password for this local Windows user account.

Confirm 
password

Confirm the password for the local Windows user account.

Groups Specify the Windows groups that this user belongs to as a 
comma-delimited list. Example: Administrators, Marketing, 
Management.

Field Description
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 Deployment agents 
To remotely manage computers from a Deployment Console, a Deployment Agent is 
installed on each computer in the Deployment Server system. Deployment Agents are 
provided for various computer types, including Windows, Linux, and DOS computers. 

The following Deployment Agents reside on the client computer and communicate with 
the Deployment Server.

User must 
change 
password at 
next logon

Select to force the user to change the password after setting the 
configuration properties.

User cannot 
change 
password

Prohibit the user from changing the password at any time.

Password 
never expires

Select to maintain the user password.

See also Computer configuration properties on page 101.

 

To set or modify Deployment Agent settings from the Deployment Server 
Console, right-click a computer or group, select Change Agent Settings 
and click Production or Automation.

To set or modify agent settings for new computers, click Tools > Options, 
click Agent Settings.

Deployment Agent on 
Windows

The Deployment Agent runs on Windows computers, 
including desktops, notebooks, and servers.

See Deployment agent settings on page 110.

Deployment Agent on Linux This Deployment Agent runs on Linux workstations 
and servers.

See Deployment agent settings on page 110.

Automation Agent The Automation Agent is used when you create 
configurations to boot client computer to automation. 
This is done through Boot Disk Creator.

See Boot Disk Creator Help and Install automation 
partition on page 133.

Deployment Agent on 
ThinClient CE 6.0

This agent runs on ThinClient Windows CE 6.0 
operating systems and lets the Deployment Console 
manage WinCE 6.0 based Thin Clients.

Deployment Agent on CE 
.NET

This agent runs on the CE .NET 4.2 operating 
system.

Field Description
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Install Deployment Agent to add a managed computer

When a Deployment Agent is installed on a computer, it searches the network for a 
Deployment Server to attach to. When the Deployment Agent locates a Deployment 
Server, the client computer is added as a record to the Deployment Database.

Automatically update to newer version of Deployment Agent

At times, Altiris may update versions of the Deployment Agent to enhance features. For 
best performance, we recommend that all managed computers run the latest version of 
the Deployment Agent. When a new version of the Deployment Agent is saved to the 
Deployment Share file server, the managed computers automatically update the 
Deployment Agent.

1. From the computer where Deployment Server is installed, click Start > All 
Programs > Altiris > Deployment Solution > Configuration. The Altiris 
Deployment Server Configuration Utility page appears.

2. Click Options.

3. Click Transport.

4. Select the Automatically update clients option and click OK.

Deployment agent settings 
You can set the default agent settings when new client computers are added to the 
system that the Deployment Server manages.

Notification Server Client The NS client is an Altiris agent that runs on 
computers supported by the Notification Server. This 
agent runs on the Deployment Server computer 
when running Deployment Solution on the 
Notification Server.

Deployment Server Agent This agent runs on the Deployment Server computer 
when running Deployment Solution on the 
Notification Server.

 

When the Deployment Agent for Windows is running on a computer, the user 
sees a small icon in the system tray. When the icon is blue, the client 
computer running the Deployment Agent is connected to the Deployment 
Solution system. 

 

When the Deployment Agent for Windows icon is clear, it shows that the client 
computer is not connected to the Deployment Solution system. The agent 
may be configured incorrectly, the Deployment Server is down, or other 
network problems exist.
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You can also modify the properties settings for the Production or Automation Agent 
through the Automation Agent.

When the client agent is first started, the agent establishes a connection to the 
Deployment Server using the following general steps:

1. The agent service is started and initialized.

2. A TCP socket is created.

3. A connection is made to the Deployment Server.

4. The agent is updated, if required.

5. A basic inventory of the client is sent to the Deployment Server.

After the initial connection process is complete, no additional data needs to be sent to or 
from the Deployment Server for the client agent to remain connected.

Note
If no Deployment Solution traffic is sent to the Deployment System agent, the TCP/IP 
protocols send an occasional watchdog packet (approximately every 24 hours) to ensure 
that the connection is still valid.

Deployment agent properties

Right-clicking the Deployment Agent icon gives you access to the following options:

View status. Brings up the Altiris Client Service box to observe the current status 
of the Deployment Agent. You can also see the computer name, deployment server 
connected to, IP address, multicast address, and MAC address. You can also watch 
Deployment Agent communicate with the Deployment Server. Clicking Properties 
lets you edit the Deployment Agent properties. Passwords protect this option.

About. Displays the version and licensing statement for the Deployment Agent. 
Passwords do not affect this option.

 

To set or modify agent settings in the Deployment Server Console for 
Windows or Linux clients, right-click the computer and select Change 
Agent Settings > Production Agent Settings.

To set or modify agent settings for the Deployment Agent, click Tools 
> Options.

Click the Agent Settings tab.

Select the Force new agents to take these default settings check 
box to set the Deployment Agent settings for all new computers.

Click the Change Default Settings tab. Click each agent setting tab 
to set the properties. See Server connection on page 112, Access on 
page 113, Security on page 114, Log file on page 114, Proxy on 
page 115, and Startup and shutdown on page 115.

Click OK.

 

To view or modify settings from the Windows client, right-click the 
Deployment Agent icon in the system tray (or double-click the client icon in 
the system tray and click Properties).
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View log file. View the Deployment Agent log file, if you have chosen the option to 
create a log file. Passwords have no effect on this option.

Clear log file. Clear the log file that has been created.

Shutdown for imaging. Make an image of a computer without using a job. This 
makes the required preparatory changes to the computer before an image is made. 
Failure to do this breaks the reconfiguration phase when deploying the image using 
a job. Passwords protect this option.

Change Name in Console. Change how this computer is listed in the deployment 
server console. This option does not change the NetBios name of the computer or 
the name of the computer in the database, but only changes the name of the 
computer displayed in the Computers window. Passwords protect this option.

Remove. Uninstall Deployment Agent from the computer. Passwords protect this 
option.

Exit. Stops all Deployment Agent services from running but does not uninstall 
Deployment Agent. Deployment Agent loads normally the next time you boot the 
computer. Passwords protect this option.

User Properties. Quickly go to the User Properties page to view or make changes. 
Passwords protect this option.

Admin Properties. Quickly go to the Admin Properties page to view or make 
changes. Passwords protect this option.

Show Network Interfaces. View what network cards are in your computer. 
Passwords protect this option.

The following configuration properties (organized using tabs in the dialog) are included 
in the Production Agent Settings dialog. 

Server connection
Connect directly to this Deployment Sever. Select this option so that the client 
receiving the Deployment Agent connects to the Deployment Server you selected to 
configure. 

Address/Hostname. Enter the IP address or NetBIOS name of the Deployment Server 
computer. 

Port. Enter the port number communicating with the Deployment Server.

Enable key-based authentication to Deployment Server.  Select this option to 
specify mandatory authentication for client computers to connect to the Deployment 
Server. This helps keep rogue computers from connecting to unauthorized Deployment 
Servers.

Discover Deployment Server using TCP/IP multicast. Managed computers can use 
the multicast address if they are on the same segment as the Deployment Server or if 
multicast is enabled on the network routers. Ensure that the multicast address and port 
match those set up on the Deployment Server. Try using defaults on both the client and 
Deployment Server if you have problems while connecting.

Server connection Log file

Access Proxy

Security Startup and shutdown
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Managed computers should use the Deployment Server IP address if multicasting is 
disabled on the network routers or if they are not on the same network segment as the 
Deployment Server. The port number must match the number set on the Deployment 
Server. Otherwise, the client computers cannot connect.

Server Name. Enter the NetBIOS name of the computer running the Deployment 
Server.

Port. Enter the port number distributing the multicast address.

Multicast Address. Enter the group multicast address.

TTL. Specifies the number of routers the multicast request can pass through. Change 
this setting if you want to locate a Deployment Server that is more than 32 routers away 
(default setting) or to restrict the search to a smaller number of routers, making it 
easier to find the closest Deployment Server.

Refresh connection after idle. Select the Refresh Connection after idle check box 
and set the refresh time in hours or days. The Deployment Server closes the connection 
after the specified time and immediately tries to re-open the connection. This  sends a 
message to client computers that the network is down.

The default checking is of 28800 seconds or 8 hours. We recommend keeping this 
setting above 28800. Do not set this option too low—reconnecting to the Deployment 
Server increases bandwidth when connecting. If this option is set too low, your client 
computers will take longer to connect than to refresh their connections.

Abort files transfers if rate is slower than. Select this option to preserve bandwidth 
when running deployment tasks on slower connections.

Access
Set these commands to control the way the client handles requests from the server.

Allow this computer to be remote controlled. Select to let the administrator 
remotely control the selected computer. The default setting is to NOT let the computer 
be remotely controlled.

Prompt the user before performing actions. You can select the following options to 
prompt the user before the corresponding action is performed:

Shut down and Restart. Prompts the user before shutting down and restarting the 
computer. This feature overrides the Power Control option from the Deployment 
Server to force applications to shut down without a message.

Copy file and Run command. Prompts the user before running a program or 
executing file copy commands.

Remote Control. Prompts the user before running the Remote Control commands.

Time to wait for user response. If one of the Prompt the user before perform 
actions is selected and the user is not at the computer to respond, you need to decide 
whether to continue or abort the operation. Specify the time to wait for the user’s 
response, and select one of the following:

Continue the operation. Select to continue if there is no response from the 
user.

Abort the operation. Click to not continue if there is no response from the 
user.
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Select when the Deployment Server is denied access to the Deployment Agent. 
Select the days and set the start and end times when access to the Deployment Agent is 
denied.

Security
This page lets you secure data between the Deployment Server and the Deployment 
Agent, or to set a password so that the user on the client computer can only view and 
modify the User Properties of the Altiris Client Settings on the managed computer.

Encrypt session communication with Deployment Server. Select to allow 
encryption from this managed client computer to the Deployment Server. This lets 
encrypted data transmissions between the Deployment Server and the Deployment 
Agent on the client computer. If selected, the client computer can connect (but is not 
required to connect) using encryption.

To enable encryption protocols, you must open the Altiris Deployment Server 
Configuration Utility, click Options and select the Transport tab. Select the Allow 
encrypted sessions check box to let Deployment Server transmit using encryption 
protocols.

Require encrypted session with any server. Select to require encryption between 
the managed client computer and the Deployment Server. If this option is selected and 
the option to allow encryption in the Deployment Configuration tool is not selected, the 
Deployment Server does not communicate with the Altiris Client on the managed client 
computer.

Note
Selecting encryption options slows down the communication path between the agent 
and the Deployment Server.

Password protect Admin properties from user. Select to let users on the managed 
computer access the Admin properties only if they enter the set password. If the check 
box is selected and the user does not know the password, they will have rights only to 
view the User Properties, which includes only the User Prompts and Remote Control 
tabs on the Altiris Client Settings dialog. 

Enter the password in the Password field and re-enter the password for 
confirmation in the Confirm password field.

Hide client tray icon. Select to hide the Altiris Client icon in the system tray of the 
managed computer. If you hide the icon, you must run AClient.exe with the -admin 
switch to view and modify the complete administrative properties from the managed 
client computer.

Log file
The Log File page controls how data is logged and saved in a Deployment Server 
system, letting you save different types and levels of information to the log files. You 
can save a text file with log errors, informational errors, and debug data using this 
dialog.

If the log exceeds the specified size, the older data is dropped from the files. You can 
maximize the size of the log file to save all selected data.

Save log information to a text file. Select this option to save information to a log file. 
By default, this option is cleared. Selecting this option enables the File name and 
Maximum size fields.
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File name. Enter the name and path of the log file. The default path is \Program 
Files\Altiris\AClient\AClient.log file.

Maximum size. Enter the maximum number of bytes for each log file.

Log errors. Select this option to save only the errors returned when running a job or 
operation between the Deployment Server and the Deployment Agent.

Log informational messages. Select this option to save a list of procedural steps run 
on the client computer.

Log debugging information. Select this option to list comprehensive debugging 
information in the text file.

Note
If the log exceeds the specified size, the older data is dropped from the files, so it is 
recommended to provide maximum file size.

Proxy
Typically, remote networks on the other side of a router or switch cannot receive 
multicast or Wake-On-LAN packets from the Deployment Server. Setting the managed 
computer as a proxy client computer forwards or re-creates the multicast packets. A 
managed client computer setup as a multicast proxy simply acts as a Deployment 
Server and advertises the server’s name and IP address through multicasting. You can 
also set the managed computer as a proxy to send Wake-On-LAN packets.

Set these options to control how the managed computer acts as a proxy agent, 
identifying the type of traffic this managed computer forwards from the server.

Forward Wake-On-LAN packets. Select if you want the managed computer to 
forward Wake-on-LAN packets.

Forward Deployment Server discovery multicast packets. Select if you want to 
advertise the Deployment Server to client computers on another LAN segment or if the 
client computer is on the other side of the router.

Send multicast advertisement every. Set the time in seconds, minutes, or hours for 
managed computers to send a multicast advertisement.

Startup and shutdown 
Delay starting jobs after system startup. Set the time in seconds, minutes, or hours 
for managed computers to delay jobs until after system startup.

Specify the Windows boot drive. Specify the drive that the client computer boots 
from. The default is the C drive.

Force all programs to close when shutting down. Select this option to shut down 
applications when using Power Control features. The user is still prompted to Abort or 
Continue the shutdown.

Synchronize date/time with Deployment Server. Select this option to synchronize 
the system clock of managed computers with the time of the Deployment Server.

Prompt for a boot disk when performing automation jobs. Select this option to 
prompt for a boot disk while running any automation jobs.

Advanced
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Disabled direct disk access for Deployment Agent for DOS (BootWorks) 
communication. Select this option to disable the direct disk access for Automation 
communication.

Deployment Agent for Linux
The Deployment Agent for Linux is an agent software that runs on managed Linux 
computers. The agent collects and sends data from the managed computer to the 
Deployment Server system, executes deployment tasks sent from the server, installs 
packages, and runs management processes as directed from a Deployment Console. 
See Installing Deployment Agent on Linux on page 357 for additional information.

A Linux managed computer is identified in the Deployment Console by unique Linux 
icons reflecting deployment and process status, letting you deploy and manage 
computers similar to the Deployment Agent for Windows, with the following exceptions:

Deployment Agent settings for DOS
You can configure property settings for the Automation Agent for specified computers or 
computer groups. You can remotely maintain important agent settings and update 
settings as required from the console.

When a new client computer connects, it receives the default agent settings from 
Deployment Server for drive mappings, authentication, and LMHost entries. Each client 
computer still has the capability to maintain its unique settings for the Deployment 
Agent for DOS as set in the Boot Disk Creator.

Automation Agent Settings include the following property settings:

Deployment Task Deployment Agent for 
Windows

Deployment Agent for 
Linux

Create Disk Image Yes Yes

Distribute Disk Image Yes Yes

Scripted OS Install Yes Yes

Distribute Software Yes Yes

Capture Personality Yes No

Distribute Personality Yes No

Change Configuration Yes Yes

Run Script Yes Yes

Copy File Yes Yes

Shutdown/Restart Yes Yes

 

To set or modify agent settings for a specific computer, right-click the 
computer icon and select Change Agent Settings > Automation Agent 
in the Deployment Console.

To set or modify agent settings for ALL computers, click Tools > Options, 
click Agent Settings > Change Default Settings.
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Drive mappings

Authentication

Network

Drive mappings
Set drive mappings used by the Deployment Agent for DOS to access hard disk image 
files and other packages from a specified network drive. You must map the F Drive to 
the Deployment Share. You can also map other file server directories when storing large 
numbers of image files or deployment packages.

Click Add to open the Add Drive Mapping page. Select the following options:

OS. Select the operating system from the drop-down list.

Drive Mapping. Enter the drive letter and volume of a shared folder. Example:  
F: \\WebDeploy\Image files.

Note
You must select a shared folder in this field. You can browse and select any type of 
folder, but the Deployment Agent for DOS maps to and accesses files only from a shared 
folder.

Path. Enter a UNC path.

You can also edit or remove a drive mapping from the list. See also Deployment agents 
on page 109.

Authentication
Provide the login credentials that the Deployment Agent for DOS needs to map network 
drives. The associated credentials for each network drive must have the rights that the 
Automation agents need to access files.

Domain/Workgroup. To map the network drives, enter the name of the user’s Domain 
or Workgroup that the Deployment Agent for DOS uses to log on.

Username. To map the network drives, enter the user name that the Deployment Agent 
for DOS logs on as.

Password. Enter the password.

Confirm Password. Retype the password for confirmation.

See also Deployment agents on page 109.

Network
These settings let you match the IP address with the computer name, as maintained in 
the LMHosts file in the Deployment Agent for DOS partition.

1. Click Add. The Add LMHosts Entry dialog appears.

2. Enter the Computer Name. Enter the name of a computer to associate with an IP 
address.

3. Enter the IP Address.

or
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Click Lookup IP. This automatically populates the field with the IP address of the 
entered computer name.

4. Click OK. 

See also Deployment agents on page 109.

Managing client connections 
The following utilities are provided for managing transmissions between the Deployment 
Server and the Deployment Agents running on the managed client computers.

Reset a client connection

Resetting the connection that a managed computer has with the Server simply 
disconnects and reconnects the computer. This is useful for troubleshooting or if you 
suspect a bad connection.

To reset a client connection, right-click a computer and click Advanced > Reset 
Connection. When the computer disconnects, its icon turns gray. The computer should 
reconnect and its icon color returns to its original active status color.

Reject or retrieve a rejected computer

If a computer you do not want to manage connects to your Deployment Server, you can 
reject it. This removes the unwanted computer from the Computers pane in the 
console. Further attempts by the computer to connect are denied. Although the 
computer is not deleted, any history or schedule information associated with the 
computer is deleted.

1. Right-click the computer you want to reject from connecting to the Deployment 
Server.

2. Click Advanced > Reject Connection.

3. Click OK.

Rejected computers are stored in a Rejected Computers list. Select View > Rejected 
Computers to view this list.

Accept a previously rejected computer

If you now want to accept a previously rejected computer, you can retrieve it and 
reconnect it to the Deployment Server. 

1. Click View > Rejected Computers.

2. From the list, select the computer you want to retrieve.

3. Click Accept Computer(s) to remove the computer from the rejected list (this 
doesn’t delete the computer, just removes it from the list of rejected computers).

4. Click Yes to confirm the action, click Close.

This client computer can now be managed from within the Computers pane. 
Connection requests from this client computer are now allowed.

See also Deployment agents on page 109.
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Computer properties 

View and edit the computer properties for each managed computer.

General 

See also Computer configuration properties on page 101.

Hardware 

See also Computer configuration properties on page 101.

Drives 

 

View and edit computer properties by double-clicking a computer icon in 
the Computers pane, or right-clicking and selecting Properties, or 
clicking the icon in the toolbar. 

General Services

Hardware Devices

Drives Location

Network configuration

TCP/IP

Applications

 

View or change the name of the computer as it appears in the console. You 
can view the following: logged-on user names, operating system installed, 
name of the Deployment Server, whether an automation partition is 
installed, version of the Altiris Windows Client, and other client information.

 

View processor make and type, processor count, RAM installed on the 
computer, display configuration, manufacturer, model, product name, MAC 
address of each network adapter installed, serial number, asset tag, UUID, 
and whether Wake On LAN and PXE are installed and configured.

 

View information about each drive on the computer. If you have multiple 
drives, you can select a drive from the list to view its settings, such as the 
capacity, serial number, file system, volume label, and number of drives 
installed.
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See also Computer configuration properties on page 101.

Network configuration 

See also Computer configuration properties on page 101.

TCP/IP 

See also Computer configuration properties on page 101.

Applications 

See also Computer configuration properties on page 101.

Services 

See also Computer configuration properties on page 101.

Devices 

 

View Microsoft Networking, Novell Netware settings, and user information 
for the selected managed client computer.

 

View TCP/IP information, including a list of all installed network adapter 
cards (up to eight) for the selected computer. Click Change to open the 
Configuration page to modify settings (see Configuring computers on 
page 125).

 

View the applications that are installed on the computer, including their 
description, publisher, version number, product ID, and system 
components.

 

View the services installed on the computer along with the description, 
start type, and path for each service.

 

View the devices installed on the computer, including display adapters, disk 
drives, ports, storage volumes, keyboards, and other system devices.
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See also Computer configuration properties on page 101.

Location 

See also Computer configuration properties on page 101.

Bay 

Server deployment rules
From the Bay property page, you can select rules to govern actions taken when a new 
blade server is detected in a selected bay. These rules are described below:

 

View and edit user-specific properties such as contact name, phone 
number, e-mail address, department, mail stop, and site name. As the 
administrator, you can enter this information manually or you can let the 
user populate this screen using the Prompt User for Properties option. 
See Prompt user for properties on page 132.

  

View location information and other properties for Rack / 
Enclosure / Bay components for high-density and blade servers. 
Set rules for automatic re-deployment of blade servers based on 
physical location changes. This property is available only to 
systems using blade servers.

Rule Action

Re-Deploy 
Computer

Restore a blade server using deployment tasks and configuration 
settings saved from the previous server blade in the bay. This lets 
you replace new blades in the bay and automatically run 
deployment tasks from its deployment history. (See Restoring a 
computer from its deployment history on page 124.)

All deployment tasks in the bay's history are run starting from the 
last Distributing a Disk Image task or Scripted OS Install task, or 
from any script (in a Run Script task) with this command: rem 
deployment start. See Distributing a disk image on page 162, 
Scripted OS install on page 168, and Running a script on 
page 184.

Run 
Predefined Job

The server processes any specified job. Select a job to run 
automatically when a new server is detected in the bay.   

Ignore the 
Change

This option lets you move blades to different bays without 
automatically running jobs. The server blade placed in the bay is 
not identified as a new server and no jobs are initiated. If the 
server existed in a previous bay, the history and parameters for 
the server are moved or associated with the new bay. If the server 
blade is a new server (never before identified), the established 
process for managing new computers is executed.
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See also Computer configuration properties on page 101.

Lights-Out 

Note
This feature is currently only available for selected HP Integrated Lights Out (ILO) and 
Remote Insight Lights-Out Edition (RILOE) features.

See also Computer configuration properties on page 101.

Remote operations using Deployment Solution 
The Operations menu in the Deployment Console provides a variety of commands to 
remotely manage all computers in your site or network segment. Some operation 
commands, such as Restore, automatically create and schedule deployment jobs and 
place them in the System Jobs folder in the Jobs pane. Other commands, like Chat or 
Remote Control, open utility programs to access and remotely manage computers.

Wait for User 
Interaction

(Default) No job or tasks are performed (the Deployment Agent on 
the server blade is instructed to wait). The icon on the console 
changes to reflect that the server is waiting.

 

View information about the remote management hardware installed on the 
selected computer (most often a server) used to power up, power down 
and restart the computer remotely, or to check server status. You can also 
enter the password for the remote management hardware by clicking 
Password.

 

Open the computer operations menu by right-clicking a computer icon in 
the Computers pane, clicking Operations on the menu bar, or clicking 
the icons in the toolbar.

Restore      Reconfigure your computer to a former state. Select from a list 
of previous deployment tasks and select to restore only the ones 
you want. See Restoring a computer from its deployment history 
on page 124.

History      View, print, delete, and save to file a history of deployment 
tasks. See Viewing a computer’s history on page 125.

Rule Action
Altiris Deployment Solution™ from Symantec User’s Guide 122



 

Configure Set network and local configuration properties for each 

computer, including computer name, IP address, domains, 
Active Directory context. See Configuring computers on 
page 125.

Quick Disk 
Image

Select a computer and image its hard disk. This creates and 
stores the image to distribute now or later. See Quick disk image 
on page 125. 

Power Control Wake up, restart, shut down, and log off remotely. See Power 
control on page 126.

Remote Control Open a remote control window directly to a selected client 
computer. Investigate problems directly from your console. See 
Remote control on page 127.

Execute Type and run commands remotely. See Execute on page 131.

Copy File to Copy selected files, directories, or entire directory structures 
and send them to the selected computer(s). See Copying a file 
on page 188.

Chat Start an individual chat session with one or more selected client 
computers. Communicate actions or query for symptoms during 
administration. See Chat on page 132.

ADVANCED >

Clear Computer 
Status

Clear computer status as shown in the title bar of the List View.

Prompt User for 
Properties

Query the user for personal information. This feature sends a 
form to the user to fill out. See Prompt user for properties on 
page 132.

Reset 
Connection

Disconnect and reset the connection between Deployment 
Server and the Deployment Agent on the selected computer.

Install 
Automation 
Partition

Embed automation partitions onto the selected computer’s hard 
disk to enable a managed computer to run automation tasks.

Get Inventory Update property settings for a selected computer. These 
inventory settings can be viewed in Computer properties on 
page 119. Select it to ensure that you have the latest inventory 
of the computer. 

Set the timeout value in the General tab of the Deployment 
Server Configuration utility (in the Control Panel). 

Reject 
Connection

Refuse communication with the selected computer.

Install BIS 
Certificate

Install a BIS certificate for the selected computer.

Remove BIS 
Certificate

Remove a BIS certificate from the selected computer.

Uninstall agent Uninstall the agent from the selected computer.

Apply Regular 
License

Apply a permanent license if a client computer is using a time-
limited license or requires an updated license. 
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Restoring a computer from its deployment history 
Occasionally, it is necessary to restore a computer to its original settings based on 
operations or deployment jobs previously executed on the computer. A computer’s past 
deployment history appears in the Restore Computer dialog, where you can restore a 
computer by selecting the tasks from its history file. You can rerun the deployment tasks 
to restore the computer.

1. Right-click a computer and click Restore.

The Restore Computer dialog appears with a list of previous tasks with check 
boxes.

2. (Optional) Select the type of tasks to be displayed from the Show only drop-down 
list. Select the date from the Since list box to filter tasks.

3. Click Next to view a summary of tasks selected to reschedule.

4. Click Next to schedule the job. See Scheduling jobs on page 153.

5. Click Finish. 

When you finish this computer operation, a new job appears in the Jobs pane of the 
Deployment Console under the System Jobs > Restoration Jobs folder. The job name 
has a generic format of Restore: <computer name>.

New Job Wizard Open this to build, assign, and schedule deployment jobs for the 
selected computer. See New job wizard on page 146.

New Group Click to create a new computer group in the Computers pane.

New Computer Create a new computer account. See Adding new computers on 
page 98.

Rename Assign the computer or group a new name in the console. Right-
click a computer or group to edit in the Computer pane.

Delete Delete a computer, a computer group, or any combination of 
computers and groups from the database.

Change Agent 
Settings

Update property settings for the Deployment Agent running on 
selected computer(s). See Deployment agents on page 109.

Permissions View security settings for the selected computer(s).

Job Scheduling 
Wizard

Open this to assign deployment jobs to the selected computer.

Properties View computer configuration and network properties. See 
Computer properties on page 119.

 

Restore a computer by right-clicking a computer icon in the Computers 
pane and selecting Restore, clicking Operations > Restore Computer 
on the menu bar, or clicking this icon in the toolbar. You can restore a 
computer using Remote Operations Using Deployment Solution or by 
creating and scheduling a job using the New Job Wizard. See Remote 
operations using Deployment Solution on page 122 and New job wizard on 
page 146.
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Viewing a computer’s history

You can view the history of deployment tasks for a specific computer. Users who do not 
have administrative privileges or the permissions to delete a computer’s history cannot 
access this option.

1. Right-click a computer and click History.

The History of <Computer Name> dialog appears with a list of previous tasks, 
including when the task was scheduled, its deployment status and other deployment 
information.

2. (Optional) Click Save As to save the file as a .TXT or .LOG file.

3. (Optional) Click Print to print the History file.

4. Click Delete to delete the History file. Click Yes to the confirmation message.

5. Click Close. 

See also Remote operations using Deployment Solution on page 122.

Configuring computers
From the Operations menu, you can enter and modify configuration settings for 
computers. See Computer configuration properties on page 101 for complete 
information about configuration settings.

1. Right-click a computer and click Configure.

The Computer Configuration Properties dialog appears.

2. Set basic configuration values in the General configuration group (default view).

3. Click other configuration group icons in the left pane to set additional values.

4. Click OK.

See also Remote operations using Deployment Solution on page 122.

Quick disk image
This computer operation creates a disk image of the selected computer. This option is a 
quick and easy way to create a disk image of a selected managed computer from the 
Deployment Console.

To run a disk image job you must have an automation partition installed on the client 
computer, or it is PXE-enabled and can boot to automation by connecting to a PXE 
Server.

1. Right-click a computer and click Quick Disk Image.

The Schedule Computers for Job dialog appears. See Scheduling jobs on 
page 153.

2. Schedule the job to run immediately or at a later time. You can also click the option 
to not schedule the job (this option places the job in the working area and does not 
run until you manually drag it to a selected computer and reschedule it).

3. Click OK.

A new job appears in the Jobs pane of the Deployment Console under the System 
Jobs > Image Jobs folder. The job name has a generic format of Create Image: 
<computer name>. 
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See also Remote operations using Deployment Solution on page 122.

Power control
This computer operation lets you wake up a computer, restart a computer, shut down, or 
log off as the current user for a selected managed computer. You can also power a 
computer on if Wake-On-Lan is supported.

1. Right-click a computer and select Power Control.

A secondary menu appears with the following options:

2. Select a Power Control option. A Confirm Operation dialog appears. Select the 
Force application to close without a message option to shut down users 
without a warning. If you do not select this option, the user is prompted to save 
work before the power operation continues.

3. Click Yes.

 

Restore a computer by right-clicking a computer icon in the Computers 
pane and selecting Power Control, clicking Operations > Power 
Control on the menu bar, or clicking the icon on the toolbar. 

Wake-up       The Wake-Up feature is hardware-dependent and is available only 
for inactive computers. Select this command to start a computer 
that has been turned off.

Notes
Your operating system and network adapter must be capable of 
recognizing and processing the Wake-on-LAN packets. Non-
embedded network adapters must be properly configured. 
Example: 3Com NICs have an extra header cable that enables 
Wake-on-LAN. Check the documentation that comes with your 
network adapter for more information about Wake-on-LAN. 

For NICs and operating systems that support Wake-on-LAN Power 
Management features, go to the Properties dialog of the network 
adapter driver and select the Power Management tab. Click the 
Allow this device to bring the computer out of standby option 
for this device to bring the computer out of standby status. 

You must enable this feature for some computers in their BIOS.

Restart Click to reboot the selected managed computer. Select Force 
Applications to close without a message box to restart 
immediately without prompting the user.

Shut down Click to shut down the selected managed computer. Select Force 
Applications to close without a message box to shut down 
immediately without prompting the user.

Log off Click to log off the selected managed computer. Select Force 
Applications to close without a message box to log off 
immediately.
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See also Remote operations using Deployment Solution on page 122.

Remote control 
Multiple methods are provided to remote control managed computers. The integrated 
DS remote control utility can be used on Windows computers.

Additionally, you can access the built-in Remote Desktop feature built into many 
Windows operating systems directly from the Deployment Console. You can also 
manually add access to other remote control utilities by modifying a configuration file.

DS remote control (page 127)

Remote desktop connection (page 130)

Additional remote control programs (page 131)

DS remote control
Remote Control is a computer management feature built into the Deployment Server 
Console. It lets you control all types of computers to view problems or make immediate 
changes as if you were sitting at the managed computer’s screen and using its keyboard 
and mouse.

Note
You cannot disable the flashing eye icon while the computer is being remotely controlled.

Before you can remotely control a managed computer:

The managed computer must have the Altiris Agent for Windows installed and 
properly set up.

The client must have the appropriate Proxy option selected in Altiris Client 
Properties. See Proxy on page 115.

The client and Deployment Server Console must be able to communicate to each 
other through TCP/IP.

To remotely control a managed computer

1. Right-click a computer and click Remote Control > DS Remote Control. 

This opens the Remote Control window displaying the managed computer’s 
screen.

 

 

When a managed computer is being remotely controlled, the Deployment 
Agent icon in the managed computer’s system tray flashes these two icons 
alternately.

Remote Control also provides Chat, Refresh, , Send File, and 
Ctrl+Alt+Delete features to assist in managing computers from the 
console. See Chat on page 132 and Copying a file on page 188.
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Note
If you cannot perform a remote-control operation from the selected managed 
computer, you can change this client setting by using the Remote Control options 
in the Change Agent Settings command. The default setting is to not allow 
remote control of the managed computer. See Proxy on page 115.

2. From the Remote Control window, you can execute the following commands:

3. To end a Remote Control session, click Control > Close Window in the Remote 
Control window.

Send files during remote control 
Click to send files to the managed computer that is remotely controlled. Enter the name 
of the source file to be copied and the destination path on the managed computer. Select 
the required compression and encryption options.

Toolbar

Chat Click to open a chat session with the selected managed computer. 
This starts a chat session between the console computer and the 
managed computer. The chat session opens a chat window that lets 
you send messages back and forth between the Deployment 
Console and the managed computer. If you start a chat session 
while controlling multiple computers in a single window, the chat 
session is only between the Deployment Console and the master 
client.

Refresh   Click to update the screen view of the managed computer.

Ctrl+Alt+Delet
e

Click to select Restart or Logon options for the managed 
computer.

Note
The managed computer must be running Windows and have the 
keyboard and mouse driver installed for this feature to be 
available.

Send File See Send files during remote control on page 129.

Toggle Control Click to toggle between the view of control access of the managed 
computer (default) and of access only of the managed computer.

Control menu

Disable Input 
from the Client

Click to prohibit the user of the managed computer from using the 
keyboard or mouse during the remote-control session.

Close Window Click to close the remote control window of the managed computer.

View menu

Refresh Click to refresh the view of the screen.

Fit to Window If this option is selected, the client display image becomes the 
same size as the Remote Control window. If this option is not 
selected, the image retains the size of the client display.

Color Depth See Remote control properties on page 129.

Properties See Remote control properties on page 129.
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If you are controlling multiple clients within a single window, this dialog sends a file only 
to the master client.

Source filename. Enter the name of the file to be sent.

Destination path. Enter the path where you want the file to reside on the managed 
computer.

Compress Data. Select to compress the file during the copy process to decrease 
network traffic.

Encrypt Data. Select to encrypt data package for security.

You can also drag entire folders from the Deployment Console computer to the remote 
control window, which copies the files to the remote client computer.

Remote control properties
Color Depth. Click to specify the color depth (number of colors) used by the Remote 
Control window. This setting applies only to the Remote Control window at the console, 
not to the display of the managed computer. There is no benefit  of setting a color depth 
on the Remote Control window greater than that of the managed computer. The benefit 
of lower color depths is improvement in speed.

Use specific image resolution. Click to specify the width and height of the image that 
represents the client display.

Update Interval. Select to specify how often the image in the Remote Control window 
is updated (in milliseconds). The more frequently the display is updated, the more 
bandwidth is required.

Only update foreground window. Select to refresh only the selected window in the 
remote control session.

Set remote control permissions
Deployment Solution provides multiple features for ensuring privacy and security when 
a managed computer is remotely controlled. Before a managed computer can be 
remotely controlled, the Remote Control preferences on the Deployment Agent for 
Windows must be set to allow remote control access.

You can also lock the keyboard and mouse of the managed computer or set a prompt for 
the user, asking for permission to initiate a remote session. This lets the user accept or 
reject the request. In certain environments, such as a lab or classroom, using a prompt 
to ask for permission might not be preferred.

To remotely set security options on each managed computer, use Change agent settings 
from the console or open Properties on the Deployment Agent on the client computer 
(you must access Admin properties).

1. After opening the Deployment Agent property page, select the Remote Control 
tab.

2. Select Allow this computer to be remote controlled to provide access from the 
Deployment Server Console.

3. (Optional) To lock the keyboard and mouse during a remote control session, select 
the Enable keyboard and mouse driver option.

This option works only on Windows.
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Note
After selecting this option (either enabling or disabling the keyboard and mouse) 
you must restart the managed computer. This can be done using a Power Control 
operation. See Power control on page 126.

4. If you want the user to be prompted before a remote control session begins, click 
the User Prompts tab.

a. From the Choose the commands you would like to be prompted before 
executing options, select the Remote Control commands option.

b. Specify the number of seconds you want the prompt to wait. Also, specify what 
will happen after the prompt time is over. Click either Continue the operation 
or Abort the operation.

5. Click OK.

Start multiple sessions
You can manage multiple computers using the Remote Control feature. However, the 
more computers you include in the session, the larger the bandwidth over the network.

Open a separate Remote Control window for each managed computer. Right-click 
each computer and select Remote Control. A new window appears for each 
selected computer.

Open a Remote Control window for a group of managed computers. Right-click a 
computer group icon and select Remote Control.

The Remote Control Options dialog appears with options to Control each client 
separately in its own window or to Control all clients together. If you select to 
control clients separately, individual windows appear for each computer. If you 
select to control clients together, you are asked to select a master computer.

The Master Computer is the computer that appears in the Remote Control window, 
but all   operations performed from the Master Computer’s console also run on the 
other computers in the group. All computers in the group should be similar in 
configuration to work properly.

Note
If you are controlling multiple computers in a single window, you can send a file only 
between the console and the master client. If you want to send a file to multiple 
clients at the same time, use the Copy File to feature. See Copying a file on 
page 188.

To end a Remote Control session, click Control > Close Window.

Remote desktop connection
Remote Desktop connection is available for many Windows operating systems.

To remotely connect to a computer

1. Open the Deployment Console and right-click the Vista computer you want to 
remotely connect.

2. Click Remote Desktop. The remote desktop window for the computer appears.

The remote desktop connection is established to the Vista computer.
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To remotely connect to multiple computers using the Remote Desktop 
option

1. Open the Deployment Console and right-click the computer you want to remotely 
connect.

2. Click Remote Desktop. The remote desktop window for the computer appears.

The remote desktop connection is established to the computer.

To remotely connect to multiple computers

1. Open the Deployment Console and right-click the computers you want to remotely 
connect.

2. Click Remote Control. The Remote Control Options dialog appears.

3. Select Control each client separately in its own window to remote control each 
computer separately.

or

Select Control all clients together, in the same window, using the following 
master to remote control the selected computers together and select the master 
computer.

4. Click OK.

The remote control connection is established for the computers.

Additional remote control programs
You can manually add access to additional remote control programs to the Remote 
Control menu in the Deployment Console.

To add a program, open the RemoteControlTools.ini located at the root of your 
Deployment Share and follow the instructions provided in the file.

Execute 
Send a command from the Deployment Console as if you were entering a command 
from the command-line prompt on the client computer.

1. Type a command you would like executed on the selected remote computer(s), or 
select from a list of previously-run commands. Example: Type regedit to open the 
registry on the computer.

2. To run the command as another user on the managed computer, click User and 
enter the user name and password.

User account
Use this dialog to run a script using another local user account. You can log in with 
another user name and password with rights to run an execute command.

 

Execute a command to a client computer by right-clicking a computer icon 
in the Computers pane and selecting Execute, clicking Operations > 
Execute from the menu, or clicking this icon in the toolbar.
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Run with default security credentials. This option runs with the current user 
credentials. This is the default option.

Run with the following credentials. Click this option to log on with another user 
name and password.

See also Remote operations using Deployment Solution on page 122.

Chat 
You can communicate with managed computers using the Chat text messaging system. 
From the Deployment Server Console, select an individual computer or a group of 
computers to open an individual chat session with each logged-in user.

1. Open a chat session. The Chat with <computer name> window appears, 
identifying the computer you are sending messages to.

2. Type a message in the lower field.

3. Click Send or press Enter.

The exchange of text messages appears in the upper field.

See also Remote operations using Deployment Solution on page 122.

Prompt user for properties 
This feature lets an administrator prompt a user for computer location and user 
information. The information supplied in this form appears in the Location properties in 
the Computer Properties dialog. See Computer properties on page 119.

To prompt a user for location properties

1. In the Computers pane of the Deployment Server Console, right-click a computer 
and click Advanced > Prompt User for Properties. You can also select a 
computer and click on the Prompt User for Properties icon in the toolbar or click 
on Operations > Prompt User for Properties.

A dialog appears in the Deployment Server Console with a list of properties.

2. Select the properties to prompt the user. The properties selected in this dialog are 
active on the property form sent to the user, letting the user enter information for 
the selected properties.

Note
All properties are selected by default; you must deselect the properties you don’t 
want to include when the client is prompted.

3. Click OK.

 

Open text messaging with a user by right-clicking the computer icon in the 
Computers pane and selecting Chat, or clicking this icon in the Remote 
Control dialog. See Remote control on page 127.
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The properties form appears for the logged-on user of the computer, asking for 
location properties.

When the user enters information and selects OK, the Location properties in the 
Computer Properties field are updated for the selected computer. If the user 
changes the computer name, the name in the Computers pane of the Deployment 
Console also changes. These settings are stored directly to the Deployment 
Database.

See also Chat on page 132 and Remote operations using Deployment Solution on 
page 122.

Install automation partition
When the Deployment Server sends a deployment job to client computers, tasks within 
the job can be assigned the default automation pre-boot environment, or one of DOS, 
Linux, or WinPE. With an embedded (recommended) or hidden automation partition 
installed on the client computer’s hard disk, deployment jobs can run automatically.

You can have multiple tasks within a deployment job, and each task can be assigned to 
run in a different automation environment, depending on the task and end result you 
want. The following are the automation tasks you can add to the deployment jobs.

Run script

Create disk image

Distribute disk image

Scripted OS install

During the Deployment Server installation, the Pre-boot Operating System page appears 
for you to select a default pre-boot operating system, which is used by Boot Disk Creator 
to create the configurations that boot client computers to automation. You can install 
additional pre-boot operating system files through Boot Disk Creator. See Boot Disk 
Creator Help.

If you are running PXE Servers, you do not need to install an automation partition on 
each client computer’s hard disk. When the Deployment Server sends a deployment job, 
PXE-enabled client computers search for a PXE Server to receive the boot menu options 
and the boot menu files that are required to boot to automation. See Automation Pre-
boot Environment in the Deployment Server Reference Guide.
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To install an automation partition

1. Right-click a computer and click Advanced > Install Automation Partition.

2. From the drop-down list, select the pre-boot operating system environment you 
want to install.

3. Click OK.

The Automation Agent you selected installs as an embedded partition on the client 
computer’s hard disk. After the installation completes, the client computer reboots 
automatically. You can now run automation-specific deployment tasks on this 
computer.

Change agent settings
This feature lets you modify most of the agent settings for a selected computer or 
computer group. You can set properties for the Production Agent (Deployment Agent), 
or for an Automation Agent.

To change agent settings

1. From the Computers pane, right-click a computer and select Change Agent 
Settings. 

2. Select either Production Agent or Automation Agent.

3. Edit the properties settings.

4. Click OK.

Deploying and managing servers
Deployment Solution provides additional features to remotely install, deploy and 
manage network and Web servers. From the Deployment Server Console, you can 
configure new server hardware, install operating systems and applications, and manage 
servers throughout their life cycle. And because servers are mission-critical, you can set 
up a system to quickly deploy new servers or automatically re-deploy servers that have 
failed. Features like rules-based deployment, support for remote management cards, 
and quick server restoration from a deployment history give you new tools to manage all 
servers throughout your organization.

Manage Servers from the Console. The Deployment Server Console includes features 
specifically designed for deploying and managing servers, such as enhanced task 
logging and history tracking features to let you recall administrative actions and quickly 
redeploy mission-critical servers. 

Servers are identified in the Computer pane with distinctive server icons. 
Like all managed computer icons, the icons change to identify the status 
and state of the computer, such as user logged on or Server Waiting. 

Note

Servers are recognized by their operating system (such as Windows or 
Linux), multiple processors, and specific vendor server models.
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Set Server-specific options. Servers are essential to any organization and require 
special planning and management strategies. Deployment Server provides server-
specific features to automatically deploy new servers and maintain existing servers. See 
Server deployment options on page 136. 

Server management features
Deployment Server provides various features for deploying and managing servers. 
These features are supported for client computers as well, but are essential in deploying 
servers.

Server icons. The Deployment Console displays icons that identify servers across the 
network. Like other computer icons in the console, server icons can be selected to view 

server properties or assign specific jobs and management tasks

Run Scripted Installs. Execute scripted, unattended installs across the network for 
both Microsoft Windows and Linux servers. Follow steps to create answer files and set up 
operating system install files using a wizard. See Scripted OS install on page 168.

Support for multiple network adapter cards. Because servers may require more 
than one network interface card, Deployment Server provides property pages to access 
and configure multiple network adapters remotely from the console. See TCP/IP 
configuration settings on page 104.

Synchronized server date and time. Deployment Server automatically sets the 
server’s date and time after installing or imaging (as part of the configuration process). 
Deployment Agents include an option to disable this feature (it is off by default).

Enhanced scripting capabilities. You can deploy multiple tasks per deployment job 
and boot to DOS multiple times when configuring and deploying a clean server. 
Deployment Server also lets you view and debug each step in the deployment script, 
and track each job to provide a history of tasks for redeploying a server.

Server deployment options
Deployment Server includes features to automatically reconfigure and redeploy new 
servers. If you are using Initial Deployment to automatically re-image new servers or 
run installation scripts, you can (1) safeguard against mistaken disk overwrites, or (2) 
run automatically for every server not identified as a managed computer in the 
database. These contrasting settings are based on polices you define for managing 
servers in your organization.

Icon Description

 The server is active and a user is logged on.

 

The server is disconnected from the console.

 

The server is in a waiting state.
Altiris Deployment Solution™ from Symantec User’s Guide 135



 

Example: If you rely on PXE to boot the new server and you want to deploy new servers 
automatically without halting the process, you must change the default settings in the 
PXE Configuration Utility. In contrast, if you want to ensure that the server waits before 
being deployed (or waits a set time before proceeding) to avoid erroneous re-
deployment, you must set the options in the Advanced section of Initial Deployment.

Halt the initial deployment of servers

When a server boots from a PXE server or from Automation (if the option is set), 
Deployment Server recognizes it as a new computer and attempts to configure the 
computer with sample jobs. See Sample jobs on page 196. Initial Deployment includes a 
feature to prohibit servers from being deployed automatically.

1. Click Initial Deployment and select Properties.

2. Click the Advanced tab.

3. Select the Servers check box and click OK.

Initial Deployment does not run for any computer identified in the console as a server.

Change PXE options for initial deployment

If installing a server using a PXE Server, the server attempts to install, but does not run 
automatically using default settings. It waits until a boot option is selected from the 
client computer. You can change the default setting in the PXE Configuration Utility to 
allow Initial Deployment to run automatically and not wait for user intervention.

1. Click on Start > All Programs > Altiris > PXE Services > PXE Configuration 
Utility.

2.  Click the DS tab.

3. Select a pre-boot operating system from the Initial Deploy boot option drop-
down list.

4. Click Execute Immediately. 

Initial Deployment runs automatically for every identified server.

5. Click Save.

6. Click OK.

Clear BootWorks prompt for remote Iistall

When you run a deployment job on a computer where the Deployment Agent is remotely 
installed, a message appears stating that no BootWorks partition or PXE stamp is found. 
The message remains open until the user clicks OK on the message dialog, which delays 
executing the scheduled job as part of an automated redeployment process. To fix this 
delay:

1. Select Tools > Options. The Program Options dialog appears.

2. Select the Agent Settings tab.

3. In the Automation Agent Settings section, select the Force new Automation agents 
to take these settings check box and click Change Default Settings.

4. Click OK. 

Following these steps, ensures that the BootWorks message does not appear and a job 
runs smoothly when scheduled.
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Managing server blades
Deployment Solution lets you manage high-density server blades with Rack/Enclosure/
Bay (R/E/B) hardware and properties. From the Deployment Console, you can deploy 
and manage these space-efficient server blades using the physical view to assign jobs 
to the Rack, Enclosure, or Bay level of the server cluster, or you can manage each server 
blade directly from the logical view. 

See Bay on page 121 for properties and rules to deploy Rack/Enclosure/Bay servers.

Using Deployment Solution, you can employ rip and replace technology that lets you 
insert a new server blade and automatically configure and deploy it exactly like the 
previously installed server blade, letting you replace any server that is down and get it 
back on line quickly. By default, the replay option is checked when you create a new job. 
This option replays the job during any rip and replace actions.

Symantec provides fail-safe features to ensure that no server is mistakenly overwritten 
and that all disk images, software, data, and patches are applied to the new server from 
the history of jobs assigned to the previous server blade. 

Managing new server blades
Deployment Solution lets you automatically deploy, configure and provision new server 
blades using a variety of features, including Sample Jobs and Server Deployment Rules. 

See Sample jobs on page 196 and Server deployment rules on page 121.

New server blades in newly identified bays

When new blades are identified in a Bay that has not been used previously (if it has 
been used previously, the Bay object is identified in the physical view), both the Initial 
Deployment and Virtual Bays features can be set up to automatically run configuration 
tasks and deployment jobs.

To Create Virtual Bays: Set up Virtual Rack/Enclosure/Bays for Hewlett-Packard Rapid 
Deployment Pack installations of Deployment Solution.

Initial Deployment setup: Clear the Servers check box in the Advanced dialog.

If both new computer features are set up and a new server blade is installed in a Bay not 
previously identified by the Deployment Server, the Create Virtual Bay feature executes 
and Initial Deployment does not execute.

New server blades in identified bays

If a new HP server blade is installed in an identified Bay (one that already has a server 
blade installed and is visible from the Deployment Console), both Sample Jobs in 
Deployment Solution and Server Deployment Rules can be set up. However, when both 
are set up, the Server Deployment Rules execute and Initial Deployment does not 
execute.

Virtual bays 
Hewlett-Packard blade servers now have a Virtual Bay feature that lets you pre-assign 
deployment jobs to the Rack, the Enclosure, or to a specific blade server in the Bay. Any 
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HP blade server can have predefined deployment jobs and configuration tasks 
associated with it to execute automatically upon installation. (This feature requires that 
the Hewlett-Packard Rapid Deployment Pack is installed.) The Virtual Rack/Enclosure/
Bay icons change from virtual icons to managed server icons in the Deployment Console 
as live blade servers are inserted and identified by Deployment Solution.

Rack name. Enter or edit the name of the Rack.

Enclosure name. Enter or edit the name of the Enclosure.

Enclosure type. Select the type of HP server blade from the list.

Initial Job. Select an existing job to run when the pre-configured computer account is 
associated with a new server blade.

Server Change rule. Select the Server Deployment Rules to run on the Bay when a 
new server blade is installed.

See Server deployment rules on page 121.

Note
If you create Virtual Bays for an enclosure (such as the BLe-class with 20 bays) and if 
another model of server blade with an enclosure containing fewer bays is connected 
(such as the BLp-class with 8 bays), the excess virtual bays are truncated automatically. 
Conversely, if you create Virtual Bays with fewer bays (8) and install an enclosure with 
additional bays (20), you must re-create the virtual bays in the enclosure (right-click the 
enclosure name in the physical view and click New Virtual Bays).

See also Managing new server blades on page 137.

Hewlett-Packard server blades
Hewlett-Packard high-density blade servers can be deployed and managed from the 

Deployment Console. The following HP server blades are supported:

HP blade servers let you employ all features provided in the Deployment Console when 
you install the HP Proliant Essentials Rapid Deployment Pack (see www.hp.com/servers/
rdp), including the Virtual Blade Server feature. The name of each Rack for an HP Server 
appears along with the assigned name for the Enclosure and Bay. These names are 
collected from the SMBIOS of the server blade and appear in both the physical and 
server views within the Computers pane of the Deployment Console.

For HP blade servers in the physical view, the Rack name can be a custom name in the 
console, with all subordinate Enclosures and Bays also identified. Example:

<rackName>

<enclosureName>

<bayNumber>

HP Proliant™ BL e-Class HP Proliant™ BL p-class

 Proliant™ BL 10e Proliant™ BL 20p

 Proliant™ BL 10e G2 Proliant™ BL 20p G2

 Proliant™ BL 40p
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See also Server management features on page 135 and Server deployment options on 
page 136.

Dell server blades
Dell high-density blade servers can be deployed and managed from the Deployment 
Console. All Dell Rack Servers are supported by Deployment Solution, but the server 
blades can also be managed from the physical view in the Rack/Enclosure/Bay view. The 

following servers are supported: 

For Dell blade servers in the physical view, the Rack name is always Dell. All 
subordinate Enclosures and Bays are identified with custom names under the Dell rack 
name. Example:

Dell

<enclosureName>

<bayName>

See also Server management features on page 135 and Server deployment options on 
page 136.

Fujitsu-Siemens server blades
Fujitsu-Siemens high-density blade servers can be deployed and managed from the 
Deployment Console. All Fujitsu-Siemens Rack Servers are supported by Deployment 
Solution, but the server blades can also be managed from the physical view in the Rack/

Enclosure/Bay view. The following servers are supported: 

For Fujitsu-Siemens blade servers in the physical view, the Rack name is always 
Fujitsu-Siemens. All subordinate Enclosures and Bays are identified with custom 
names under the Fujitsu-Siemens rack name. Example:

Fujitsu-Siemens

<enclosureName>

<bayName>

See also Server management features on page 135 and Server deployment options on 
page 136.

Dell Rack Servers Dell Server Blades

All PowerEdge™ rack servers PowerEdge™ 1655MC

Fujitsu-Siemens Rack 
Servers

Fujitsu-Siemens Server Blades

All Primergy™ rack servers Primergy™ BX300 blade servers
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Note
If you have Fujitsu-Siemens Server blades managed by the Deployment Server, ensure 
that the SNMP service is running on the Deployment Server. Also, if the Deployment 
Server is installed on a Windows 2003 server, ensure that the security is set correctly to 
receive traps from remote computers. By default, Deployment Servers cannot receive 
traps from remote computers.

IBM server blades
IBM high-density Blade Centers can be deployed and managed from the Deployment 
Console. All IBM blade servers are supported by Deployment Solution, but the server 
blades can also be managed from the physical view in the Rack/Enclosure/Bay view.

For IBM blade servers in the physical view, the Rack name is always IBM. All 
subordinate Enclosures are identified with custom names under the IBM rack name and 
Bays are identified by number. Example:

IBM

<enclosureName>

<baynumber>

See also Server management features on page 135 and Server deployment options on 
page 136.

Finding a computer in the database 
This search filter lets you type a string and query specified database fields for specific 
computer properties. You can search for user or computer names, licensing or location 
information, or primary lookup keys: MAC address, serial number, asset number, or 
UUID. This search filter queries property values appear in the Computer Properties 
pages. See Computer properties on page 119.

 

1. In the Search For field, type all or part of the computer’s property values you 
would like to search for. This alpha-numeric string is compared with specified 
database fields.

2. From the In Field drop-down list, select the field you want to search in the 
Deployment Database.

Example: To find a computer by searching for its IP address, type the address in the 
Search For field and select the IP Address from the In Field drop-down list.

 

Click <CTRL> F or click Find Computer on the console toolbar to search 
the Deployment Database for computers by property settings. 

The search begins at the top of the computer list and highlights the 
computer name in the Computers pane when a match is found. Press F3 
to find the next computer that matches the search criteria until there are 
no more results, or the end of the computer list is reached.
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The computer you are looking for appears highlighted in the Computers window in the 
console.

Note
This search is not case-sensitive and allows wildcard searches using *.

See also Computer filters and job conditions on page 80.

Using lab builder 
Use the Lab Builder to set up jobs under the Lab folder in the Jobs pane to set up a 
classroom or lab environment.

You can set up jobs to: 

Create Disk Image

Deploy Lab

Restore Lab

Update Configuration

Upload Registries

Name BIOS name of the computer.

Computer 
Name

Deployment Solution name of the computer.

MAC Address Example: 0080C6E983E8.

IP Address Example: 192.168.1.1.

ID Example: The computer ID. 5000001.

Serial Number Serial number installed in BIOS. A primary lookup key.

Asset Tag Asset number in BIOS. A primary lookup key.

UUID A primary lookup key.

Registered 
User

Name entered when the operating system was installed.

Product Key Product Key for the operating system.

Logged On 
User 

Name of the user currently at the computer.

Physical Bay 
Name

The actual bay number. Example: 7x.

 

Click Lab Builder on the console toolbar or click File > New > Lab Builder 
to set up jobs specifically created for managing multiple computers in a lab 
environment.
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Each of these jobs contains a default list of tasks. Lab Builder places these five new jobs 
under a folder (which you name) located under the Lab folder. All tasks in the jobs have 
been assigned default paths and file names that let them use the same images and 
configuration information, registry data, and so on. We recommend that you do not 
change the file names and paths. If you change the default settings (example: changing 
the image name), you must change them in all jobs where the image is used.

To use Lab Builder

1. Click the Lab Builder icon on the toolbar, or choose File > New > Lab Builder.

2. Enter the name of the Lab Setup.

Note
The lab name must be unique because the program creates a default image file 
name based on the name, and the image file name must be unique. The default 
image name is synchronized in all lab jobs, so if you change the name later you 
must change it in all the jobs that use the image. 

3. (Optional) Enter a lab description to help you differentiate the lab from others and 
click OK.

4. Identify an image in the Create Disk Image job. See Creating a disk image on 
page 157.

5. Set computer names and addresses in the Update Configuration job.

The following information describes the default jobs. To run one of these jobs, simply 
drag it to the computer or computer group you want it applied to.

Create Disk Image. This job uploads an image of a computer to the server and an 
image name is created automatically based on the lab name. However, there is no actual 
image in the job until you drag the image source computer to this job.

Deploy Lab. This job has three default tasks: Deploy image, Apply configuration 
settings, and Back up registry files. The image that is uploaded using the Create Disk 
Image job is deployed when you use this job. The configuration settings you specify in 
the Update Configuration job are applied to the computers, and the computer registry 
files are uploaded to the Deployment Server. 

Restore Lab. This job restores the image and registry files to a computer where a lab 
was previously deployed. You can quickly get a computer running again by restoring the 
lab on that computer.

Update Configuration. This job lets you set unique configuration information (such as 
computer names and network addresses) for client computers. When a lab is deployed, 
each computer has an identical image, but not the same configuration settings. This 
means you don't have to visit each computer to reset the IP addresses and other 
settings when you deploy an image.

Upload Registries. This job backs up computer registry files to the Deployment Server.
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Chapter 14
Building and scheduling jobs 

A job represents a collection of predefined or custom deployment tasks that are 
scheduled and executed remotely on selected client computers. You can build jobs with 
tasks to automatically create and deploy hard disk images, back up and distribute 
software or personality settings, add printers, configure computer settings, and perform 
all aspects of IT administration. Jobs can be run immediately for a specific computer, or 
stored and scheduled for daily or long-term administrative duties on multiple computer 
groups.

The New Job Wizard guides you through common deployment and management jobs. It 
is an easy way to set up new users or migrate users to new computers, create and 
distribute images of computers on the network, distribute software packages, restore 
computers, and more. See New job wizard on page 146.

Jobs include one or more Deployment tasks. You build jobs by adding tasks to a job and 
customizing the task for your specific needs. You can add tasks to capture and distribute 
images, software packages, and personality settings. You can also write and run a script 
task, or run scripted installs, configure settings, copy files and back up registry settings. 
You can also modify existing jobs by adding, modifying, copy and pasting, or deleting 
tasks to suit your requirements. See Deployment tasks on page 155 and Building new 
jobs on page 150.

Set conditions on jobs to run only on computers with properties that match the criteria 
you specify. You can build one job to run on different computer types for different needs, 
and avoid mistakes by ensuring that the correct job runs on the correct managed 
computer. See Setting conditions for task sets on page 151.

Initial Deployment lets you run predefined jobs and configuration tasks on new 
computers when they start up. You can automatically deploy new computers by imaging 
and configuring TCP/IP, SIDs, and other network settings and installing basic software 
packages. See Sample jobs on page 196.

Sample jobs are installed with Deployment Solution and appear in the Samples folder 
of the Jobs pane. You can run many sample jobs as they are, or you can set 
environmental variables. See Sample jobs on page 196.

Viewing job details
As jobs are assigned, scheduled and executed, it is helpful to know specific details about 
their status and assignments. The Deployment Console provides job icons to show the 
state and status of the job in the Details pane:

 

Job icons appear in the Jobs pane of the Deployment Console. To assign and 
schedule a job in the Deployment Console, drag the job icon to selected 
computer icons. Job status icons also appear in the Details pane of the 
Deployment Console to indicate various deployment states. See Viewing job 
details on page 145.
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Job status icons that update the state of the job in running deployment tasks. These 
icons are graphical symbols in the Deployment Console used to identify the status of 
an assigned job.

.

A description of the job, if available. You can also use Add or Modify in the main 
window to edit the description.

If a job defines error conditions when individual tasks run, the Status field displays 
any errors incurred and the tasks that completed successfully.

Job Schedule details. This is the job's run time, beginning when the job started 
and ending when it completed successfully.

The currently applied conditions appear in a list box with a Setup option to add 
conditions to different task sets for different computer properties within a job. 
Conditions specify characteristics that a computer must have before the job runs. 
See Setting conditions for task sets on page 151.

A list of tasks assigned to the job and task descriptions also appears. Change the 
order of the task execution with the up and down arrows. Tasks are executed in the 
order they are listed. See Deployment tasks on page 155.

Features to add, modify, and delete tasks for each job.

A list of assigned computers and its deployment history.

To sort jobs or computer details, just point and click on the category in the Details 
pane. Example: Click the Status column heading to organize and display the progress 
status of the job.

See also Viewing computer details on page 96.

New job wizard 
The New Job Wizard provides integrated features to build, assign, and schedule common 
deployment jobs. It helps you build the most common jobs, and guides you through 
additional steps to assign and schedule the jobs to selected computers. It lets you 

 
A job is scheduled to run on a computer or computer group.

 
A job is in progress. 

 
A job has executed successfully.

 A job is associated with a computer or group of computers but is not 
scheduled. 

Indicates error conditions when individual tasks run.
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quickly build image files and deploy new computers, distribute software packages, 
migrate users, and more.

Note
When a software package or deployment job is scheduled to run on client computers, 
the Altiris Client Service Message dialog appears, warning them that a job is about to 
execute. If a user clicks Abort when the message appears, an event is logged to the 
client's history so that Deployment Solution administrators know when users abort a 
scheduled event.

1. Select a job option:

Create an image. This wizard guides you through the steps required to create an 
image of a computer’s hard disk and schedule the job. See Creating a disk image on 
page 157.

Deploy and configure computers. This wizard guides you through the steps 
required to deploy a previously created new disk image on a selected computer and 
install software and personality settings. See Distributing a disk image on page 162.

Deploy software packages. This wizard guides you through steps required to 
install software packages. You can set conditions, select packages, assign to 
computers, and schedule the job. See Distributing software on page 175.

Restore a computer. This wizard guides you through the steps required to restore 
a computer to a known working state by re-imaging the hard drive and reinstalling 
software packages, personality settings, and defining configuration values. This 
option reschedules jobs saved in each managed computer’s history record, which 
contains all deployment tasks previously processed. See Restoring a computer from 
its deployment history on page 124.

Migrate computers. This wizard guides you through the steps required to migrate 
the hard disk image, applications, and personality settings from a source computer 
to a destination computer. You can perform one or more migration operations using 
the provided options.

2. Give the job a unique name. You can type a name up to 64 characters. 

3. Follow the steps in each wizard to create a job (some New Job wizards build multiple 
jobs).

4. (Optional) Unselect the Replay during rip and replace option.

This option is selected by default. This option replays the job during any rip and 
replace actions.

After creating a job, the job appears in the Jobs pane of the Deployment Console with 
the deployment tasks listed in the Tasks list.

 

Create a new job by clicking New Job Wizard on the Deployment 
Console, clicking File > New > Job Wizard, or right-clicking in the Jobs 
pane of the Deployment Console and selecting New Job Wizard. The 
New Job Wizard appears to guide you through basic deployment jobs.
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Note
You cannot define return codes when using the New Job Wizard. See Building new jobs 
on page 150 to build customized jobs and set up return codes. 

See also Modifying tasks in a deployment job on page 190.

Migrating computers 
From the New Job Wizard, you can select Migrate computers to quickly distribute hard 
disk images, software, and settings from a user’s current computer to a new computer. 
You can image a new computer’s hard disk with a new operating system and install 
software and personality settings. Or perform different levels of migration to distribute 
only software or to simply capture and distribute personality settings to the new 
computer.

Migrate one computer to another separate computer

Click this option to migrate a user from a source computer (old computer) to another 
destination computer (new computer). Capture personality settings, distribute a new 
hard disk image, distribute software and redistribute the saved personality settings from 
the source computer to the new destination computer.

Click the option to migrate only personality settings to one or more computers. Also 
select Prepare destination computer with a disk image to distribute a disk image to 
the new computer and select Install software packages prior to applying the 
personality on the destination computer to install software packages on the new 
computer.

Note
This option creates two jobs that appear in the Jobs pane: Job (Capture) and Job 
(Distribute).

Job (Capture) includes a Capture Personality Settings task (see Capturing personality 
settings on page 179) to capture the personality of the source computer and a Modify 
Configuration task to rename the source computer to avoid naming conflicts (see 
Modifying configuration on page 182). The source computer is named computerName 
(Old).

Job (Distribute) includes a Deploy Image task (see Distributing a disk image on 
page 162) if selected, a Modify Configuration task to update settings to the destination 
computer, and one or more Install Package tasks to update software (if selected) and 
migrate personality settings. See Distributing software on page 175.

Migrate the same computer to another operating system

Click this option to upgrade the operating system on a computer and reinstall 
personality settings and software packages on the same computer. It creates jobs and 
tasks to capture the personality settings, distribute a new disk image, distribute 
software packages, and migrate the personality settings.

Click the option to deploy a disk image and migrate the personality settings to the 
computer. (Optional) Select Install software packages prior to applying the 
personality on the destination computer to install software packages on the 
computer.
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Note
This option creates two jobs that appear in the Jobs pane: Job (Capture) and Job 
(Distribute).

Job (Capture) includes a Capture Personality Settings task (see Capturing personality 
settings on page 179) to capture the personality of the source computer.

Job (Distribute) includes a Deploy Image task (see Distributing a disk image on 
page 162) and one or more Install Package tasks to update software, if selected (see 
Distributing software on page 175).

Simply capture the personality of the computers

Click this option to capture and save, but not distribute, the personality settings of the 
selected computer(s). You can select a personality template and save Personality 
Packages to the Deployment Share, letting you distribute these personality settings later 
to new computers.

Note
This option creates a single job with a Capture Personality Settings task (see Capturing 
personality settings on page 179).

See also New job wizard on page 146.

Selecting computers in the new job wizard 
The New Job Wizard provides steps to select and assign computers to the jobs created in 
the wizard, rather than requiring you to create a job and assign it to computers when 
building new jobs. The jobs created in the New Job Wizard appear in the Jobs pane, and 
can be saved and assigned to other computers at a later time. You can also schedule 
jobs for the specified computers in the wizard. See Building new jobs on page 150 and 
Scheduling jobs on page 153.

Applying computers to a job
When deploying software in the New Job Wizard, you can select computers to assign the 
Distribute Software task created in the wizard. (See Distributing software on page 175.) 
You can also select an option to simply store the job and use it at another time without 
scheduling the job. Regardless of the scheduling option selected, the job appears in the 
Jobs pane to use at another time.

New Computers. Open an Adding New Computers dialog to create new user 
accounts to assign the job. See Adding new computers on page 98.

See also Scheduling jobs on page 153.

Associating destination computers 
Use this dialog to associate source computers with destination computers when 
migrating personality settings. Depending on the computers selected in the previous 
Select Computers dialog, you can migrate personality settings captured from the 
source computers to new destination computers.

Right-click a computer in the Source column to replace it with another source computer. 
Right-click a computer in the Destination column to replace it with another destination 
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computer and assign it to a new source computer. To automatically assign multiple 
computers, click Automatic to assign source computers with destination computers 
using an alpha-numeric order. The associated computers share personality settings after 
running the jobs.

See also Migrating computers on page 148.

Setting up conditions in the new job wizard 
The New Job Wizard also provides steps to set up conditions, a step usually performed 
independently for each job during its build phase. Setting conditions lets you run 
selected tasks only on computers matching defined criteria. See Setting conditions for 
task sets on page 151.

Click Setup conditions for this set of tasks to open the Define Conditions dialog 
from the New Job Wizard.

Installing software packages 
The New Job Wizard provides steps to install software packages to the selected 
computers. You can install any type of software to the managed client computer, 
including .MSIs, .RIPs, and personality packages. If the selected package is not an .RIP 
or personality package, a message appears asking if you want to continue. See 
Distributing software on page 175 for additional information.

Option summary
After selecting the options in the New Job Wizard, you can view a summary of the job 
names, assigned computers, conditions, and other selected choices. To change any 
options, click Back to return to the previous dialog. Click Finish to complete the steps 
in the wizard.

See also New job wizard on page 146 and Job scheduling wizard on page 151.

Building new jobs 
A job can be a single task to distribute software or change computer property settings, 
or a series of tasks sequenced to migrate hard disk images, set post-installation TCP/IP 
and SID values, and install software packages and personality settings.

1. Create a new job. Enter a unique name and description for the job. You can type a 
name up to 64 characters.

A new job is added to the Jobs pane in the Deployment Console. You can group and 
organize jobs, and access and apply them to computers or computer groups from an 
index of prebuilt jobs.

 

To create a new job, click this icon on the Deployment Console, or click 
File > New > Job, or right-click in the Jobs pane of the Deployment 
Console and select New Job. You can modify jobs by double-clicking the 
job or right-clicking, and selecting Properties. Add tasks to each job by 
clicking Add.
Altiris Deployment Solution™ from Symantec User’s Guide 150



 

2. (Optional) Set conditions to apply the job to specified computers meeting defined 

criteria. Order multiple conditions to run jobs on computers that match the first 
applicable condition. See Setting conditions for task sets on page 151.

3. Click Add to open a list of deployment tasks to add to each job. See Deployment 
tasks on page 155.

4. Set task options using the provided wizards.

5. (Optional) Unselect the Replay during rip and replace option.

This option is selected by default. This option replays the job during any rip and 
replace actions.

After you complete the steps to create a task, it is added to the Task list. Click Add 
to add another task. Use the up and down arrows to change the order of execution 
of the tasks in the Task list.

Tasks are executed in the order that they appear in the task list. Therefore, ensure 
you do not run a task that overrides the previous tasks. Example: List Distribute 
Disk Image above Distribute Software or Distribute Personality, letting the 
hard disk be imaged before installing applications and settings.

6. (Optional) Set Return Codes. The last action in each task wizard lets you set return 
codes for each deployment task. See Setting up return codes on page 193.

7. After adding tasks, click OK.

8.  To schedule the job, drag it to a computer or computer group. The Schedule Jobs 
dialog appears. See Scheduling jobs on page 153.

See also Importing and exporting jobs on page 193.

Job scheduling wizard
The Job Scheduling Wizard provides features to assign jobs to selected computers and 
computer groups, and to schedule the jobs to run without using a mouse. This new 
feature meets Section 508 requirements to improve disability access and enables 
integration of voice activation software and other user interface features.

Select a job
Select the jobs or groups of jobs to assign to computers or computer groups. Use the 
SHIFT and CTRL keys to select multiple jobs or job folders. Click Next.

Select a computer or computer groups
Select the computers or groups of computers to assign the jobs selected in the previous 
dialog. Use the SHIFT and CTRL keys to select multiple computers or groups. Click 
Next.

New Computers. Click when adding new computers. See Adding new computers on 
page 98.

Setting conditions for task sets 
Setting conditions on a job lets you run selected tasks only on computers that match 
defined criteria. As a result, you can create a single job with tasks defined for computers 
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with varying properties, including operating system types, network adapters, 
processors, free drive space, and other computer properties. You can create task sets 
for each job that apply only to the computers matching those conditions.

Note
The default condition (named default) has no parameters or values associated with it. If 
this is the only condition that a job contains, the tasks associated with the default 
condition will always work on all computers to which the job is assigned. A default 
condition is like having no conditions.

In addition, if a task is associated with the default condition, the task always runs when 
a computer does not meet any other conditions associated with this job.

1. Select a job from the Jobs pane of the Deployment Console. The Job Properties 
dialog appears.

2. Click Setup next to the Condition field. A menu appears with options to create a 
new condition, or to modify, delete, or reorder a condition.

3. To reorder conditions, click Order and reorder them using up or down. See Order 
condition sets on page 153.

4. To create a new condition, click New in the menu. The Condition Settings dialog 
appears. Enter a name up to 64 characters.

5. Click Add to open the Condition dialog. Specify the following conditions and click 
OK:

From the Field drop-down list, select a data field heading. You can define 
conditions based on common client features such as operating system, software 
and hardware version, hard drive space, operating system language, RAM, and 
other characteristics.

To set up custom conditions based on custom tokens, select User Defined 
Tokens from the Field drop-down list.

From the Operation drop-down list, select a compare statement.

In the Value box, type a string to search for in the selected database field. You 
can set conditions based on computer properties stored in fields in the 
Deployment Database. Example: You can set a condition to match a particular 
asset tag, Altiris agent version, or IP address. You can use wildcard characters 
and AND/OR operators.

To set up custom conditions based on custom tokens, select User Defined 
Tokens from the Field list.

The task set you create appears in the Task list for each condition. When you select a 
new condition, the tasks for that condition appear.

Example: You can set Condition A to distribute the XPImage.img file to Windows XP 
computers using a Deploy Image task. You can set Condition B to distribute the 
W2KImage.img file to other Windows computers using another Deploy Image task. 
When the job is applied to a computer group, the conditions are evaluated for each 
computer and the appropriate task runs on the appropriate computer.
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Note
When using User Defined Tokens to set conditions for some client property values, you 
may be required to use the decimal value instead of the hex value. Example: When 
setting conditions based on the NICS table on the nic_device_id and nic_vendor_id 
columns, you must use decimal values.

 See also Deployment tasks on page 155.

Order condition sets
By specifying and ordering different sets of conditions, you can determine when a task 
executes based on defined computer properties. Each condition is processed in sequence 
until the computer matches the condition defined within a set. If the computer does not 
meet any of the defined conditions, it runs the default condition. Once a match is found, 
the set of tasks for this condition set is processed.

See also Setting conditions for task sets on page 151.

Scheduling jobs
After a job is created and is assigned to multiple computers or computer groups, the 
Schedule Job dialog appears, letting you schedule the job to one of the following 
options: Do not schedule, Run this job immediately, Schedule this job. Jobs and 
job folders selected from the Jobs pane of the Deployment Console are scheduled in the 
order they are selected, even across multiple Deployment Servers.

To schedule a job

1. Drag a job to a computer or computer group. The Schedule Job dialog appears.

2. In the Schedule Job dialog, click the Job Schedule tab. The following options are 
available:

Do not schedule. This option lets you assign jobs to computers but does not 
run the job until you return to the Schedule Job dialog and set a run time.

Run this job immediately. This option lets you run the job immediately.

Schedule this job. This option lets you specify the date and time to run the 
job.

Repeat this job every. This option lets you schedule this job to repeat after a 
specified number of minutes, hours, days, or weeks.

Allow this job to be deferred for up to. This option lets you defer the job for 
a specified number of minutes, hours, days, or weeks when the server is busy 
executing other jobs, setting a lower priority for particular jobs. By default, all 
jobs are deferred up to five minutes.

Schedule in batches of x computers at y minute intervals. This option lets 
you schedule computers in batches to maximize efficiency.

3. Click the Computer(s) Selected tab. This is a list of computers on which the job is 
scheduled to run, with their associated group and IP address.

4. Click the Job(s) Selected tab. The job name and folder located in the Jobs pane 
appear. Use the up and down arrows to change the order of the scheduled jobs.

5. Click OK.
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Note
The Schedule Job dialog is the same for Rescheduling Jobs, New Job Wizard, and Job 
Scheduling Wizard.

To reschedule a job

1. From either the Computers or Jobs panes in the Deployment Console, select a job 
or computer that has been previously scheduled.

A job icon appears in the Details pane, identifying the computers assigned or the 
name of the job.

2. Select the job icon, click the scheduled computers in the Details pane, right-click 
and click Reschedule.

If you select a computer icon, click the job icon in the Details pane, right-click and 
click Reschedule. The Schedule Jobs dialog appears.

3. To immediately start a scheduled job that has not yet run, right-click the job icon 
and select Start Now.

4. To stop a repeating job, right-click the job in the Details pane and click 
Discontinue Repeat. At this point you need to schedule a new time to run the job 
or click the Do not schedule option.

To remove computers from a scheduled job

You can complete this task by removing a job assigned to a computer or removing a 
computer assigned to a job.

1. Click a job in the Jobs pane.

2. Click a computer in the Details view and press Delete or right click the job(s) and 
select Delete.

To remove tasks from a job

You can remove tasks assigned to a job by double-clicking the job and opening the Job 
Properties dialog. (Edit features also open in the Details view of the Deployment 
Console when you select the job from the Jobs pane).

1. Select one of the assigned tasks in the Task list.

2. Click Delete.

To remove scheduled jobs from a computer 

1. Click the computer.

2. Select the scheduled job in the Details pane, and press Delete or right click the 
job(s) and select Delete. To remove multiple jobs, hold down the SHIFT or CTRL 
key while you select the job(s), press Delete or right-click the job(s) and select 
Delete.

The icon for a scheduled job is yellow.

To run a job immediately from the resources view

If you have a batch file, image file, .RIP, .MSI, or executable file assigned to a job or 
stored in the Deployment Share, these files and packages appear in the Resources 
view (see Shortcuts and resources view on page 72). You can drag these files and 
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packages from the Resources view to a computer or computer group to automatically 
create and run a job (or you can drag computers to a file or package in the Resources 
view). A job is created automatically for each assigned package in the Systems Jobs > 
Drag-n-Drop folder.

See also Building new jobs on page 150 and Modifying tasks in a deployment job on 
page 190.

Deployment tasks
A task is an action of a job. Jobs are built with tasks. Each task runs according to its 
order in the task list contained in a job. You can resize the task pane by dragging the 
bottom pane (horizontal bar) that separates the task list and the scheduled computer 
list of the Deployment Console. This lets you view a greater number of tasks in a 
deployment job without using the scroll bar to navigate up and down.

Task names in a mixed-language environment
Deployment Server does not handle the code pages in a mixed-language environment 
well. If a Windows 32-bit Deployment Server Console is installed on a native single-byte 
OS (for example, English, Italian, and French) and viewed on a double-byte language, 
the task names show as a series of question marks.

When you view the task names on a native double-byte OS, they display correctly.

Common Tasks
The Add menu of the Deployment Console includes the following tasks:

Create Disk Image. Create a disk image from a reference computer and save the 
image file (.IMG or .EXE files) for later distribution. See Creating a disk image on 
page 157.

Distribute Disk Image. Distribute previously created disk images (.IMG or .EXE files) 
or create a disk image from a reference computer on the network and simultaneously 
distribute it (.IMG or .EXE) to other managed computers on the network. See 
Distributing a disk image on page 162.

Scripted OS Install. Run scripted (unattended) installs using answer files to install 
computers remotely over the network. See Scripted OS install on page 168.

Distribute Software. Distribute .RIPs, .MSI files, scripts, personality settings, and 
other package files to computers or groups. See Distributing software on page 175.

Manage SVS Layer. Instantly activate, deactivate or reset layers and completely avoid 
conflicts between applications, without altering the base Windows application. See 
Managing the SVS layer on page 177.

Capture Personality. Capture the personality settings of a selected computer on the 
network using the PC Transplant software. PC Transplant ships as a part of Deployment 
Server. See Capturing personality settings on page 179.

Distribute Personality. Send a Personality Package to computer or groups. This task 
identifies valid Altiris packages and assign passwords and command-line options to 
Personality Packages. See Distributing personality settings on page 181.
Altiris Deployment Solution™ from Symantec User’s Guide 155



 

Modify Configuration. Modify the IP address, computer and user name, domains and 
Active Directory organizational units, and other network information and computer 
properties. See Modifying configuration on page 182.

Back up Registry. Copy the registry files of selected computers and save the registry 
file settings to a selected directory. See Backing up and restoring registry files on 
page 183.

Restore Registry. Copy the registry file settings to a managed computer.

Get Inventory. This lets you gather inventory information from client computers to 
ensure that the Deployment Database is updated with the latest computer properties. 
See Get Inventory on page 166.

Run Script. Create custom commands using scripts to perform jobs outside the bounds 
of the preconfigured tasks. Use the Run Script dialog to select or define a script file to 
run on specified computers or groups. See Run Script on page 167.

Copy File to. Copy a file from the Deployment Share or another source computer to a 
destination computer. See Copy File to on page 170.

Power Control. Perform power control options to restart, shutdown, power off, and log 
off. See Power Control on page 172.

Wait. Use the Wait dialog to retain a computer in automation mode after a task is 
performed. See Wait on page 172.

Tasks are listed for each job in the Task list. Each task runs according to its order in the 
list. You can change the order using the up and down arrow keys.

Supported Live Task Types
The following is the list of the live tasks supported for the x64, IA64, and SPARC 
platforms.

Task x64 IA64 SPARC

Restore Computer Yes Yes Yes

History Yes Yes Yes

Configure Yes Yes Yes

Quick Disk Image Yes Yes Yes

Power Control: Wake Up Yes Yes Yes

Power Control: Restart Yes Yes Yes

Power Control: Shutdown Yes Yes Yes

Power Control: Log off Yes Yes No

Remote Control Yes No No

Execute Yes Yes Yes

Copy File Yes Yes Yes

Chat No No No

Advanced: Clear Computer Status Yes Yes Yes

Advanced: Prompt User for Properties Yes Yes No
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Creating a disk image 
This task creates an image of a computer’s hard disk. You can save the disk image as an 
.IMG, .EXE, .WIM, .DMG, or .GHO file.

For more information about Ghost, see the Symantec Ghost Imaging Foundation 
documentation.

 

To create an image of a computer, you must boot to DOS, Linux, or WinPE. This requires 
that you set up a PXE Server or install an automation partition.

To create a disk image

1. In the Jobs pane in the Deployment Console, select a job.

2. In the Details pane, click Add and select Create Disk Image.

3. In the Create Disk Image dialog, select an imaging tool from the drop-down list. 
You can select RapiDeploy (Text mode), RapiDeploy (Graphics mode), RapiDeploy 
(Linux mode), ImageX, Mac Image or Ghost.

Advanced: Reset Connection Yes Yes Yes

Advanced: Install Automation Partition Yes

Advanced: Get Inventory Yes Yes Yes

Advanced: Reject Connection Yes Yes Yes

Advanced: Uninstall Windows Agent Yes Yes No

Advanced: Install BIS Certificate No No Yes

Advanced: Remove BIS Certificate No No Yes

Advanced: Apply Regular License Yes Yes Yes

New Job Wizard Yes Yes Yes

New Group Yes Yes Yes

New Computer Yes Yes Yes

Rename Yes Yes Yes

Delete Yes Yes Yes

Change Agent Setting Yes Yes Yes

Permissions Yes Yes Yes

Job Scheduling Wizard Yes Yes Yes

 

Create an image file by using the New Job Wizard or adding the task when 
building new jobs. You can distribute the disk image file using the 
Distribute a Disk Image task. This task will run Altiris RDeploy.exe from 
the console to capture and migrate hard disk images. See New job wizard 
on page 146, Building new jobs on page 150, and Distributing a disk image 
on page 162.

Task x64 IA64 SPARC
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RDeploy Options

RDeployT is the default imaging executable. This facilitates the imaging of thin client 
computers. The following are the RapiDeploy options for imaging:

Graphical Mode (RDeploy). Select this option to run the RDeploy in a GUI mode. 

Text Mode (RDeployT). Select this option to run the RDeploy in a text mode.

Linux (RDeploy). Select this option to run the RDeploy in Linux mode.

You can select the ImageX or Mac Image option for imaging. If you select ImageX, 
the image is created as a .WIM file. If you select Mac Image, the image is created as 
a .DMG file. For information on creating a Mac Image, see Creating a Mac image on 
page 159.

You can also select the Ghost option for imaging. If you select Ghost, the image is 
created as a .GHO file. For information on creating a Ghost Image, see Creating a 
Ghost image on page 160.

Important
Linux (RDeploy) and Ghost options are available only when the ImageTools.ini file is 
stored in the eXpress folder.

4. Enter additional parameters in the Additional Parameters field.

You can add command-line options specifically for the RapiDeploy program to run 
imaging tasks. See Command-line Switches in the Deployment and Migration Guide.

5. Enter a path and file name to store the disk image file. You can store image files to 
access later when a managed computer is assigned a job that includes the image 
file.

The default file name extension is .IMG. Saving image files with an .EXE extension 
converts them into self-extracting executable files (the run-time version of 
RapiDeploy is added in the file). You can also save ImageX files with a .WIM 
extension, a Mac image with a .DMG extension, and a Ghost image with a .GHO 
extension.

If WinPE is used, Deployment Solution supports UNC and DFS paths in the Name 
field. For example, you can type \\My_Server\My_Volume\myimagefile.img in the 
Name field.

6. Select Disable image path validation if you want to store the image file outside of 
the Deployment Share file structure. If you do not select this option and do not 
specify a Deployment Share path, a warning message appears, reminding you to 
configure your automation process to use the path indicated in the Name field. You 
can still save your image to a location outside of the Deployment Share file structure 
even when you do not select this option. This option only eliminates the warning 
message. You can use this option to store images locally on the managed 
computer's hard drive or to an additional server used to store images.

If you typed a UNC path in the Name field and the server does not have access to 
the path, check to disable image path validation. Otherwise, the process fails.

When storing images locally on the managed computer's hard drive, ensure that you 
enter the path relative to the managed computer (Example: C:\myimage.img). 
When you store an image locally on a managed computer instead of a file server, 
you save server disk space and reduce network traffic.
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Prerequisite: To store images locally on the managed computer’s hard drive, you 
must have a hidden automation partition installed on the managed computer's hard 
disk with the required disk space to hold the images you want to store.

Caution
When imaging computers where images are stored on the managed computer’s 
hidden automation partition, use the option to remove the automation partition only 
when you want to clear all images from the computer.

7. Select Prepare using Sysprep to use Sysprep to prepare the system for imaging.

8. From the Operating System drop-down list, select the operating system or Add 
new to open the OS Product Key dialog and select the OS Information.

9. Click Advanced Settings. This opens the Sysprep advanced settings dialog. See 
Advanced Sysprep settings for creating a disk image on page 161.

10. (Optional) Select the Do not boot to Production option to create an image of the 
hard disk while booted to Automation without first booting to Windows to save 
network settings (TCP/IP settings, SID, computer name, and so on). If you select 
this option, these network settings are not reapplied to the computer after the 
imaging task, resulting in network conflicts when the computer starts.

11. From the Automation pre-boot environment (DOS/WinPE/Linux) drop-down 
list, select the required pre-boot environment to perform the Create Disk Image 
task in the selected pre-boot environment. By default, the Default Automation 
(Auto-select) type is selected.

Note
ImageX requires a WinPE x86 pre-boot environment.

12. (Optional) To select Media Spanning and additional options, click Advanced. See 
Create disk image advanced on page 162.

13. Click OK (if you are using the New Job Wizard) or click Next.

14. (Optional) Set Return Codes. See Setting up return codes on page 193.

15. Click Finish. The task appears in the Task list for the job. The disk image is created 
when you run this task.

Tip
If an imaging job fails on a managed computer, the Deployment Agent 
Configuration page appears on the client computer. This page displays a prompt to 
confirm whether the user wants to configure the client computer or restore the 
original settings. On the client computer’s screen, select Cancel > Restore 
Original Settings.

See also Deployment tasks on page 155.

Creating a Mac image
You can create a Mac Image using the Create Disk Image task.

To create a Mac image

1. In the Create Disk Image dialog, select Mac Image (*.dmg) from the Imaging 
Tool drop-down list.
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2. (Optional) Provide the disk number in the Additional Parameters field using the 

following format:

-d[disk#]

By default, all partitions of disk 1 are imaged. To image a different disk, provide the 
disk number in the Additional Parameters field using the same format.

3. Choose from one of the following options to add the path and file name for the disk 
image:

Specify the share using the following format:

afp://server/sharepoint/path/filename.dmg

Provide credentials using the following format:

afp://username:password@server/sharepoint/path/filename.dmg

If no credentials for this server are provided in the automation configuration, the 
guest account is used by default.

Warning!
These credentials are passed unencrypted and can be read by a network sniffer.

Caution
The captured disk image must be stored on an AppleTalk Filing Protocol (AFP) share.

4. Select Disable image path validation.

The image file is stored outside of the Deployment Share file structure. If you do not 
select this option, a warning message appears, reminding you to configure your 
automation process to use the path indicated in the Name field. You can still save 
your image to a location outside of the Deployment Share file structure even when 
you do not select this option. This option eliminates the warning message.

5. (Optional) Select the Do not boot to Production option if you do not want the 
computer to boot to Production before creating the image.

6. From the Automation pre-boot environment (DOS/WinPE/Linux) drop-down 
list, select the required pre-boot environment to perform the Create Disk Image 
task in the selected pre-boot environment. By default, the Default Automation 
(Auto-select) type is selected.

7. Click Next. The Return Codes dialog appears.

8. (Optional) Set Return Codes. See Setting up return codes on page 193.

9. Click Finish. The task appears in the Task list for the job. The Mac image is created 
when you run this task.

Note
The Sysprep settings option is disabled if you select Mac Image as the Imaging Tool. 
The Automation pre-boot Environment for Mac Image is the Default Automation 
when capturing Mac images.

Creating a Ghost image 
Symantec™ Ghost Solution Suite is a corporate imaging and deployment solution. It also 
provides operating system migration, software distribution, computer personality 
migration, hardware and software inventory, and secure system retirement.
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For more information about Ghost, see the Ghost Imaging Foundation documentation.

You can create a Ghost Image using the Create Disk Image task.

Important
To use the Ghost Solution for creating a disk image, you have to store the ghost.exe and 
ImageTools.ini files in the Program Files\Altiris\eXpress\Deployment Server directory.

To create a Ghost image

1. In the Create Disk Image dialog, select Ghost Image (.gho) from the Imaging 
Tool drop-down list.

2. Add additional parameters in the Additional Parameters field.

3. Enter the path and file name to store the disk image. 

4. (Optional) To disable the validation of the image path, select the Disable image 
path validation check box. This is useful if the image is stored locally, or if you are 
retrieving the image from a remote server.

5. To use Microsoft Sysprep, select the Prepare using Sysprep check box and specify 
the operating system and product key.

6. From the Automation pre-boot environment (DOS/WinPE/Linux) drop-down 
list, select the required pre-boot environment to create the disk in the selected pre-
boot environment.

By default, the Default Automation (Auto-select) type is selected.

7. Click Next.

The Return Codes dialog appears.

8. (Optional) Set Return Codes. See Setting up return codes on page 193.

9. Click Finish.

The task appears in the Task list for the job. The Ghost image is created when you 
run this task.

Advanced Sysprep settings for creating a disk 
image
You can use the Sysprep Advanced Settings dialog to specify Sysprep mass storage 
device support. By default, the Enable mass storage device support using built-in 
drivers (For Windows XP and 2003 only) option is selected.

Disable mass storage device support. When this option is selected, the Sysprep.inf 
file contains the section [Sysprep] with the key value pair as 
BuildMassStorageSection = No.

Enable mass storage device support using built-in drivers. When this option is 
selected, the Sysprep.inf file contains the section [Sysprep] with the key value pair as 
BuildMassStorageSection = Yes.

Enable mass storage device support using following: When this option is selected, 
the Sysprep.inf file contains the section [SysprepMassStorage] and is appended by 
contents of the file mentioned in the Mass storage section file field. You can also copy 
the drivers directory mentioned in the Mass storage drivers field.

Command-line switches. You can add command-line options.
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Advanced Sysprep settings for creating a disk 
image in Windows Vista
You can use the Sysprep advanced settings dialog to specify the settings for any 
Windows Vista operating system. If you select Windows Vista as the operating system 
under Sysprep settings on the Create Disk Image dialog and click Advanced 
Settings, the Sysprep advanced settings dialog for Windows Vista appears. This 
dialog lets you select Plug-n-Play (PnP) drivers options, as well as Sysprep options, such 
as command-line options.

Create disk image advanced
Media Spanning

Maximum file size. The maximum file size supported is 2 GB. To save an image larger 
than 2 GB, the Deployment Server automatically breaks it into separate files regardless 
of your storage capacity. From the Maximum file size drop-down list, select a media 
type.

Specify ___ MB. If the preferred type is not on the list, select Other (specify) and 
enter the required file size in the Specify ___ MB field.

Additional Options

Compression. Compressing an image is a trade-off between size and speed. 
Uncompressed images are faster to create, but use more disk space. 

Select Optimize for Size to compress the image to the smallest file size. Select 
Optimize for Speed to create a larger compressed image file with a faster imaging 
time. The default setting is Optimize for Speed.

Note
Configuration restoration after imaging a compressed drive is not supported for this 
release.

Description. (Optional) Enter an image description to help identify the image and click 
OK.

Distributing a disk image
Distribute an RDeploy, ImageX, Mac, or Ghost image file to managed computers to 
deploy a previously created hard disk image.

Deployment Solution supports hardware independent imaging through DeployAnywhere. 
DeployAnywhere requires Windows PE on 32-bit automation only.

DeployAnwhere creates a hardware abstraction layer (HAL) and updates network drivers 
and storage drivers. It performs post-imaging functionality while you are still in 
automation mode.

You can use the following switches with DeployAnywhere:

/logPth that specifies the fully qualified path where the DA log files are written.

/logID that specifies the ID to prepend to the log file name.

For more information about DeployAnywhere or Ghost, see the Symantec Ghost Imaging 
Foundation documentation.
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Note
If you deploy a Windows image over a Linux computer or a Linux image over a 
Windows computer, you must change the path of the Deployment Agent for the 
Windows log file.

To distribute a disk image

1. Open the New Job Wizard and select Deploy and configure computers and click 
Next. The Job conditions page appears. (See Setting up conditions in the new job 
wizard on page 150.) Click Next.

or

In the Jobs pane in the Deployment Console, select a job. In the Details pane, click 
Add and select Distribute Disk Image.

2. In the Disk Image Source page, click Select a disk image file to select a stored 
image file. This lets you set down a new image file from a previously imaged 
computer. Enter the name of an existing image file.

If you do not want the Deployment Server to validate the selected path, select 
Disable image path validation. This is useful if the image is stored locally, or 
if you are retrieving the image from a remote server.

3. Click Select a computer on the network to image a source computer on the 
network. Enter the name and location of the source computer to both create an 
image and distribute the newly created image file.

This option saves an image of a selected computer’s hard disk in its current state 
each time the job runs. You can schedule the job to image a specified computer 
every time it runs, which updates the image each time.

Select the Save the disk image as a file while distributing option to save 
the newly created image file. If you use a reference computer as the image 
source, you can also choose to save the image as a file for later use. Enter or 
browse to the location where you want to store the file.

4. Select Prepared using Sysprep to use Sysprep to prepare the system for imaging. 

5. From the Operating System drop-down list, select the operating system.

Note
Click Add New to open the OS Product Key dialog and select the OS Information.

6. From the Product Key drop-down list, select the product key.

7. Click Advanced Settings to open the Sysprep Advanced Settings dialog. See 
Advanced Sysprep settings for distributing a disk image on page 166.

8. Enter the required Additional Parameters.

 

Distribute a hard disk image using the New Job Wizard or adding the 
Distribute Disk Image task when building new jobs. You can create the disk 
image file using the Create a Disk Image task. See New job wizard on 
page 146, Building new jobs on page 150, and Creating a disk image on 
page 157.
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9. Select Automatically perform configuration task after completing this 

imaging task to restart the computer and push the configuration settings to the 
imaged computer.

Note 
If you clear this option, a warning appears, confirming that you want to remove the 
configuration step after the image is deployed. As a result, the imaged computer 
may not reconnect to the network.

10. (Optional) Select the DeployAnywhere option if you want to do hardware 
independent imaging.

11. (Optional) Select the Boot to production to complete configuration task.

12. From the Automation pre-boot environment (DOS/WinPE/ Linux) drop-down 
list, select the required pre-boot environment to perform the Distribute Disk 
Image task. By default, the Default Automation (Auto-select) type is selected.

13. (Optional) Click Advanced to resize partitions and set additional options. See 
Distribute disk image-resizing on page 166. Click OK.

14. Click Next.

15. (Optional) Set Return Codes. See Setting up return codes on page 193.

16. Click Finish. The task appears in the Task list for the job. The disk image is 
distributed when you run this task.

See also Deployment tasks on page 155.

Distributing a Mac image
You can deploy a Mac image using the Distribute Disk Image task.

This task deploys only .DMG files that were created using a Create Disk Image task. The 
Distribute Disk Image task cannot deploy an image that was created by Apple Disk 
Utility or the hdiutil tool.

To deploy a Mac image

1. Select the Select a disk image file option.

2. In the Name field, choose from one of the following options to add the path to the 
Mac (.DMG) image:

Specify the share using the following format:

afp://server/sharepoint/path/filename.dmg

Provide credentials using the following format:

afp://username:password@server/sharepoint/path/filename.dmg

If no credentials for this server are provided in the automation configuration, the 
guest account is used by default.

Warning!
These credentials are passed unencrypted and can be read by a network sniffer.

Caution
The captured disk image must be stored on an AppleTalk Filing Protocol (AFP) share.
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3. Select Automatically perform configuration task after completing this 

imaging task to run the configuration task after the imaging task is complete.

4. Click Next. The Return Codes dialog appears.

5. (Optional) Set Return Codes. See Setting up return codes on page 193.

6. Click Finish. The task appears in the Task list for the job. The Mac image is 
deployed when you run this task.

Note
The Image is stored locally on the client and the Sysprep settings options are 
disabled when you select a Mac image. The Select a computer on the network 
feature is not supported when using Mac Imaging. The Automation pre-boot 
Environment for Mac Image is Default Automation when deploying Mac images. 
This option uses the NetBoot architecture that was previously set up. For more 
information, see topics on NetBoot in the Administration Guide.

Distributing a Ghost image
You can distribute a Ghost (.GHO) image using the Distribute Disk Image task.

For more information about Ghost, see the Symantec Ghost Imaging Foundation 
documentation.

To distribute a Ghost image

1. On the Distribute Disk Image dialog, select the Select a disk image file option.

2. Browse and select a .GHO image.

If you do not want the Deployment Server to validate a selected path, select 
Disable image path validation. This is useful if the image is stored locally, or if 
you are retrieving the image from a remote server.

3. To use Sysprep to distribute the image, select Prepared using Sysprep.

4. From the Operating System drop-down list, select the operating system.

Note
Click Add New. From the Sysprep Settings dialog, select the operating system 
information.

5. From the Product Key drop-down list, select the product key.

6. Add any additional parameters in the Additional Parameters field.

7. To restart the computer and push the configuration settings to the imaged 
computer, select Automatically perform configuration tasks after completing 
this imaging task.

8. From the Automation pre-boot environment drop-down list, select the required 
pre-boot environment to perform the Distribute Disk Image task.

By default, the Default Automation (Auto-select) type is selected.

9. Click Next.

10. (Optional) Set Return Codes. See Setting up return codes on page 193.

11. Click Finish.
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The task appears in the Task list for the job. The Ghost image is deployed when you 
run this task.

Advanced Sysprep settings for distributing a disk 
image
You can generate the Sysprep.inf file for the Distribute Disk Image task, depending 
on the option selected in the Advanced Sysprep Settings dialog.

Use default answer file. When this option is selected, the Deployment Server 
generates the Sysprep.inf file depending on the data present in the database.

Use the following answer file. When this option is selected, the Deployment Server 
picks up the contents of the file mentioned in the Sysprep answer file field and prepares 
the Sysprep.inf file from it.

Advanced Sysprep settings for distributing a disk 
image in Windows Vista
You can use the Sysprep advanced settings dialog to specify the settings for any 
Windows Vista operating system. If you select Windows Vista as the operating system 
under Sysprep settings on the Distribute Disk Image dialog and click Advanced 
Settings, the Sysprep advanced settings dialog for Windows Vista appears. This 
dialog lets you select Sysprep answer file options.

Distribute disk image-resizing
By default, whenever you deploy an image, you have the option to resize the partition to 
take advantage of the available disk space. Drive Size gives you information about the 
size of the image, so you can determine if you need to change partition sizes. Minimum 
indicates the amount of space the image will use on the target computers. Original 
indicates the image source disk size.

Fixed Size. Select this option and enter the desired partition size. 

Percentage. Select this option and enter the percentage of free space you want the 
partition to occupy.

Min. View the minimum size of the partition.

Max. View the maximum size of the partition.

Note
FAT16 file systems have a 2 GB limit and cannot be resized larger than that (although 
they can be resized smaller than the minimum value). HP partitions remain a fixed size.

Distribute disk image-additional options
This option lets you specify operations for existing Automation Agents and OEM disk 
partitions. The options are as follows: leave the partition as it is, remove, or replace the 
existing partitions. If the image file does not contain any information for an automation 
or OEM partition, the default option is to leave the client’s existing Automation or OEM 
partition as it is.
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RDeploy options:

Graphical Mode[RDeploy]. Click this option to choose RDeploy as the imaging 
executable.

Text Mode[RDeployT]. Click this option to choose RDeployT as the imaging 
executable. Text Mode or RDeployT is the default choice.

Automation partition:

Leave the client's existing Automation partition as it is. If the image file contains 
no automation partition information, by default, this option is selected. The automation 
partition remains unchanged when distributing disk images.

Delete the client's Automation partition [-nobw]. Select this option to delete the 
existing Automation partition from client computers.

Replace the client's existing BW partition from image file [-forcebw]. Select this 
option to replace the existing automation partition on the client computer with the 
automation partition from the image file.

OEM partition:

Leave the client's existing OEM partition as it is. If the image file contains no OEM 
partition information, by default, this option is selected. The OEM partition remains 
unchanged when distributing disk images.

Delete the client's OEM partition [-nooem]. Select this option to delete the existing 
OEM partition from client computers.

Replace the client's existing OEM partition from image file [-forceoem]. Select 
this option to replace the existing OEM partitions on the client computer with the OEM 
partition from the image file.

Additional Command line switches. You can add command-line options specifically 
for the RapiDeploy program that runs imaging tasks.

Note
The checkdisk command-line option should not be used from a Deployment Console. 
The post-configuration task fails after an image restore.

See also Deployment tasks on page 155.

Imaging computers from USB disk on key (DOK) 
devices (JumpDrives)
Deployment Solution supports imaging clients from bootable USB Disk on Key (DOK) 
devices.

To image computers from USB disk on key devices

1. Format the USB DOK using HP’s USB Disk Storage Format tool as FAT and make it a 
DOS startup disk.

2. In Boot Disk Creator, create a new automation boot disk while creating a new 
configuration.

3. Select Bootable disk-Removable disk to install on the USB Disk on Key.

4. Copy HIMEM.SYS to the device.
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Copy RDeployT.exe from the <InstallPath>\eXpress\Deployment Server\RDeploy\DOS 
directory to the device.

5. Copy the <Filename>.img file to the device.

6. Create an Autoexec.bat with the script and command-line option, rdeployt -md -
fc:\IMAGE.img -d2 

Note 
The -d2 switch is the most important part of the script, as it specifies the flash drive.

7. Create a Config.sys with the following:

DEVICE=C:\HIMEM.SYS

switches = /f

DOS=HIGH,UMB

SHELL=command.com /p /E:1024

BUFFERS=20

FILES=20

STACKS=0,0

FCBS=1,0

LASTDRIVE=Z

8. Boot from the USB Disk on Key (recognized as C:) and rdeployt executes and 
images correctly.

Scripted OS install
The Scripted OS Install task performs remote, automated, and unattended operating 
system installations over the network using answer files to input configuration and 
installation-specific values. Scripted installs let you deploy server and client computers 
across the network from installation files and perform post-installation configuration 
tasks. You can run scripted installs for Windows or Linux computers.

Note
Scripted Install requires either an automation boot disk or a PXE Server. Using 
embedded automations causes the selected image (DOS, Linux, WinPE) to load and halt. 
It does not let the scripted install run.

When running a Scripted OS Install task, you can identify the type of operating system 
to install for supported languages, run the scripted install, and update with service pack 
installations. This task provides easy-to-use features to create an answer file for each 
scripted installation.

Scripted installs are flexible in performing post-configuring tasks, but much slower and 
bandwidth-intensive. Complete network and Web server installation and configuration 
tasks benefit most from scripted installs.

Windows. Use complete unattended install features to copy Windows operating system 
source files quickly to the Deployment Share and easily create an answer file. 
Configured operating system install sets can be reused to build and run scripted install 
jobs as needed. See Scripted install for Windows on page 169.
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Linux. Run scripted install jobs to remotely install different versions of Linux. You can 
customize sample scripted install jobs installed with the Deployment Server system and 
create a kickstart answer file to remotely run a scripted install. See Scripted install for 
Linux on page 175.

Scripted install for Windows
1. After selecting Add > Scripted OS Install, select the Windows option and click 

Next.

2. Select the type of Windows operating system to install and the preferred language. 
See Select OS version and language on page 170. Select the required pre-boot 
environment from the Automation - PXE or BootWorks environments (DOS/
WinPE/Linux) Automation pre-boot environment (DOS/WinPE/Linux) drop-
down list to perform the Distribute Disk Image task in the selected pre-boot 
environment. The option reported by the PXE Manager is the default pre-boot 
environment option. By default, the Default Automation (Auto-select) type is 
selected. Click Next.

3. From the Select or add new OS source files drop-down list, select the operating 
system source files already copied to your Deployment Share. See Installation 
source files on page 171.

Click Add New from the list to set up the new operating system installation files. 
See Operating system-source files on page 171.

Click OK after entering a unique name and the path to the operating system 
installation source files. The source files will be copied to the Deploy folder in the 
Deployment Share directory. The first source files added are given a generic name 
of WinOS001, with additional operating system source folders named as WinOS002, 
WinOS003 and so on. Service Pack source files are also stored as WinSP00x.img 
files.

This process could take a few minutes. Because the installation source files are 
copied over to the Deployment Share, when running subsequent scripted installs 
you do not need to add new source files for this version of Windows. They can be 
selected from the list of installation source files. See Installation source files on 
page 171.

Note
When importing Scripted Install jobs, you must edit the job files to point to the 
installation source files on the new Deployment Server system. This requires you to 
run the Scripted Install for Windows wizard and modify the path and name of the 
folder for the Installation Source Files for the exported jobs. This is required for both 
the main installation and the service pack installation files. See also Scripted install 
for Windows on page 169, Installation source files on page 171, and Importing and 
exporting jobs on page 193.

4. After the source files are copied, select the newly created operating system source 
name from the Installation Source Files list. Click Next.

5. In the Partition and Format Disk page, click Select a DOS disk image to 
distribute a DOS disk image (default), or click Continue without distributing 
DOS image to partition and format the hard disk of the destination computer using 
custom scripts or setup utilities. Click Advanced to set partition size, delete hidden 
partitions or set RapiDeploy command-line parameters. Click Next. See Operating 
system-source files on page 171.
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Note
Before running a scripted install, you must install DOS. However, DOS is not 
required if you are using your own scripts or utilities to partition and format the 
client computer. 

6. Import an answer file to the Deployment Database. See Import an answer file on 
page 172. Click Next.

7. Create the Answer file. See Answer file setup on page 172. Click Next.

8. Set command-line options for cmdlines.txt files and for the WINNT installation 
program. See Command-line switches for scripted install on page 173. Click Next.

9. View and modify the Deployment Agent for Windows configuration file from the 
dialog. See Deployment agent settings for scripted install on page 173. Click Next.

10. View the summary of the selected options. See Scripted install summary on 
page 174. Click Next.

11. Set up return codes for the Scripted Install task. See Setting up return codes on 
page 193. Click Finish. The task appears in the Task list for the job.

See also Scripted OS install on page 168.

Select OS version and language
Identify the operating system version to run in a scripted install. The selected version 
and language must correspond to your Windows installation files.

We support multiple languages for the following Deployment Solution utilities:

Boot Disk Creator

Image Explorer

PXE Configuration Utility

Remote Client Installer

Control Panel Applet

DS Info

PW Util (Password utility)

Switch Management 

Select the operating system version. Select the Windows operating system you want 
to install from the list. Click Template if you want to install another version or language 
of a Windows operating system not provided in the list.

Select the operating system language. Select the language version of the operating 
system to install. The language must correspond to the operating system source files. If 
you selected the Template option, only the Multilingual language option can be selected 
(this is a generic language option).

Automation (Pre-boot Environment). Select the required pre-boot environment 
from the Automation (Pre-boot Environment) drop-down list. The option reported by the 
PXE Manager is the default pre-boot environment option.

List of supported multiple languages:

German 
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French 

Spanish 

Japanese 

Simplified Chinese

See also Scripted install for Windows on page 169.

Installation source files
If you copied installation files to the Deployment Share for previous scripted installs, the 
name of this install source configuration appears in the list box for each operating 
system type and language. To create new source configuration sets for additional 
operating system installs, select Add new from the drop-down list.

Select or add new operating system source files. Select the assigned name for 
each operating system source configuration in the list, or select Add new from the list 
to create a new install task. Previous scripted install jobs will create a WinOS00x.img file 
in the Deploy directory of the Deployment Share.

The Operating System-Source Files dialog lets you identify the version of Windows 
install files and enter the path to the files (on the CD or other medium).

Select or add new service pack source files. Run service pack updates immediately 
after installing the operating system during the scripted install process. Previous 
scripted install jobs will create a WinSP00x.img file.

See also Scripted install for Windows on page 169.

Operating system-source files
Name the operating system source configuration, specify the path, and automatically 
copy Windows installation files to the Deployment Share.

Enter a unique name for the operating system source files. Enter a name for the 
operating system source configuration files to assign an alias to associate with the install 
files for a specific operating system version and language.

Enter path to operating system source files. Enter the path to the I386 folder on 
the CD where the Windows installation programs and support files are stored. Example: 
Browse to the CD drive and select I386\WINNT.exe. Click Open.

The Windows operating system identified previously in the Installation Source Files 
dialog must match the source files selected here. If the name and language of the 
operating system does not match the installation files, you receive an error.

Click OK and the files will copy from the source CD (or other volume) to the Deployment 
Server\Deploy directory in the Deployment Share. This process will take a few minutes.

Enter a short description. (Optional) Enter a description of the Windows operating 
system source configuration. Example: W2K Advanced Server SP3 English.

See also Scripted install for Windows on page 169.

Partition and format disk
Select a DOS disk image to distribute to the client computers before starting the 
Windows scripted install. A DOS image is provided in the Images directory in the 
Deployment Share (default path in the Name field).
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Select a DOS disk image. Click this option to distribute a DOS image from the 
Deployment Share. The Deployment Server system includes a DR DOS image file that is 
selected by default. You can create your own MS DOS image from your Windows CD and 
build a job.

Advanced. Select advanced options to set the size of the partitions, or to remove 
hidden partitions and add command-line options.

See Create disk image advanced on page 162 and Distribute disk image-resizing on 
page 166.

Continue without distributing DOS image. Click this option to not install a DOS 
image from Deployment Server. Skip this step if you are installing DOS using custom 
procedures for your environment.

See also Scripted install for Windows on page 169.

Import an answer file
Reference a previously created answer file for a Windows scripted install. You can also 
view a summary of the operating system source configuration.

Import existing unattend.txt. Select to import a previously created answer file to the 
Deployment Database. The values for the answer file are imported from the delimited 
text file and appear in the Answer File Setup dialog. 

Path of the unattend.txt. Enter a path and select an answer file with any name. The 
answer file is imported to the database, edited in the console (if required), and 
distributed as an unattend.txt file to the client computer.

See also Scripted install for Windows on page 169.

Answer file setup
Use the tabs in this dialog to enter values to create an answer file for a scripted install. 
These values are stored in the Deployment Database. An answer file is generated from 
the database (unattend.txt) and distributed to each managed computer when the job 
runs. 

In the Answer File Setup dialog, select a value (a row) in the table. A list appears in 
the Values column to change values for each entry. You can add new variables to each 
section by selecting the bottom row named Add new Variable. To add a new section to 
the answer file, click the right arrow until the Add new Section tab appears (the last 
tab on the right).

The required answer file values are selected automatically in the dialog with a gray 
check mark (you cannot clear these variables). Optional but selected values have a 
green check mark. Other optional values are cleared. Select these optional values if you 
want to add them to the answer file when it is generated.

The various tabs in the Answer File Setup dialog correspond to the general answer file 
sections. See the Microsoft Windows Unattended Setup Guide for specific values for an 
unattended setup file.

See also Scripted install for Windows on page 169.

Add a new section
Use this dialog to add new variable sections to the answer file.
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Enter a name for the section. If you add a section, this name appears in the new tab 
in the Answer File setup dialog.

Enter a description. Enter comments to describe the new section.

See the Microsoft Windows Unattended Setup Guide for your specific operating system 
values for an unattended setup file. 

See also Scripted install for Windows on page 169.

Delete a section
To delete a new section that you added, right-click the section and select Delete 
selected Section.

Add a new variable
Use the New Variable for Section “Unattended” dialog to add new variables to the 
answer file. This variable appears as a row in the Answer File Setup dialog.

Name of the variable. Select a variable name.

Type of the new variable. Select a variable data type. The Default value of the 
variable and Displayed value of the variable fields are enabled depending on the 
variable type selected.

Default value of the variable. Enter values for a list, text, password, IP address, or 
variable only types.

Displayed value of the variable. Enter an alias for list item types to appear instead of 
the real variable value.

Description. Enter comments to describe the new variable. It appears in the 
Description column of the Answer File Setup dialog.

See also Scripted install for Windows on page 169.

Command-line switches for scripted install
Use the Scripted OS install commands dialog to enter Windows commands that are 
executed from the cmdlines.txt file. You can also add scripted install command-line 
options.

Switches. Add or edit switch commands to this line for the install program for the 
scripted install.

Additional commands in the cmdlines.txt file. Enter additional Windows scripted 
install commands in this dialog. The commands execute in the order they are listed. The 
provided command installs the Deployment Agent for Windows during the Install 
Component phase of the installation. You can view and edit Deployment Agent settings 
in the next dialog.

See also Scripted install for Windows on page 169.

Deployment agent settings for scripted install 
View or edit Deployment Agent for Windows settings in this dialog. You can change 
agent settings using this text-edit dialog. See Deployment agent settings on page 110 
for a list of the Deployment Agent properties.
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See also Scripted install for Windows on page 169.

Scripted install summary
View a summary of the selected options for the scripted install. Click Back to change 
any of these settings or click Finish to complete the Scripted Install task. Click Next to 
set up return codes. See Setting up return codes on page 193.

See also Scripted install for Windows on page 169.

Scripted install for Windows Vista and 2008 server
The Scripted OS install for Windows Vista and Windows 2008 Server provides a wizard 
to help set up Vista and Windows 2008 Server installation files and run sample jobs. 
Follow the steps in the wizard to identify the type of scripted install as Vista or Windows 
2008 Server. You can gather all the files for Vista or Windows 2008 Server for the job, 
but the server does not build any answer file. Instead, you are asked for the location of 
the answer file. Also, a sample answer file is provided.

To perform a scripted install for Windows Vista and 2008 server

1. On the Scripted Operating System Installation page of the Scripted OS Install 
dialog, select the following options:

Windows Vista or Windows 2008 Server as the operating system

Operating system language

Automation pre-boot environment

Note
Deployment Solution supports only WinPE environments.

Click Next.

2. From the Select or add new OS source files drop-down list on the Installation 
Source Files page of the Scripted OS Install dialog, select Vista or Windows 2008 
Server.

3. (Optional) You can select the required option from the Select or add new service 
pack source files drop-down list. Click Next.

4. Select the Select a DOS disk image\Diskpart tool option on the Partition and 
Format Disk page of the Scripted OS Install dialog to partition and format the 
disk. Click Next.

Note
You can select the Continue without selecting DOS image\Diskpart Tool 
option to partition and format the hard disk using your own scripts and setup 
utilities.

5. On the Scripted Operating System Installation page of the Scripted OS Install 
dialog, browse to select the path of the unattended .XML file.

6. On the Scripted OS Install Commands page of the Scripted OS Install dialog, 
set the command-line options for the cmdlines.txt files and enter the Additional 
commands in the cmdlines.txt file. (See Command-line switches for scripted 
install on page 173.) Click Finish. The job
Altiris Deployment Solution™ from Symantec User’s Guide 174



 

Note
If you want to use the sample answer files (Vista_unattend.xml and 
Longhorn_unattend.xml) provided by default in the Deploy folder of the Deployment 
Share, you must enter the product key (for the version you want to install) before 
you schedule the job. (See OS product key dialog on page 84.) If you do not select 
the product key, the job fails.

Scripted install for Linux 
The Scripted OS install for Linux provides a wizard to help set up Linux installation files 
and run Sample jobs. Follow steps in the wizard to identify the type of scripted install 
and locate the answer files. You can also modify and run Sample deployment jobs to 
remotely run a scripted install on Linux servers and workstations.

Directory. Browse to or enter the path and name of the Linux answer file (Kickstart 
file).

Command-line. Enter the command-line options.

Automation pre-boot environment (DOS/WinPE/Linux). Select the required pre-
boot environment from the drop-down list to perform the Backup and Restore task in the 
selected pre-boot environment. By default, the Default Automation (Auto-select) type is 
selected.

See also Scripted OS install on page 168 and Scripted install for Windows on page 169.

Scripted install summary
View a summary of the selected options for the scripted install. Click Back to change 
any of these settings or click Finish to complete the Scripted Install task.

Distributing software
Send .MSI Packages, .CAB, .EXE, and other package files to selected computers or 
computer groups, including EBS, and .RPM files for Linux computers. This task identifies 
valid Altiris packages and assigns passwords and command-line options.

1. Enter the name and location of the package to distribute in the Name field. 

Note
Information about the package appears in the Description field for valid packages. 
If no description appears, the file is not an .RIP or a Personality Package.

2. For .RIPs, if you set the password option when you created the .RIP, you must 
enter the password for the package to run.

3. Select Run in quiet mode to install the package without requiring user interaction.

4. Specify the users to associate with the .RIP or the Personality Package.

 

Distribute software packages to managed computers using the New Job 
Wizard or adding the Distribute Software task when building new jobs. 
See New Job Wizard on page 130 and Building New Jobs on page 134.
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Select Apply to all users to run the package for all users with accounts on the 
computer.

If you want to send the package to a managed computer with multiple users 
and to install it for certain users with a unique password, clear the Apply to all 
users box. 

Example: To install an .RIP for a specific user account on a computer, add values 
to the Additional command-line switches field: 

-cu:”JDoe;TMaya;Domain\BLee”

Note
The command-line switches are specific to any package you are distributing that 
supports command-line options, such as .MSI and Personality Packages. For a 
complete list of command-line options, see the Wise MSI Product Guide and the 
Altiris PC Transplant Pro Product Guide.

5. If distributing an install package or other types of packages with associated support 
files, you can select Copy all directory files to install all peer files in the directory. 
Select Copy subdirectories to distribute peer files in the directory and all files in 
associated subdirectories.

Note
Some clients may have software installed on the client computer that, for protection 
against harmful software, only lets software programs on a list of "well-known" 
executables to run. Therefore, whenever the system administrator wanted to install 
a patch on client computers, he or she would have to update the well-known-
executables list on all the client computers, which could be a lot of work.

To save the work of updating that list, or of manually renaming distribution 
packages, the RenameDistPkg feature was added. Now, the system administrator 
may update the well-known-executable list once with a filename of their choice. The 
well-known filename may be entered into the Windows registry of the Deployment 
Server computer (the computer running axengine.exe) as the Value data of a string 
value named RenameDistPkg under the 
HKEY_LOCAL_MACHINE\SOFTWARE\Altiris\Altiris eXpress\Options key. If the 
RenameDistPkg registry entry is set, Deployment Server renames the installation 
files that are copied to the client computers.

This feature only affects files that are temporarily copied to the client computer as 
part of a Distribute Software task. The file that is to be executed only during the 
installation, sometimes referred to as the package, is the file that is renamed, not 
the files that are actually installed to various locations on the target computer.

If the Copy all directory files option is enabled, only the main (installable) file is 
renamed.

6. Click Advanced to specify how files are distributed to the managed computer. You 
can copy through the Deployment Server, or copy directly from the file source and 
then run, or run directly from the file source. See Distribute software advanced on 
page 177. Click Next.

7. Provide additional command-line options for distributing software.

8. (Optional) Set Return Codes. See Setting up return codes on page 193.

9. Click Finish. The task appears in the Task list for the job. The software is distributed 
when you run this task.
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Notes
When an .RIP or Personality Package is executed through Deployment Server, the quiet 
mode command-line option is applied. This means the user cannot interact with the user 
interface on the managed computer. 

If the Personality Package is configured to run only if a particular user is logged in and 
only if the user has an account on the managed computer, the package runs the next 
time that user logs in. If the user does not have an account, the package aborts and 
sends an error back to the console through the Deployment Agent. If the package is not 
run through the Deployment Server, a message appears on the managed computer and 
the user is prompted to abort or continue.

See also Modifying tasks in a deployment job on page 190.

Distribute software advanced
Copy files using Deployment Server then execute. Select this option to distribute 
packages through the Deployment Server to the managed computer, requiring two file 
copy transactions if the Deployment Share is on another file server. This option is run for 
Simple installs and is the default option.

Copy directly from file source then execute. Select this option to copy packages 
directly from the Deployment Share if this data store is located on another server (a 
Custom install). It copies the file and runs it, avoiding running through the Deployment 
Server and reducing processor output.

Run directly from file source. Select this option to run files remotely from the 
Deployment Share or another selected file server. 

Specify user. Enter the user name and password for the client computer and the 
Deployment Share. Both must have the same user name and password (this is not an 
issue if both are on the same domain).

Run script in console user session. For Windows 2008, Vista, and Windows 7, you 
can see the output of jobs on a local desktop and use that output for debugging 
purposes. The script runs in a logged-in user’s UI session. If no users are logged in, the 
job fails. DAgent can also run scripts in a console user session.

Managing the SVS layer
The Manage SVS Layer task lets you instantly activate, deactivate, or reset SVS layers. 
This task helps in avoiding conflicts between applications, without altering the base 
Windows application. You can reduce the testing time for applications, as you can install 
different versions of an application on the layers at the same time, and activate or 
deactivate the layers as required. For more information on SVS Help, refer to Software 
Virtualization Solution on page 78.

Note
This task runs only on Windows computers.
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1. After creating a job, click Add > Manage SVS Layer.

2. Enter the .VSA file name in the Layer name drop-down list, or browse and select a 
.VSA file. You can also enter a .VSA file path in the Layer name drop-down list. The 
Deployment Console checks if the path entered is correct. If it finds that the file 
path is correct and it is a valid .VSA file, it replaces the path name with the layer 
name in the .VSA file.

Note
The console displays a list of the previously selected layers in the Layer name 
drop-down list. This makes it easier for you to select a layer from the list, instead of 
browsing or typing the .VSA file name again.

3. Select Import Package to import the selected layer and apply the actions present 
in the Action drop-down list. The actions are:

4. Click Advanced to copy files using the Deployment Server or copy files directly 
from the file source. See Importing package advanced on page 179.

5. Select Manage Layer to manage the selected layer using actions present in the 
Action drop-down list. The actions are:

Manage the SVS Layer using the New Job Wizard or adding the Manage 
SVS Layer task when building new jobs. See New job wizard on page 146 
and Building new jobs on page 150.

Action Name Description

(none) Only import package.

Activate Import package and immediately activate it.

Activate on 
startup

Import package and activate it on startup.

Activate and 
Activate on 
startup

Import package, and immediately activate it and activate it 
whenever the computer starts up.

Action Name Description

Activate Activate layer.

Activate on 
startup

Activate layer on startup.

Activate and 
Activate on 
startup

Activate layer and activate it whenever the computer starts up.

Deactivate Deactivate layer.
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6. Select User defined action to enter a command line.

7. (Optional) Set Return Codes. See Setting up return codes on page 193.

Note
SVS clients have an automatic 120-day license. To purchase a permanent license, please 
visit the Altiris Sales Web site (www.altiris.com/sales.aspx).

Importing package advanced
Copy files using Deployment Server. Select this option to copy files using the 
Deployment Server.

Copy directly from file source. Select this option to copy files directly from their 
source. If you select this option, you must enter the following File source logon 
details:

User name. Enter the user name.

Password. Enter the password.

Confirm Password. Enter the password again.

Click OK.

Capturing personality settings 
The Capture Personality task lets you save personal display and user interface settings 
defined in the operating system for each user. You can create a Personality Package that 
you can save and distribute when migrating users. This task runs Altiris PC Transplant 
from the console to capture and distribute settings.

1. After creating a job, click Add > Capture Personality.

Deactivate on 
startup

Deactivate layer on startup.

Deactivate and 
Deactivate on 
startup

Deactivate layer and deactivate it on startup.

Delete Delete layer.

Reset Reset layer.

Reset and 
Activate

Reset and activate layer.

Reset and 
Deactivate

Reset and deactivate layer.

 

Capture personality settings using the New Job Wizard or adding the 
Capturing Personality task when building new jobs. See New job wizard 
on page 146 and Building new jobs on page 150. Also see Distributing 
personality settings on page 181 to migrate settings to another user.

Action Name Description
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2. Enter the name of a personality template file, or browse and select a template. A 

default personality template is included in the PCT folder of the Deployment Share 
(DEFAULT.PBT). Enter the name of the folder where you want to store the package.

The personality template lets you define the settings, files, and options to be 
captured during run time. Click Template Builder to open a wizard to build a 
custom template.

3. In User account and folder login, enter the login credentials for the managed 
computer from which the personality settings are captured, and the file server 
where the Personality Package is stored. 

4. In Package login, enter a password for the Personality Package. This is a run-time 
password that is required when the Personality Package runs on the destination 
computer.

5. Click Advanced to specify additional features.

6. Set the Advanced options and click OK. Click Next. See Capture personality 
advanced options on page 180.

7. (Optional) Set Return Codes. See Setting up return codes on page 193.

8. Click Finish. You have now created a Capture Personality task, which appears in the 
Task list. You must schedule this task to capture a personality setting and save it as 
a PCT file in the selected location (most often in the PCT folder on the Deployment 
Server shared directory on the Deployment Share). See Distributing personality 
settings on page 181.

Note
Set the conditions on the job for either Windows XP, 2003, 2008 and Vista computers to 
ensure that the appropriate Capture Personality task runs on the appropriate computers.

Capture personality advanced options
Domain users. Select this option to capture personality settings for all domain users on 
the computer.

Local Users. Select this option to capture personality settings for all local users on the 
computer. 

Custom. Specify users or groups to capture personality settings. Select the Custom 
check box and enter the Users or Groups you want to capture personality settings. 
Also, instead of specifying names, you can also select users who have been either 
created or accessed in the specified number of days.

Additional command-line switches. You can add command-line options specifically 
for the PC Transplant program that migrates personality settings. See the Altiris PC 
Transplant Reference Guide in the docs folder of the Deployment Share.

Distributing personality settings 
The Distribute Personality task lets you save personal display and user interface settings 
defined in the operating system for each user. You can distribute Personality Packages to 
migrate personality settings. This task runs Altiris PC Transplant from the console to 
capture and distribute settings.
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1. In the Name field, enter the file name and location of the PCT file.

Note
The information about the Personality Package appears in the Description field for 
valid Personality Packages (PCT files). If no description appears, the file is not a 
valid package. 

If you use a token, such as %COMPNAME%, in this field, and you proceed with the 
job, when you apply the job to a Windows XP computer, the user must enter input 
before the job completes. Altiris recommends you enter a valid Personality Package 
name and use the Additional command-line switches fields for token values. 
See the Altiris PC Transplant Reference Guide for a complete list of valid command-
line options.

2. In the Password field, type the password set for the PCT file when created.

3. Select Run in quiet mode to install the package without displaying the PC 
Transplant screens.

4. Specify the users to associate with the Personality Package.

Select Apply to all users to run the package for all users with accounts on the 
specified computer.

If you want to send the package to a managed computer with multiple users 
and to install it for certain users with a unique password, clear the Apply to all 
users box. 

Example: To install a Personality Package for specific user accounts on a 
computer, add values to the Additional command-line switches field. 
Example:

-user: JDoe; TMaya; BLee

Note
The command-line options are specifically for Personality Packages. For a 
complete list of command-line options, see the Altiris PC Transplant Reference 
Guide.

5. (Optional) Click Advanced to specify how to copy Personality Packages to the 
managed computer. You can copy through Deployment Server and then run, or copy 
directly from the file source and then run, or run directly from the file source. See 
Distribute personality advanced on page 182. Click OK.

6. Click Next.

7. (Optional) Set Return Codes. See Setting up return codes on page 193.

8. Click Finish. The task appears in the Task list for the job. The personality is 
distributed when you run this task.

 

Distribute personality settings using the New Job Wizard or adding the 
Distribute Personality task when building new jobs. See New job wizard 
on page 146 and Building new jobs on page 150. See also Capturing 
personality settings on page 179 to create a Personality Package.
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For more information about capturing a computer's personality settings, see the Altiris 
PC Transplant Help.

See also Distributing software on page 175 and Modifying tasks in a deployment job on 
page 190.

Distribute personality advanced
Copy files using Deployment Server then execute. Select this option to distribute 
software packages through the Deployment Server to the managed computer, requiring 
two file copy transactions if the Deployment Share is on another file server. Use this 
option for Simple Installs to take advantage of security rights defined by Deployment 
Server. This is the default option.

Copy directly from file source then execute. Select this option to copy packages 
directly from the Deployment Share, sending only one copy across the network. It 
copies the file and runs it and avoids running through the Deployment Server and 
diminishing processor output. Because the Deployment Agent doesn't recognize shared 
rights and is not guaranteed to have a mapped drive to the data source, you must 
identify a user name and password for the data share computer from the target 
computer. This option also requires a full UNC path name in the Source Path field in the 
Copy File dialog.

Execute directly from file source. Select this option to run files remotely from the 
Deployment Share or another selected file server.

File source access and credentials. Enter the user name and password for the client 
computer and the Deployment Share. Both must have the same user name and 
password (this is not an issue if both exist in the same domain).

Modifying configuration
You can add a task to configure or modify the configuration of computer property 
settings using the Modify Configuration dialog. The Deployment Agent updates the 
property settings and restarts the computer for changes to take effect.

1. After creating a job, double-click the job, and click Add > Modify Configuration.

2. Select the Reboot after Configuration check box to restart client computer after 
the configuration changes are complete. By default, the check box for Reboot after 
Configuration is selected.

3. Enter or edit the property settings in the Configuration dialog. Click the category 
icons in the left pane to set additional values for each property setting group. See 
Computer configuration properties on page 101.

4. Click Next.

5. (Optional) Set Return Codes. See Setting up return codes on page 193.

6. Click Finish. The task appears in the Task list for the job. The configuration is 
modified when you run this task.

See also Modifying tasks in a deployment job on page 190.
Altiris Deployment Solution™ from Symantec User’s Guide 182



 

Backing up and restoring registry files  

Note
This feature has been deprecated and removed from the product in a later release. 

Copy registry files of selected computers using the Back Up Registry task and save the 
registry file settings to a selected directory. You can also create a Restore Registry 
task to copy the registry settings to a managed computer.

1. Enter the directory path to back up or restore registry files.

2. The Computers with registry files in this directory field displays the names of the 
computers whose registry files will be captured in this directory.

3. Select the required pre-boot environment from the Automation pre-boot 
environment (DOS/WinPE/Linux) drop-down list to perform the Backup and 
Restore task in the selected pre-boot environment. The Default Automation (Auto-
select) type is selected.

4. Click Advanced if Windows was installed on client computers in a directory other 
than the default. Enter the correct path to the root of the Windows directory. 

Select Include registry information for all users to back up registry keys for 
all user accounts.

Note
If you clear this check box, only the Administrator and Guest user accounts are 
backed up or restored.

5. Click Next.

6. (Optional) Set Return Codes. See Setting up return codes on page 193.

7. Click Finish. The task appears in the Task list for the job.

See also Modifying tasks in a deployment job on page 190.

Getting inventory
Use this task to gather inventory from an individual computer or a group of client 
computers. This ensures that the Deployment Database is updated with the latest 
computer properties information, which includes the following information:

Applications

Devices

Drivers

Hardware

Location

 

Copy registry settings by adding the Back Up Registry task when building 
new jobs. Restore registry settings by adding the Restore Registry task. 
See Building New Jobs on page 134.
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Network

Services

TCP-IP

General

Location is the only area that administrators can manually enter if they want to. The 
Deployment Solution software gathers the other information from each computer.

You can view the history of the Get Inventory task in the Computers History pane. See 
Viewing a computer’s history on page 125.

Click Add and select Get Inventory from the list. The Get Inventory task 
appears in the list.

Running a script 
Select an existing script or write a new script file to run on selected managed client 
computers.

1. If you have a script file defined, select Run Script and browse to select the file. To 
read or edit the script file, click Modify.

Note
To run scripts that call an executable, use the start command.

Example: Enter start C:\windows\notepad.exe to open the Notepad application on 
the client computer.

2. To create a new script, click Run Script. Enter the script in the provided field, or 
click Import and select a script file to import. After you import the script, you can 
modify it in the provided field.

3. Specify the operating system to run the script. You can choose Windows, DOS, 
Linux, or Mac OS X. Click Next.

4. Set Script Information. See Script information on page 185. Click Next.

5. (Optional) Set Return Codes. See Setting up return codes on page 193.

6. Click Finish. The task appears in the Task list for the job. The script runs when you 
run this task.

Notes 

When a computer is in an automation mode using a DOS configuration, it does not 
detect DOS partitions. To run a script using the DOS Automation Agent, use FIRM 
(File-system Independent Resource Manager) commands. FIRM can only copy and 
delete files; it cannot run a code on a drive.

The Deployment Server assumes a return code of zero (0) as a successful script 
execution. Some programs return a code of one (1) to denote a successful script 

 

Run script files on client computers by adding the New Script task when 
building new jobs. See Script information on page 185 to identify how the 
script appears, script security, and an option for server-side execution of 
the script. See also Building new jobs on page 150.
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execution. If a program returns a one (1), you see an error message at the 
Deployment Console even though the script ran correctly. To modify the return 
codes, you can edit the script file to return a code that the console interprets 
correctly.

See also Modifying tasks in a deployment job on page 190.

Script information 
Script Run Location

Select one of the following options to run the script:

On the client computer. This option runs the script on the managed computer 
to which you assign the job.

Locally on the Deployment Server. This option runs a server-side script on 
the Deployment Server of the managed computer. In most cases you can create 
a server-side script task that runs in context with other tasks. Example: You can 
add a task to image a computer and add a task to execute a server-side script 
to post the imaging return codes to a log file stored on the Deployment Server 
computer.

Use the -id option for running scripts on Deployment Server when using the 
WLogEvent and LogEvent utilities. See Using LogEvent and WLogEvent in scripts 
on page 186.

Note
You cannot use this feature to run scripts that require user intervention. The 
script runs on the Deployment Server of the managed computer, but is not 
visible. Example: If you run a DOS command locally on the Deployment Server, 
the Command Prompt window does not open on the Deployment Server 
computer when the script runs.

When running the script on the Deployment Server, it runs specifically for the 
assigned managed computer. Example: If you create a job with a script to run 
locally on the Deployment Server and assign the job to 500 computers, the 
script runs on the Deployment Server 500 times.

Client run environment

Select the environment for your client computer. You can run the script either in 
production mode or in automation mode.

Production - Client-installed OS (Windows/Linux/Mac OS X)

Security Context. You can specify one of the following security options for running 
the scripts:

Default (local system account). Use the network security account established 
to administrate all managed computers.

Specific user. If you have selected to run the task on the local Deployment 
Server, enter an administrator user name and password for that Deployment 
Server account. In most cases Deployment Server does not have the 
Deployment Agent installed, which prohibits it from using a network security 
account.

Run script in console user session. For Windows 2008 and Vista, you can 
see the output of jobs on a local desktop and use that output for debugging 
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purposes. The script runs in a logged-in user’s UI session. If no users are logged 
in, the job fails.

Scripts run in an elevated mode, which skips the usual consent step through a 
user access control (UAC). Otherwise, someone must physically go to the 
remote computer and approve the action to allow the script to run.

Script Window. From the drop-down list, select how you want the script window to 
appear: minimized, normal, maximized, or hidden.

Note 
This option is available only for Windows environment.

Script Options - (Windows/Linux/Mac OS X)

Additional command-line switches. Enter commands to execute when the 
script runs in Windows, Linux, or Mac OS X.

Automation pre-boot environment (DOS/WinPE/Linux/Mac OS X). Select 
this option to run the script in an automation environment. Select a pre-boot 
automation environment from the drop-down list.

If you select Linux as the operating system type, the Locally on the Deployment 
Server option is disabled and only the Additional command-line switches under the 
Production Client installed OS (Windows/Linux/Mac OS X) is enabled.

If you select DOS as the operating system type, the Locally on the Deployment 
Server and the Production - Client-installed OS (Windows/Linux/Mac OS X) 
options are disabled.

Example script

The process to convert NT4 from FAT16 to NTFS normally returns a 1 after a successful 
completion. The following is an example of the file that is modified to return a code of 0 
(which is the success code recognized by the Symantec Management Console and 
utilities). You can make similar changes to your script files as needed.

CONVERT /FS:NTFS

if ERRORLEVEL 1 goto success

goto failure

:success

set ERRORLEVEL = 0

goto end

:failure

echo Failed

set ERRORLEVEL = 1

goto end

:end

Using LogEvent and WLogEvent in scripts
The logging features, LogEvent and WLogEvent, accommodate detailed logging to help 
debug complex scripts. These utilities include the following features:
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Logging is stored in the database instead of a log file.

A DOS-based tool can be called from any script file to log status and error codes.

The console displays and works with the new status messages.

LogEvent posts status sends messages to the Deployment Console, letting you view the 
status of the script. It is a light-weight reporting tool that can log both status strings and 
status codes to the history file and the console.

LogEvent — Use the LogEvent utility for DOS and Linux scripts.

WLogEvent — Use the WLogEvent utility for Windows scripts.

The LogEvent and WLogEvent utilities are command-line driven only — there is no user 
interface. Use both utilities with the following switches.

LOGEVENT -c:code -id:%ID% -l:level -ss:“message” 

code is any number for a return code level.

id is used for server-side scripting only. For server-side scripts you must add the -
id:%ID% switch.

See the Locally on the Deployment Server option in Script Information to select a 
server-side script. See Script information on page 185.

level is the severity level. The following levels are used:

1 = Information message

2 =Warning message

3 = Critical failure message. Only this level can be used to set up a return code. See 
Setting up return codes on page 193. The response does not execute for a return code 
unless a level 3 is specified when using the LogEvent and WLogEvent command in a 
script.

message is the status string. If spaces exist in the message, the string must be 
contained in quotes. Specifying a severity level of 3 causes the script job to fail.

Example scripts

REM Bootwork unload

Set ImageName=F:\Images\XPIntel.img

rdeploy -mu -f%ImageName% -p1

logevent -l:1 -ss:“Created %ImageName%.”

REM Execute WLogEvent.exe from CMD script

REM This script requires WLogevent.exe to reside on the client

REM in the temp directory

.\WLogevent.exe -c:0 -l:1 -ss:“Running Dir on %NAME%"

dir

.\WLogevent.exe -c:0 -l:1 -ss:“Finished with the DIR command on 
%NAME%"
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Copying a file

Copy all types of files to managed computers. You can send selected files or directories 
to a computer or computer group.

1. Select either the Copy File or Copy Directory option. When you select the Copy 
Directory option, select Copy Subdirectories to copy all subdirectories.

2. Enter the directory path and name of the file or directory. The Source path defaults 
to the Deployment Share, but you can enter or browse to a file or directory.

To copy files or directories through the Deployment Server from the Deployment 
Share, you can enter a relative path in this field. To copy files or directories directly 
from the Deployment Share to the managed computer, you must enter the full UNC 
path name. See Copy file to advanced on page 189.

Note
When entering the source path for copying files through the Deployment Server, you 
can only access the shared directories through an established user account. 
Specifically, you can only use UNC paths when you have sufficient authentication 
rights established.

3. Select the Allow to run in automation check box to run this task in automation 
mode.

Note
This option is only applicable for Linux and WinPE automation.

4. Type the destination path. The Destination path field automatically enters a 
sample path, but you can enter the directory path you require. If the destination 
path does not exist on the destination computer, it is created.

5. Click Advanced to specify additional features to copy files through the Deployment 
Server or directly from a file server. See Copy file to advanced on page 189. Click 
Next.

6. (Optional) Set Return Codes. See Setting up return codes on page 193.

7. Click Finish. The task appears in the Task list for the job. The file is sent to the 
specified location when you run this task.

See also Modifying tasks in a deployment job on page 190.

Using location variables

Location variables are being added to the Deployment Server for the Copy Files feature, 
letting you enter a token variable instead of requiring a complete location path when 
copying files to a managed computer (a client computer running the Deployment 
Agent). 

 

Send files to client computers by adding the Copy File to task when 
building new jobs. Use the Copy File to operation (see Remote operations 
using Deployment Solution on page 122) to copy files quickly from 
Computers pane in the console. See Building new jobs on page 150.
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Deployment Solution supports long names in the REM replacetoken command. If your 
file name includes spaces, enclose the file name in quotes so that it handles correctly.

The current variables include:

Temp. Enter Temp in the Destination path to set the Temp directory (identified in the 
system path) for the managed computer. Example: Instead of entering 
C:\windows\temp\setup.exe in the Destination path, enter temp:setup.exe.

Copy file to advanced
Select options to copy files directly from the Deployment Share. This option is for files 
stored on another network server in a distributed Deployment Server installation.

Copy files using Deployment Server. This option distributes software packages 
through the Deployment Server to the managed computer, requiring two file copy 
transactions if the Deployment Share is on another file server. Use this option for Simple 
installs to take advantage of security rights defined by the Deployment Server. You can 
use a relative path name entered in the Source Path field in the Copy Files dialog. This 
is the default option.

Copy directly from file source. Click this option to copy packages directly from the 
Deployment Share, sending only one copy across the network. It copies the file directly 
to avoid running through the Deployment Server and diminishes processor output. 
Because the Deployment Agent doesn't recognize shared rights and is not guaranteed to 
have a mapped drive to the data source, you need to identify a user name and password 
for the data share computer from the target computer. This option also requires a full 
UNC path name in the Source Path field in the Copy File dialog.

File Source logon. Enter the user name and password for the client computer and the 
Deployment Share. Both must have the same user name and password (this is not an 
issue if both exist in the same domain).

Power control 
Start the computer using Wake on LAN or run standard power control options to restart 
the computer, shut down, or log off the current user.

1. Create a job.

2. Click Add > Power Control.

3. Select an option: Restart, Shut down (if available), Log off, or Wake up (send 
Wake-On-LAN).

4. Select Force application to close without a message, if required. Click Next.

5. (Optional) Set Return Codes. See Setting up return codes on page 193.

6. Click Finish. The task appears in the Task list for the job.

 

Wake up, shut down, or log off client computers by adding the Power 
Control task when building new jobs. See Building new jobs on page 150.
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Waiting

Use the Wait task to boot a computer in the automation mode and wait for user 
interaction.

1. Create a job.

2. Click Add > Wait.

The Wait dialog appears.

3. Select the appropriate pre-boot environment from the drop-down list. Click Next.

4. (Optional) Set Return Codes. See Setting up return codes on page 193.

5. Click Finish. The task appears in the Task list for the job.

Modifying tasks in a deployment job
You can build jobs by adding or modifying deployment tasks. You can modify the tasks in 
a job that is already scheduled on any computer. The job will run the modified tasks 
according to the previously set schedule.

To add a task to a job immediately

If the task (image, batch file, executable, and so on) is saved in the product directory, it 
appears on your Resources list in the Shortcuts pane. Simply drag it to an existing job 
to add it.

To add a task to a job

1. In the Jobs pane, double-click the job you want to modify.

2. Click Add and select another task from the menu.

3. Follow the basic instructions on each dialog provided for each task. Select the type 
of task you want to add and follow the directions.

4. After finishing task configuration, a new task appears in the Jobs list.

5. Change the order of the tasks using the up and down arrows. The tasks run in the 
order listed.

To copy and paste a task

Use the steps below to copy and paste tasks within the same job, or from one job to 
another. You can use CTRL+C and CTRL+V to copy and paste tasks.

1. In the Jobs pane, click the job that contains the task you want to copy.

2. In the Details pane, right-click the task, and select Copy. (To copy multiple tasks, 
press the CTRL key and select the desired tasks. The tasks that are highlighted are 
copied when you select Copy.)

3. In the Jobs pane, click the destination Job where you want to paste the task.

4. Right-click in the Details pane and select Paste. The tasks appear at the bottom of 
the task list, and use the condition settings of the current job. 

5. Change the order of the task using the up and down arrows. The tasks run in the 
order listed.
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To modify a task in a job

1. In the Jobs pane, double-click the job you want to modify.

2. Select the desired task from the list.

3. Click Modify and follow the directions to make the required changes. Click OK.

To remove a task from a job

1. In the Jobs pane, double-click the job you want to modify.

2. Select the task you want to remove from the task list. Click Delete.

3. Click OK.

To copy and paste tasks

Use the steps below to copy and paste tasks within the same job or from one job to 
another. You can also use CTRL+C and CTRL+V to copy and paste tasks.

1. In the Jobs pane, click the job that contains the task you want to copy.

2. In the Details pane, right-click the task and select Copy. (To copy multiple tasks, 
press the CTRL key and select the desired tasks. The tasks that are highlighted are 
copied when you select Copy.)

3. In the Jobs pane, click the destination Job where you want to paste the task.

4. Right-click in the Details pane and select Paste. The tasks appear at the bottom of 
the task list and use the current condition settings of the destination job.

5. Change the order of the tasks using the up and down arrows. The tasks execute in 
the order listed.

To add a new task to an existing task list

1. Select a job from the Jobs pane.

2. Click on one of the tasks within the job and add a new task. The new task is inserted 
above the task you highlighted, and all other jobs shift down by one position.

3. Use the up and down arrows to change the order of the tasks within the job.

Modifying multiple modify configuration tasks 
If you have scheduled multiple Modifying Configuration tasks to a computer group, you 
can double-click Modify Configuration in the task list of the Details pane to modify 
each computer’s configuration settings independently. 

In the Jobs pane, click the job with a Modify Configuration task. Double-click the Modify 
Configuration task.

A message appears. Click YES to modify configuration settings individually for each 
scheduled computer. Click NO to modify the Modify Configuration task when the job 
is scheduled again (the current job sends modified configuration files already 
created).

If you click YES, a Modify Job Wizard appears with a list of each managed computer 
scheduled to change configuration settings. Select one or more computers and click 
Next.
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1. In the Computer Configuration Properties property page, modify the settings. Click 

Next. See Computer configuration properties on page 101.

2. Set Return Codes. See Setting up return codes on page 193.

3. Click Finish.

Creating new script files
You can create script files and directly schedule the script file to run scripts on any 
computer or computer groups.

To create new script files

1. Go to View > Shortcuts View.

2. Click Resources in the Shortcuts view to move the focus to the Resources view.

3. Go to File > New > Script File.

Note
The Script File option is activated only if the focus is on the Resources view.

A script file is created by default at the root of the resources. The default file name 
is Batch.bat.

4. Right-click the Batch.bat file, and select Modify.

Note
You can rename the batch file by right-clicking the file and selecting Rename.

5. Type the script in the open file, and save it.

6. Drag the Batch.bat file to a computer or computer group where you want to 
schedule the job.

7. Specify the scheduling options, and click OK. See Scheduling jobs on page 153.

Copy and paste jobs and job folders
Jobs or job folders (including their subfolders) can be copied to any other job folder in 
the left pane of the Jobs pane of the Deployment Console. A Job folder can only be 
copied to a root level folder, which has a limit of 30 subfolders, and cannot be copied to 
a child level folder.

If you copy a job or folder with the same name as the destination job or folder, the 
copied job or folder is automatically named Copy of <job or folder name>. This feature 
can only be performed by administrators or users who have permissions to create jobs 
or job folders.

To copy jobs and job folders 

1. In the Jobs pane, right-click a job or job folder you want to copy, and click Copy.

2. In the Jobs pane, right-click the destination job folder and click Paste. 
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Importing and exporting jobs

Jobs can be exported to back up the Deployment Server data or to share jobs between 
Deployment Server installations.

To import jobs

1. Right-click in the Job pane, and select Import

or 

Click File > Import/Export > Import Jobs.

2. Browse to or enter the path and name of an existing import file (a .BIN file).

3. Select Import to Job Folder to import the jobs to an existing folder in the Jobs 
pane. If you have a folder already selected, it appears in the edit field.

4. Select Overwrite existing Jobs and Folders with the same name to replace 
identical jobs and folders.

5. Select Delete existing Jobs in folder to overwrite and replace all jobs in the 
selected Jobs folder. Click OK to import the job(s).

To export jobs

1. Right-click the job or Jobs folder you want to export and select Export.

or 

Click File > Import/Export > Export Jobs.

2. Select the destination folder and enter a file name.

3. Click Export subfolders to export all folders subordinate to the selected job folder.

4. Click OK.

Setting up return codes 
When you create a task in a job, you can define a response to specific return codes 
generated from that task after it runs. You can determine the response if the task runs 
successfully or if the task fails. You can also set up custom return codes generated from 
scripts or batch files that are unique to your environment or deployment system.

Note
Return code handling cannot be set up for jobs created in the New Job Wizard.

When creating a task, the Return Codes page appears so you can set a response if the 
task was successful or to determine a default response if the task failed. Because 
Deployment Server returns a 0 (zero) if the task runs successfully, any other return code 
value denotes some type of failure in running the task. As a result, in the Success field 
you can select an action if the return code is 0 (zero), or select an action in the Default 
field if the return code is not a 0 (zero).

Return codes are first evaluated to be successful (zero) or failed (non-zero). If the task 
returns as successful, it runs the action specified in the Success field. If it is not 
successful, it determines if the return code has been assigned a custom code value. If 
the return code is defined as a custom code, the selected action for that custom code 
runs. If no custom code is assigned to the return code, the action set in the default runs.
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Note
If you are using LogEvent and WlogEvent in Scripts, you can generate return codes only 
when the level 3 message is specified. Specifying a severity level 3 causes the script job 
to fail and lets you respond using this return code feature.

Return code actions

For both successful tasks (in the Success field) and failed tasks (in the Default field), 
you can specify the following actions:

Stop. This action stops the job after the task runs. Subsequent tasks do not run.

Continue. This action lets the subsequent tasks in the job continue after the task runs.

Select a job. This action lets you select existing jobs to run after the task completes.

These actions also apply to custom return codes designed specifically for your system.

Custom return codes

In the Other return codes field, you can view custom return codes set specifically for 
your system. You can add return codes by clicking Add below the Other return codes 
field, or by clicking Master Return Code. 

Type a custom code in the Code field, select a response action from the Response list, 
select the result from the Result list to specify the interpretation of this return code as 
Success or Failure, and provide a message in the Status field.

These custom codes can respond to any return codes set up in scripts or batch files in 
the Run Scripts task, or these custom codes can respond to system return codes thrown 
from the Deployment Server or external codes generated when distributing applications, 
personality settings, or disk images. Any task can have custom codes that respond to 
different return code values.

Master Return Code List. This is a list of all the return codes existing in the 
Deployment Database. You can add, modify, and delete the codes and their values so 
that setting codes for other tasks is easier.

Add. This lets you add a new custom return code for the task. You can also add the 
return code to the Master Return Codes list.

Modify. This lets you modify the return codes listed in the Other return codes field. 
The changes you make do not update the Master Return Codes list. 

Delete. This lets you delete return codes listed in the Other return codes field, but not 
from the Master Return Codes list.

To set up master return codes

The Master Return Code List dialog lets you: 

Add, modify, and remove return codes in the master list.

Select return codes for the current job from the drop-down list.

To add master return codes

1. Select a job from the Jobs pane.

2. Click Add in the right pane to add a task. Select the task. The task dialog appears.
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Note
You can add Master Return Codes for all tasks except Get Inventory.

3. Click Next until the Return Codes page appears.

4. Click Master Return Codes. The Master Return Code List dialog appears.

5. Click Add. The Add Return Code dialog appears.

6. Enter the return code in the Code field and click OK. The code is added to the 
master list.

To modify Master Return Codes

1. Click Modify. The Modify Return Code dialog appears.

2. Enter data in the Response, Result, and Status fields and click OK. The code is 
modified.

To delete master return codes

1. Select the code you want to delete and click Delete. A warning message appears to 
confirm the deletion.

2. Click Yes. The selected return code is deleted from the Master list.

Note
The OK and Cancel options in the Master Return Code List dialog apply to the return 
codes selected. If no return codes are selected, or none exist in the list, OK is disabled. 
Click OK on the Master Return Code List dialog to add the selected return codes to 
the current job.

To set up return codes

To set up return codes, you need to determine how to respond to the Deployment Server 
success return code (zero) in the Success field, how to respond to a failure return code 
(a non-zero) in the Default field, and how to respond to a custom or externally 
generated return code defined in the Other return codes field.

The following example describes how to set up a simple process to deal with custom and 
system return codes, and how to interpret the status of user-defined return codes:

1. In the Success drop-down list on the Return Codes page, keep the default value 
Continue. This lets the job continue running additional tasks in the job after 
successfully completing this task.

2. Click Add to add custom return codes. The Add Return Code dialog appears.

3. In the Code field, enter a value of 10 (ten).

4. Click the Response drop-down arrow and select Continue from the list.

5. Click the Result drop-down arrow and select Success from the list. Even if the 
return code was not zero, which is success by default, the task is considered a 
success as per the user’s choice.

6. Enter a description for the return code in the Status field. This is the message that 
appears when the task within a selected job runs.

7. Select the Add to Master return code list check box to add the custom code to 
the master return code list. The code is listed in both the Other return codes and 
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Master Return Codes lists. This is useful if you want to use the return code again. 
Click OK.

8. If the code you added already exists, a message dialog displays the return code and 
asks if you want to replace it. Click Yes to replace the return code, and click No to 
return to the Add Return Code dialog.

9. Select the Select a job option from the Default drop-down list to select a job to 
run when a default condition is reached. The Select a Job dialog appears, letting 
you select an existing job that runs if the task returns a failed system return code 
(non-zero) or a return code not defined as a custom return code.

Note
The status of the tasks executed in a job also appears in the history of a computer.

Sample jobs
Sample jobs are installed with each Deployment Server system, letting you quickly 
modify or add parameters, or to run the sample jobs as they are. During installation, 
jobs are automatically imported from the samples.bin file to the Deployment Server 
system where they can be viewed in the Samples folder in the Jobs area of the 
Deployment Console. Click each job and identify its features in the Description field of 
the Details pane.

Jobs in each folder marked with an asterisk (*) require input parameters or other minor 
modifications added before running on your system. These modifications let you add 
parameters to the job, such as user name and password or other required data for the 
job to be functional. Jobs requiring input parameters or customizing do not function 
properly if you do not edit the job with the information specific to your environment.

All files without an asterisk (*) can be used to perform the identified functions without 
modification. However, if the job conditions are not met or are not consistent with the 
computer type, you may get an error. Example: If the Repair Office XP job runs on a 
computer without MSOffice XP, you get an error when running the job.

Note
When upgrading versions of Deployment Solution, we recommend that you copy and 
rename modified sample jobs to avoid overwriting by new sample jobs.

DAgent
DAgent is the default agent for the Windows platforms.

You can implement the following features in the Security tab:

Hide the DAgent icon in the system tray of the managed computer. You then need to 
run DagentConfig.exe as an administrator to view the administrator properties.

Limit users on the managed computer to access the administrator properties only if 
they enter the set password. If the password is entered incorrectly three times, a 3-
minute lock-out time period begins and an appropriate error message displays.

You can also uninstall DAgent.
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Uninstalling DAgent

You can uninstall DAgent from the client computer. This functionality is provided only 
from the console side.

To uninstall DAgent

1. In the console, right-click.

2. Click Advanced > Uninstall Agent.

Upgrading AClient to DAgent
A sample job lets you upgrade AClient to DAgent.

You can upgrade AClient to DAgent by using the sample job that is included with 
Deployment Solution. You can also choose to use the Remote Agent Installer tool that 
upgrades the agent for you.

No automatic utility or tool is available that upgrades AClient to DAgent for you.

To upgrade AClient to DAgent

1. In the left pane, under Jobs, expand the Samples folder.

2. Expand the Misc Jobs folder.

3. Click the DAgent Upgrade sample job.

4. Copy the sample job to another location and rename it.

5. Schedule the job to run.

Symantec Backup Exec System Recovery (BESR) 
sample jobs

Deployment Solution includes several BESR sample jobs.

For more information on BESR, see http://www.symantec.com and search for Symantec 
Backup Exec System Recovery.

Initial deployment
Initial Deployment is a default job designed to help in the process of setting up 
computers that do not exist in the Deployment Database. Initial Deployment lets you 
define how computers are initially set up after being identified by the Deployment 
Server.

You can define various computer configuration sets and deployment jobs for the user 
during startup, letting the user select the computer settings and hard disk images, 
software, and personality settings for their specific needs and environment. New 
computers appear in the New Computers group in the Computers pane of the 
Deployment Console.
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Notes

Initial Deployment is ideal for small-scale deployments, from 1 to 10 computers. We 
do not recommend this feature for large deployments -- from 10 to 100 computers -
- or mass deployments -- from 100 to 5000 computers. We also do not recommend 
this feature where you use virtual computers, customized jobs, and the computer 
import feature.

Although Initial Deployment is commonly used on computers that support PXE, you 
can also configure a boot disk to run Initial Deployment. In this case, the image you 
deploy must include automation pre-boot environment so that post imaging tasks 
can run successfully. Installing an Automation Partition on the client computer’s 
hard disk ensures that future imaging deployment jobs run successfully.

Note
To completely deploy and configure a computer using Initial Deployment, you must 
define at least one Configuration and one Job.

Initial Deployment consists of a dialog with the following tabs with separate features to 
deploy new computers:

Configurations

Jobs

Advanced

Configurations
Click the Configurations tab on the Initial Deployment dialog to configure different 
sets of computer properties. Each configuration set is presented to the user as a menu. 
The user can select the configuration set designed for their environment. Compare the 
Configurations tab with the Jobs tab. See Jobs on page 199.

Note
If you do not create any configuration sets, the deployment process automatically sets 
TCP/IP information to use DHCP and names the computer to match the computer’s asset 
tag, serial number or MAC address -- in that order, depending on what is available. 

1. Double-click Initial Deployment in the Jobs pane drop-down list. The Properties 
of Initial Deployment dialog appears.

2. Click the Configurations tab.

3. Click Add. A configuration set appears in the Configurations menu field. The 
Configuration page of the New Job Wizard appears.

4. Enter values to set computer and network properties for new computers. See 
Modifying configuration on page 182 for a list of property categories.

 

To access Initial Deployment, double-click Initial Deployment from the 
Jobs pane or right-click Initial Deployment and click Properties. The 
Properties of Initial Deployment dialog appears.
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5. Click Add again to configure another set of property settings. You can add multiple 

configuration sets for the user to select from a menu after connecting to 
Deployment Server. You can modify, rename, or delete a selected configuration set.

6. After setting the properties, click Apply.

7. From the Default Menu choice drop-down list, select a configuration set as the 
default.

8. Click the Timeout after ___ seconds and proceed check box and specify the 
time after which you want to run the default job.

9. Click OK, or click the Jobs tab to define a task.

Advanced Configuration
Click Advanced on the Configurations tab to open the Advanced Configuration 
dialog. This dialog lets you set advanced configuration settings for client computers and 
provides different options for processing jobs for client computers.

Select Process this job as each client becomes active. This job is processed 
only when clients become active.

Select Process this job in batch mode. This job is processed for a batch of clients 
for the Minimum clients specified and after the specified Timeout in minutes.

Select Hold all clients until this time. You can specify the Start time for this 
job, which runs for all clients at the specified time.

Click OK.

Jobs 
Click the Jobs tab on the Initial Deployment dialog to add existing jobs or create new 
jobs to run on the new computer. The jobs you add or build using this dialog are listed in 
a menu and presented to the user during startup. The user can select the deployment 
jobs to image the computer and install applications and personality settings. Compare 
the Jobs tab with the Configurations tab. (See Configurations on page 198.) The 
conditions on the jobs are limited to the data that can be accessed at the DOS level 
(Example: Serial number, manufacturing number, NIC information, manufacturing 
name).

1. Click Initial Deployment in the Jobs pane drop-down list. The Properties of 
Initial Deployment dialog appears.

2. Click the Jobs tab.

3. Click New to build a new job. The Select a job dialog appears. See Building new 
jobs on page 150. Select a folder in which you want to create the job. Click OK. The 
Job Properties dialog appears.

4. Click Add Existing to add an existing job.

5. From the Default menu choice drop-down list, select a job as the default.

6. Click the Timeout after ___ seconds and proceed check box and specify the 
time after which you want to run the default job. The default setting is 60 seconds.

7. Click OK, or click the Advanced tab to stop servers or workstations from running 
configuration task sets and jobs automatically.

See also Sample jobs on page 196.
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 Advanced 

Click the Advanced tab to set options to stop Initial Deployment from automatically 
running the default configuration task sets and jobs. This avoids accidental re-imaging 
or overwriting of data and applications for either workstations, such as desktop and 
laptop computers, or servers, such as Web and network servers identified by 
Deployment Server.

When a computer not yet identified by the Deployment Database is first detected, it is 
placed in the New Computers group and an Initial Deployment configuration set and job 
is run. However, in many cases you do not want Web or network servers to be 
automatically re-imaged without confirmation from IT personnel.

Select Servers to stop servers from automatically running Initial Deployment 
configuration jobs. Servers are identified as the managed computers running 
multiple processors or identified as a specific server model from specific 
manufacturers. Example: Both an HP Proliant computer and a Dell computer with 
multiple processors are identified as servers. Identifying a computer as a server by 
the operating system cannot be accomplished for new computers until the server 
operating system has been installed.

Select Workstations/Clients to force desktop and laptop computers to stop before 
automatically running Initial Deployment.
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